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Pyware 3D User Guide
Welcome to Pyware 3D – the complete drill designing tool. We at Pygraphics, Inc. wish to express our
gratitude to you who have supported our products and company by allowing us to serve your software
needs for more than three decades. Our hope is that this program will become an invaluable tool in your drill
designing efforts.

This is the home page of the Pyware 3D User Guide. All pages in the User Guide have a navigation bar on
the left of the screen. Select the topic you would like to review by choosing its corresponding button on the
navigation bar. You can also search for topics, key words or phrases in the search box above. The entire
contents of this guide can be downloaded as a PDF so you may print a physical copy. Download the PDF
from the link just below the topics on the left side of your screen.

Adjusting to the many innovative concepts of 3D will take a minimum amount of time, however, we do urge
that you work through the Tutorial in order to better understand the concepts behind 3D.
Pyware™ 3D was inspired by video animators and a “wish list” of input from “end users”. You will begin to
create, evaluate, and instruct drill never thought possible. In short…you’ll soon be wondering how you got
along without it.

We also have a video version of this User Guide – Pyware University Video User Guide
We offer Night School Zoom Session for learning how to use Pyware 3D – Sign up for Pyware Night School
How to Videos and Past Night School sessions are available on the Pyware YouTube Channel

Pygraphics Pyware 3D User Guide - 11.0_en
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Pyware Web Portal
The Pyware Portal is a carefully engineered ecosystem that provides a Pyware 3D Version 10 user, a way
of managing their account licenses, as well as a hub to collaborate with all those associated with their
account licenses or associated groups. The Pyware Portal has now made it possible to personally oversee
your Pyware account and the activity of the users you have attached to the license and user groups.

After you have updated to v10, you will receive a license key that can be redeemed to create an account,
add a Pyware license, and unlock all the administrative and collaborative features of the Pyware Portal.
Once you set up your new license account, you will have access as an “Administrator” to manage and
update your account information, add users to your license, and view details on your current license and the
installations or upgrades available.

As you add users to your account, they will have access to the Portal as an “Authorized User,” which allows
them license access, along with file sharing and communication within the group message board.

The group message board functions as the communication hub where you can post announcements, share
ideas and upload and download files. You can upload pdf files of charts, coordinates, Pyware 3D drill files,
etc. As an “Administrator” or “Authorized User,” you are allowed to create groups and add users to the
message board. A standard user will only have the option to join an existing group to view messages,
announcements and download files. This group function is designed to be an expeditious tool for shared
license users, band directors and performers to communicate amongst each other.

With an easy registration and setup process, the Pyware Portal is also free of charge.

Portal User Quick Setup Guide
This is a step by step guide to set up a new portal user, create a new Pyware 3D License account and add
the license to the account.

Register a New Pyware Portal User
The Pyware Portal is a full ecosystem that allows for the integration of file, group and license management.
A Pyware Portal user is required to use the Pyware 3D Version 10 and to gain access to your groups files.
This is user setup process is quick and free to setup.

1. Go to Pyware Web Portal User Registration
2. Fill out the registration information as seen in the example image. Note: The user password should

include a Capital Letter, a lowercase letter and a number.
3. Click Register to create your Pyware Portal User.

Pygraphics Pyware 3D User Guide - 11.0_en
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Login to the Pyware Portal
Once you have registered a Pyware Portal user you can then login to manage your portal account.

1) To login go to Pyware Portal Login.
2) Enter your Pyware Portal Credentials that you set up in the registration process.
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3) Click Log in to go to your Pyware Portal Dashboard.
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Add a License Key to a Portal User
To redeem a Pyware 3D License Account Key you will need to login to your Pyware Portal Dashboard.

1. Click on Accounts in the left navigation menu. This will expand the list of accounts available to your
portal user.
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2. Click Add Key under Accounts and you will be prompted to enter the License Key.
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3. Enter the License Key.
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4. Press Add Key to redeem the key and see the License Key Description.
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5. Select Add Key to New Account. Then enter the License Account Registration information.
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6. Select Create New Account and Add Key.
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Accounts
This section explains account management.

Add User to Pyware License Account
To add an Administrator or Authorized user to a Pyware License account you need to be logged into the
Pyware Portal Dashboard.

1) Expand the Accounts section in the Navigation Panel on the left.
2) Expand the desired account to add the new user to.
3) Click Manage.
4) The account management page will show. Click on the Users tab at the top of the account management
page.
5) Click the +Add button.
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6) The Add User to Account dialog will show.
7) Enter the new users name and email and select the role that the user will have on the account.
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8) Click Add Account User. Once the user is added they will receive an email with instructions to create a
Pyware Portal User to gain access to the Pyware License. The user will show a status of New User,
Registration Pending. If the User has already create a Portal user with their email their status will show the
user level and the licensed account they have access to. The user can now login to the Dashboard or
Pyware 3D application with access to the new License.
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Remove User from Pyware License Account
To add an Administrator or Authorized user to a Pyware License account you need to be logged into the
Pyware Portal Dashboard.

1) Expand the Accounts section in the Navigation Panel on the left.
2) Expand the desired account to add the new user to.
3) Click Manage.
4) The account management page will show. Click on the Users tab at the top of the account management
page.
5) Select the user to be removed.
6) Click the Remove button.
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7) The confirmation dialog will show.

Download Pyware on a new computer
To download the Pyware software from the portal you need to be logged into the Pyware Portal Dashboard
and be an Administrator or Authorized user to a Pyware License account.

1) Expand the Accounts section in the Navigation Panel on the left.
2) Expand the desired account to add the new user to.
3) Click 3D Basic or 3D Professional, depending on the license you are a part of.
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4) Links are available for Windows and MacOS installers for the license.
5) Click the Download Installer for the appropriate Operating system.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 24 of 407



Remove a Computer Session from a Pyware
Account
To remove the Pyware software from a computer and the portal you need to be logged into the Pyware
Portal Dashboard and be an Administrator or Authorized user to a Pyware License account.

1) Expand the Accounts section in the Navigation Panel on the left.
2) Expand the desired account to add the new user to.
3) Click 3D Basic or 3D Professional, depending on the license you are a part of.

4) At the bottom of the license management page is a list of the active computers on the account license.
5) Click the Yes icon under the active column to deactivate the computer from the account.

The computer list for the license shows the Username, User email, Computer Nickname,
Session Start, Session Last Access, and Session Type. This gives you enough information
to help identify the correct computer’s session to remove.
*
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Groups
This section explains group management using the Pyware Portal System.

Create Group
To create a group you need to be logged into the Pyware Portal Dashboard and be an Administrator or
Authorized user to a Pyware License account.

1) Expand the Groups section in the Navigation Panel on the left.
2) Click Create Group.
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3) Select the account that the group will be associated with from the pull down menu.
4) Enter the name of the group.

5) Click Create Group and you will see the group creation confirmation.
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Add User to Group
To add a user to a group you need to be logged into the Pyware Portal Dashboard and be an Administrator
or Authorized user to the Pyware License account that the group is assigned to.

1) Expand the Groups section in the Navigation Panel on the left.
2) Click the desired group to add the new user to.
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3) Click Manage Members.
4) The group member management page will show.

5) Click the +Add button.
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6) The Add User to Group dialog will show.

7) Enter the new users name and email and select the role that the user will have on the group.
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8) Click Add Account User. Once the user is added they will receive an email with instructions to create a
Pyware Portal User to gain access to the Pyware License.

The user will show a status of New User, Registration Pending. If the User has already create a Portal user
with their email their status will show the user level and the User Role they have in the Group . The user can
now login to the Dashboard and access the Group files and or Pyware 3D application with access to the
new License.
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Upload File to Group
To add a user to a group you need to be logged into the Pyware Portal Dashboard and be an Administrator
or Authorized user to the Pyware License account that the group is assigned to or be a Band Director Role
for the Group.

Compatible File Types:

• 3DJ
• 3DZ
• PROD
• PDF
• 3DA
• 3DUDB
• PDF
• OGG
• WAV
• PNG
• JPG

1) Expand the Groups section in the Navigation Panel on the left.
2) Click the desired group to upload the file to.
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3) Click Upload File.
4) The Upload File window will show.

5) Enter the Show information
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• File Show – The name of the show this file is a part of. For Example Pyware University Show 2019
• File Title – The title for this specific drill.
• File Description – A brief description of the file that is being uploaded.
• File Visibility Level – This will allow the file to be shown or hidden to certain group roles.

6) Click Choose File and Upload.
7) The File Chooser will come up, locate your file that you would like to upload and click Open.
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8) Once the file upload is complete a confirmation will show.

9) Uploaded files are shown in the upper right section of the group management page.
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10) Each file has options to interact with it.

• Clicking on the file name will show the files information.
• The trash can will delete the file from the account.
• The lock icon will lock the file from being edited or removed.
• The Download icon will allow you to download the copy of the file from the account.
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Post an Announcement to a Group
To add a user to a group you need to be logged into the Pyware Portal Dashboard and be an Administrator
or Authorized user to the Pyware License account that the group is assigned toor be a Band Director Role
for the Group.

1) Expand the Groups section in the Navigation Panel on the left.
2) Click the desired group to post an announcement to.
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3) Type the desired announcement in the provided text area.
4) Click Post Announcement.
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User Settings
User Settings can be found by clicking on the user icon in the upper right corner of the Pyware Portal
Dashboard.

When Post Announcement is clicked the Pyware Portal will send an email to every group
member (depending on their contact settings) and also show the announcement on the
group management page.
*
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This page is used to view and edit the user information.

• Click Change User Information to change the user name for the user.

• Click Change Contact Information to edit your email and phone contact information.
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• Click Change Password to edit your Pyware Portal Password.

• The email notification settings can be turned on or off based on your preferences.

• An avatar image is able to be uploaded to customize the user profile.
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Basic Concepts
In this section you will learn the main windows of Pyware 3D and many of the terms that are to be used
throughout the application and manual.

You can access the sub-topics by expanding the list in the Table of Contents, or by clicking through to the
next sub-topic below.

Log In to Pyware Portal

Getting Started With 3D
3D is always started by choosing the 3D application on your computer from your group of programs. 3D will
not start by selecting a 3D drill file directly. You must launch 3D first, then choose New or Open from 3D’s
File menu.

On Windows, you will find 3D in the Programs group of the Start button. On Macintosh, you will find the
application icon initially on your desktop or dock.

While Pyware 3D is loading the 3D cover screen will display. Once the program has fully loaded, a new file
will display using the default grid with a maximum of 300 counts of drill for you to start immediately. This file
has a maximum of 300 counts of drill. If you need to increase the maximum number of counts later, you will
use the Count Editor of the Utilities menu.

You can create another new file with a different maximum number of counts or a different Field Display grid
by selecting New Drill from the File menu. When determining the number of counts in a drill we recommend
that you do not make a drill file with more than one song per file.

You can also choose to open an existing file by selecting Open Drill from the File menu.

3D’s Main Window
Once you have opened a file, several windows, menus, palettes and control panels will appear on the
screen. All of which will be explained in this section. Items addressed in this section:

It’s important that you save often. You can always revert to an early “backup” of the file if,
after writing, you realize an earlier version of the file is better. Power surges and file
corruptions are a fact of life. Having backups of the file are extremely important. In addition,
backing up files on external drives is beneficial. See Backup Drill for more details on
backup techniques.

!
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• The Field Display Window
• The Count Track and Animation Controls
• The Console
• The Tool Palette
• The Perspective Window
• The Production Sheet (Available in Interactive and Professional editions only)

Field Display Window
This is the main area where drill design is created. The Field Display Window would be the entire gridded
design stage. The upper right corner of the Field Display Window contains display tools which control the
way the drill is displayed on the field.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 44 of 407



• Grid Layout Menu- You can quickly change the grid layout from the main window of 3D. To do so,
choose the grid layout you would like from the drop down menu. By default, 3D will use the drill file’s
saved layout. This is extremely helpful if you have separate grid layouts for designing and printing.
NOTE: Any selection from this menu will also load any Real View options that are saved in the grid
layout file.

• Edit Handle Resize Slider- Adjusting this slide bar will either increase or decrease the size of all tool’s
Edit Handles.

• Stride Zone Switch- Turns the display of the Stride Zone on or off. The Stride Zone can be adjusted
under Document Options of the File menu.

• Props Switch- Turns the display of props on or off. No props will be shown until they are entered.

• Label Switch- Turns the display of labels (numbers) that appear beside each performer on or off. No
labels will be displayed until the labels are entered.

• Text Switch- Turns the display of the text and arrows on the field display on or off.

• Facing Switch- Turns the display of performer facing on or off.

• Measure Tool- The Measure tool is used to measure the distance between two points. Click on the
tool and then click on two points on the field to measure. The measurement is displayed in the
Console. TIP: A quick way to turn off the measure tool is double-click anywhere on the field while the
tool is active.

• Grid Tool- This tool is used to move and zoom the design grid. Below are a list of actions you can use
with the Grid Tool enabled:

1. Right-click or mouse wheel UP to zoom in
2. CTRL-click our mouse wheel DOWN to zoom out
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3. Click and drag to move the grid
4. ALT-click (or OPTION-click on Mac) on the tool icon to reset the grid movement
5. CTRL-click on the tool icon to reset zoom

Count Track
The Count Track is typically located along the bottom of the screen. Its main component looks like a ruler
with a tick drawn for every count in the drill. Red and Yellow Anchors can be dragged along the ruler which
determines the count of the drill that will be displayed and edited on the screen. The Count Track is very
important and is fundamental for the proper operation of Pyware 3D.

During typical use, sliding left-right above the counts of the Count Track are Red and Yellow Anchors.

Directly to the left of the ruler in the Count Track is an area that displays the Red and Yellow Anchor
values.

Understanding Anchors

When writing forward the top number represents the count of drill where the Yellow Anchor is located. The
next number represents the count of drill where the Red Anchor is located, and the last number represents
the number of counts between the Red Anchor and the Yellow Anchor.
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The space between the two anchors determines the count range of a transition. The Red Anchor is the
ending count of a transition. It is the count where a shape can be edited. At this count, the positions in the
formations are displayed on the field in symbols. The Yellow Anchor is the beginning count of a transition
and is used as a reference or background chart. By default, the positions at this count are displayed on the
field as black dots. In the “old days” when designing on paper or using a light board, the Red Anchor could
be compared to the actual sheet you would be drawing on. The Yellow Anchor is the underlying sheet of
paper with a formation from the previous set to be used as a reference.

When you start a drill, typically your first step would be creating an opening formation on count 0. You would
set both Red and Yellow Anchors to count 0.

After you have created the opening formation, you would then create your transition to the next set by
“morphing” or reshaping your opening formation. To indicate the count of the next set and the number of
counts in the transition from the last set, you will spread the anchors over those counts. For example,
setting the Yellow Anchor at count 0 and the Red Anchor at count 16 will start the next set at count 16 and
create a 16 count transition between counts 0 and 16.

You may often notice when moving your anchors forward the locations of the performers on the field do not
appear to change, even though you are looking at new counts. This is because no editing has been done at
those counts, so the performers are holding in place.

To design the formations of the next set, you will select shapes and use the edit tools to reshape them. In
the example, our Red Anchor is at count 16 and therefore the formations (or shapes) we are editing are at
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count 16. Since the Yellow Anchor is at count 0, the transitions between count 0 and 16 are automatically
created for you.

Again, for example, if you wish the next transition to be between counts 16 and 40, you would move your
anchors where the Yellow Anchor is at count 16 and the Red Anchor is at count 40.

Now you are looking at count 40 on the field. Since count 40 is currently marking time from count 16, the
secondary (background) chart at count 16 that is normally displayed is directly under the primary chart
(count 40). You will now reshape the formations at count 40 and the transition counts between 16 and 40
will be automatically created for you.

Why the Count Track is Awesome

The great thing about the Count Track is that transitions can begin and end on ANY count. You are not
restricted to beginning and ending every transition at the same counts in the drill. Some transitions may
span over several printed charts. In our example we created a set of transitions that span from 0-16 and
from 16-40, so typically we would print a chart at 0, 16 and 40.

But what if you also wanted a group of performers (let’s say the guard) to travel from 0 to 40 in a single
transition? That is easy! Set the Yellow Anchor to 0 and your Red Anchor to 40. Reshape the formations
that make up the guard and you’re done. The placement of the guard at count 16 (as with the other
transition counts) are automatically created for you.

Another great thing about the Count Track is that with this approach you do not re-create a chart from
scratch at each set. With 3D, you are usually re-shaping the formations of a count (at the Red Anchor)
based on a formation’s shape at a previous count (at the Yellow Anchor). Since the transitions are
evolutionary, it is almost always easier to build a chart from its predecessor than to create the new chart
from scratch. The Tutorial that follow will help you better understand how this concept works.

NOTE: Dragging the Yellow Anchor through the count of the Red Anchor will leap frog the anchors. This
time saving feature allows you to continue on to the next set by moving just one anchor instead of two.
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Animation Controls
Animation controls are found on the left side of the Count Track.

The Jog Tool is used to jog the animation forward and backward for a quick view. Releasing the jog returns
the display to its previous condition.

Previous Page will jump your anchors to the previous page’s transition.

Next Page will jump your anchors to the next page’s transition.

The Play button starts drill animation from the beginning of the drill or from the Yellow Anchor, depending
on the setting of the All Counts switch found along the bottom of the animation controls.

The Stop button stops the animation.

The Loop option causes animation to loop continuously between the Yellow Anchor and the Red Anchor.

The Play All option starts animation at the beginning of the drill file and continues to the end of the drill,
regardless of the placement of both Red and Yellow Anchors. If All Counts is turned off, then the animation
will start at the Yellow Anchor and end at the Red Anchor.

When the Step Animate option is selected, after clicking Play, animation will advance one count per
[SPACEBAR] or [RIGHT ARROW] key press. the [LEFT ARROW] key press will reverse the drill one step.

The Fast Animation option will play animation at a fast tempo for quicker review of transitions.

Audio will enable synced music to play back with the animation.

[CTRL] click to move your anchors to a bounding set skipping over any sub-tabs. [ALT] (or
[OPTION] for Mac) click to move your anchors to a single count.*
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Console
The Console is a window that displays detailed information about a function you are currently using.

The top line of the Console is called the Location Indicator. The Location Indicator provides information
regarding “cursor placement” relating to steps from vertical (division) lines and horizontal reference points
from either back side line, front side line, or middle of field.

Information in the Console changes depending on the function currently being used. Typically the console
shows information such as: number of positions selected, average interval of selected or new shape,
average length, maximum stride of transition, etc.

The five buttons in the top right corner of the Console control the step resolution of the Location Indicator
and the cursor on the field. The choices are whole (1) step, half ½ step, quart ¼ step, eighth (1/8), and
sixteenth (1/16) step. Switching between step resolutions gives the user more control of placement points
on the field. This is valuable when implementing tools such as the Free Form Tool where many points are
required to create a smooth shape. If your shape has few data points, you would typically want to choose a
whole step resolution so your endpoints will fall on whole steps.

Performer ID Panel
Available in Interactive and Professional editions only.

The Performer ID Panel is a tab that is found on your console. This panel allows you to quickly manipulate
the positioning of Performer Labels. The picture below breaks the panel into three sections for easier

A combination of both Loop and Fast Animation is a great way to preview the interaction
of maneuvers of shapes to other shapes.*
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comprehension.

The Directional Arrows shift the selected performer label(s) in a specific direction. All selected performer
labels will shift this direction.

The Contour buttons contour the label(s) to the shape. This is particularly helpful when dealing with curved
shapes.

The Distance buttons adjust the performer label(s) closer to or further from the performer(s).

Tool Palette

The Tool Palette contains the tools for entering shapes, selecting and editing shapes, selecting and
maneuvering shapes, changing information about performers, and items such as text and arrows.

If you have a large number of performers but only need to adjust a few labels, try the Box
Selection or Lasso Selection tools. These two tools ignore any grouping that the
performers might be in and only highlight what you have selected.
*
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The Selection tools are used to select a shape or groups of shapes.

The Regrouping tools are used to combine performers into different groups for editing and maneuvering.
Also in this group is an Adjuster tool for quickly adjusting individual placements.

The Drawing tools are used to draw shapes.

The Editing & Maneuvering tools are used to create transitions as well as edit shapes.

The Extras tools are used to add and modify information about performers such as their label and symbol.
These tools can also be used to draw special items such as instructions or arrows.

Perspective Window (Classic)

The Perspective Window is manipulated by using the tools in the upper right corner of the window. The
Perspective Window defaults to the minimized (hidden) status when the program is opened. The
Perspective View will appear by click on the Minimize button.

The Minimize button reduces the window to show only the title bar. When the window is minimized, the
Perspective View calculations are disabled allowing for a faster refresh rate of the field window.

To Resize the Perspective View, click and drag the bottom right corner of the Perspective View window.

The Tilt button tilts the view in the window. After click on the button, move the mouse into the Perspective

For information on the Real View window, please click here.*
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View window, then click and drag in the direction that you want the display to tilt.

The Shift button moves the field into view. After selecting the button, move the mouse into the perspective
view window. Click and drag to shift the display. [ALT] click on the Shift button returns the window to its
default view.

The Zoom buttom zooms the view in or out. After clicking on the button, move the mouse into the
Perspective View and click again to zoom IN. Hold down the [CTRL] key and click to zoom OUT. [ALT] click
on the Zoom button returns the window to its default view.

Cameras (Interactive and Professional editions only): There are 6 Camera radio buttons available for
you to quickly jump to different viewing angles when watching the animation or previewing a chart. To set
specific angles to a preset button, change the view point in the Perspective View window to your desired
angle, then press the Set button. A new window will appear which prompts you to select a camera number
for this specific angle. Once you create a camera angle through this process, you may instantly jump to that
view in the Perspective View anytime during the design or previewing animation process.

To remove all saved camera angles, press the Set button then choose Clear All.

Production Sheet (Overview)
Available in Interactive and Professional editions only.
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The Production Sheet is a helpful tool that allows you to develop your show “timeline” in 3D before any
charting begins. Think of the Production Sheet as a “map” to your drill. Within this tool, you are able to
notate which measure of a piece will be the transitions between Page Tabs, along with adding any notes,
such as “Big Hit” or “Winds face back field.”

Set indicates the set (page tab) number you are working on.

Placing a check mark in the Sub column would indicate that the current Set is a Subset.

The Count column displays which count a set is on.

Transition shows how many counts there are to get to a particular set.

Selecting a row under the Measures column would allow you to input which measures the set is
referencing.

Title works much like the Measures column. If you click on a row under the Title column, you would be able
to input a title for that particular set.
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Note columns are there for any quick instructions or notes the ensemble (or you) might need. These notes
can be quickly imported into a Text Box and displayed on the field through the Text Box Tool.

To pull the Production Sheet away so you may view the field and the Production Sheet at the same time,
press the “Detach” button in the upper right corner of the Production Sheet window. You will now be able
to drag the Production Sheet anywhere on your screen. To pin the window back to 3D, press the “Pin”
button.

Backup Drill
With a computer, bad disks, damaged files, computer lock-ups and hard disk crashes are a fact of life.
Although these occurrences are few and far between, they inevitably seem to happen to everyone at least
once. Take the precautions mentioned below and your drill designing days will be virtually trouble free.

Separate Files for Each Movement

To prevent losing large amounts of work, it is advisable to create a separate file for each drill segment or
movement. Smaller files will also speed up animation and at times, solve certain printing problems.

Save Often

Your time and effort is very valuable. We suggest saving every fifteen minutes when working on a file.
Nothing is more frustrating than losing drill all because you did not save your work. It is easy and takes very
little time. Just select Save from the File menu.

Keep Multiple Files Multiple Places

Work from the drill files that you have stored on your hard drive, however, also put your drill files on disc or
an external storage device and store them. Keep copies in multiple locations. Hard drives crashes can
completely wipe out your entire drill design library as well as other important files stored on the computer.
Never keep your files at only one location.

File Versioning

Make quick hard drive backups by choosing Save As from the File menu and changing the name of the file.
One common method of making backups is by ending a file name with a number such as 01 and then
incrementing the number for each backup. For example: Name your opener “Opener01”. After an hour of
work, choose Save As and change the name to “Opener02” and so on. The name with the largest number is
the most current and all others are older at one hour increments. This makes it easy to go back to earlier

Selecting a set on your Production Sheet is like selecting a page tab on the Count Track.
This is another quick way to preview a set.*
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versions. After you have collected several copies, start deleting the oldest ones, and occasionally move
copies to the external storage device.

Automatic Backups

Use the Backups section of the Application Options found in the File menu. Check *“Always backup after
using Save.” See the Backup section of Menu Bar for details.
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3D Tutorial
Perhaps the best way to learn Pyware 3D is to progress through the development of a simple drill. Please
read the previous section before beginning this tutorial to understand some of the terminology. We strongly
urge you to complete this tutorial. It will introduce you to the basic functions and options of the program.

Click through to the first topic: New Drill.

New Drill
Start 3D. After a few moments, the 3D cover page will appear. A new file will be created and displayed using
the default field grid layout. A Count Track will appear at the bottom of the screen. The Count Track
determines which count of the drill will be displayed.

To name our file, choose Save As under the File menu.

Type “Tutor” for the file name and choose Save.

Page Tabs
To begin, we will set four Page Tabs on the Count Track to designate specific counts as “Hit” points for our
drill. Page Tabs will allow you to jump to various parts of your drill quickly and easily.

Click on the Page Tab Lock button at the bottom right corner of the Count Track.

Click on the yellow panel below count 0 of the Count Track. The Page Tab will appear as a small white box
on the track at count 0. Make sure that you have added the page tab on count 0 and not count 1. If the page
tab was added on count 1, simply click and drag the page tab over to count 0. You can drag page tabs to
any count on the Count Track.

The program has fully loaded once you see the 3D Perspective window (or Real View). We
recommend waiting for this window to load before performing any tasks in 3D.*
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Click on the yellow panel below count 16 of the Count Track. The Page Tab will appear as a small white box
with the number 2 on the track at count 16.

Click on the yellow panel below count 48 of the Count Track. The Page Tab will appear as a small white box
with the number 3 on the track at count 48.

Click on the yellow panel below count 72 of the Count Track. The Page Tab will appear as a small white box
with the number 4 on the track at count 72.

Finally, to complete adding Page Tabs, click on the Page Tab Lock button at the bottom right corner of the
Count Track. This will lock the Page Tab Lock and lock the new page tabs in place.

Select Save from the File menu to save the drill file with its new page tabs.

Drawing Lines
We’ll start our first drill with two mirrored horizontal lines.

Click on the Page Tab at count 0 on the Count Track. The Page Tab appears as a small box beneath count
0 of the Count Track. The Yellow and Red Anchors will return to the beginning of the Count Track.
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Locate the Tool Palette and click on the Line tool button. A Line Tool Control Panel will appear.

In the Line Tool Control Panel, click on the padlock assigned to the Restrict Horz/Vert option. This will
lock the lines to be drawn as only horizontal, vertical and 45 degree diagonals.

We can choose to first determine positions and interval prior to drawing a new shape. Type “22” in the
Positions text field. Leave a “0” in the Interval text field.

To place the 1st endpoint of the line, move the cursor to the left of the 50 yard line where the Location
Indicator located in the Console reads 45 yds 6 steps | 42 steps and click the mouse.

To place the 2nd endpoint of the line, move the cursor until the Location Indicator reads 20 yds 4.00 stp |
42 stp and click the mouse.

In the Control Panel, 22 positions will appear along with an automatically calculated interval based on the
length of the line you have entered.

Editing Handles will appear at the endpoints of the line, and a red Repositions Handle will appear in the
middle of the line. These handles can be used to reshape and edit the line.

Experimenting With Editing Options
Before committing this shape to the file, this would be a good time to experiment with various editing options
found in the Line Tool Control Panel. Click and unlock the padlock to the right of the Positions text field.
Whenever the padlock is unlocked you are allowing the value in this field to be automatically calculated.
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Enter “2” (steps) in the Interval text box. The padlock to the left of the interval text box will automatically
“lock”. This lock indicates that the interval will not change when you manipulate the shape. Since we have
locked the interval, the number of positions change as you manipulate the length of the line while the
interval stays the same.

While leaving the value “2” in the Interval text box, enter “28” in the Positions text field. The padlock is now
locked on both the interval and positions. Since we have locked the interval and the number of positions, the
shape automatically scales to keep the defined interval and number of positions.

Unlock the Positions padlock.

Drag the red edit handle assigned to the LEFT endpoint of the line until the Location Indicator reads 15
yds 4 steps | 42 steps and release the mouse button. As you drag the edit handle, positions are added or
removed to accommodate the locked interval.

Unlock the padlock assigned to the Restrict Horz/Vert option. When restrict is unchecked, line endpoints
can be placed at any point on the field.
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Drag the red edit handle assigned to the LEFT endpoint of the line until the Location Indicator reads 15
yds 4 steps | 28 steps.

(Re)lock the padlock assigned to Restrict Horz/Vert option. The shape will return to its horizontal
placement.

In the Control Panel, enter Positions = “20” and Interval = “2” in text fields.

Enter “1” in the Clone text field. The Clone option is used to duplicate a shape across an axis. The next few
steps will experiment with the Clone option.
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Change value in the Clone text field to “2”. When more than one clone is entered the shapes multiply
around a point indicated by the clone handle.

Now, change the value in the Clone text field to “3”. Click and drag the clone handle until all four lines form
into a box.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 62 of 407



Changing Placement of the Shape
The next few steps will experiment with changing the placement of the shape. This can be done with the
Reposition Handle located in the middle of the top line. To move the shape to a different location on the
field, drag the center of the Reposition Handle.

You can also use the Reposition Handle to reposition the shape by rotating it. The center of the
Relocation Handle is the Point of Rotation. You can change the Point of Rotation by dragging the outer
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ring of the Reposition Handle.

Rotate the placement of the shape by dragging the Rotator Arm of the Reposition Handle.

It’s time to stop experimenting and to actually enter a shape. Let’s cancel the shape we have been working
with and start again. Clicking on any tool in the Tool Palette will exit from any tool you are currently using. If
the tool you click on is the same tool you are currently using, it is like starting over with the tool. So, click on
the Line tool in the Tool Palette to deselect it and therefore cancel the creation of the new shape.

Line Tool (Take 2)
Click on the Line tool to open the tool if it is not already open. A Line Tool Control Panel will appear.

Click on the padlock assigned to Restrict Horz/Vert option in order to restrict the line to either horizontal,
vertical, or 45 degree alignment.

If not already done, enter these values into the Control Panel: Positions = “20” and Interval = “2’.

On the field, place the 1st endpoint of the line to the LEFT of the 50 yard line where the Location Indicator
reads 45 yds 6 steps | 42 steps and click your left mouse button.

Place the 2nd endpoint of the line to the LEFT of the 50 yard line where the Location Indicator reads 20
yds 4 steps | 42 steps and click the mouse button. Twenty positions will appear in a line at a 2 step
interval.

Change the value in the Clone text field to “1”. There are now two horizontal lines on either side of the 50
yard line.

You can also cancel out of a tool by pressing the [ESCAPE] key on your keyboard or right-
clicking anywhere on the field.*
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Before accepting the shapes designed you can assign the shape’s positions a Symbol and Color. The
default symbol and color is currently shown in the Control Panel. The symbol should be an “X” and the
color should be blue. If not, enter them now.

Click Accept in the Control Panel. You should see 40 positions divided into two lines on count 0 . The
Console is showing the number of Performers as 40.

Drawing Arcs
The next shape we’ll design will be a simple arc of 30 positions. Both endpoints of the arc will connect to the
outside endpoints of the two lines.

Click on the Arc tool in the Tool Palette. An Arc Tool Control Panel will appear.

In the Control Panel, enter “32” in the Positions text box.
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To place the 1st arc endpoint, move the cursor to the RIGHT of the 50 yard line where Location Indicator
reads: 25 yds 0 steps | 42 steps and click the mouse button. Yes, we are locating the endpoint directly on
top of the last line.

To place the 2nd arc endpoint, move the cursor to the LEFT of the 50 yard line until the Location Indicator
reads 25 yds 0 steps | 42 steps and click the mouse button.

To assign the arc’s peak, move the mouse until the Location Indicator reads 50 yds 0 steps | 20 steps
and click the mouse button.
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Experimenting With Editing Options
Before committing this shape to the file, this would be a good time to experiment with various editing options
in the Arc Tool Control Panel.

Change the value in the Data Point text box to “3”. Three data points creates a 2 sided V shape.

Now change the value in the Data Point text box to “4”. Four data points creates a 3 sided shape.

To continue with this exercise, change the value in the *Data Point” text box back to “20” to return to the
original arc shape.

Click on the Omit Overlaps option in the Control Panel.

When we created the arc, the two endpoints of the arc were entered on top of existing positions. The
endpoints were entered as “pic” points and not intended to be filled with a performer because we have
already placed performers at those points. Omit Overlaps removed the overlapping endpoints thus
preventing two performers from being on top of each other.
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Click the Accept button in the Control Panel. The Console has updated performers to 70.

Select Save from the File menu.

Drawing Circles
The third shape to be entered in our drill will be a circle.

Click on the Circle tool in the Tool Palette. A Circle Tool Control Panel will appear.

In the Control Panel, enter Positions = “24” and Interval = “2”.

If not already checked, check the Lock to Circle option.

To place the center point of the circle, use the Location Indicator in the Console to move the cursor to 50
yds 0 steps | 56 steps and click the mouse button.
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To place the circle circumference point of the circle, move the cursor on the field until the Location
Indicator reads 45 yds 4 steps | 48 steps and click the mouse button.

Experimenting With Editing Options
Before committing this shape to the file, this would be a good time to experiment with various editing options
in the Circle Tool Control Panel. Select the Offset Spacing option. This will attempt to equally distribute
the positions of the circle across the point entered as the circumference.

Unlock the Interval padlock and uncheck the Lock to Circle option. This creates an oval shape. The two
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red square editing handles can be used to shape the oval. You could also use the Reposition Handles to
shift and rotate the oval.

Recheck the Lock to Circle option. The circle will snap back into place.

Change the value in the Data Points text box to “3”. Notice this procedure creates an “outlined” triangle.
Similarly you could create an enclosed shape with any number of sides.

Click on the Circle tool in the Tool Palette to de-select the Circle tool and cancel the creation of the circle.

Circle Tool (Take 2)
Now let’s re-enter the circle.
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Click on the Circle tool in the Tool Palette. A Circle Tool Control Panel will appear.

If not already entered, in the Control Panel, enter Positions = “24” and Interval = “2”.

If not already checked, check the Lock to Circle option.

If not already checked, check the Offset Spacing option.

To place the center point of the circle, use the Location Indicator in the Console to move the cursor to 50
yds 0 steps | 56 steps and click the mouse button.

To place the circumference point of the circle, move the cursor on the field until the Location Indicator
reads 45 yds 4 steps | 48 steps and click the mouse button.

In the Control Panel, change the Symbol to “G” for Guard and the Color to a shade of red.

Click Accept to enter the circle.

Select Save from the File menu.
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Moving Lines
We have now created the opening formation at count 0 which is set #1. Now we will create the next set by
“morphing” or reshaping your formations at set #2. Initially 3D has established a mark time between set #1
and set #2. As we reshape the formation at set #2, 3D will automatically create the transitions to set #2 from
set #1.

To indicate the count of the next set and the number of counts in the transition from the last set, we will
spread the anchors in the Count Track over those counts. Setting the Yellow Anchor at count 0 and the
Red Anchor at count 16 will set up the field for editing of the formations at count 16 and create a 16 count
transition between count 0 and 16.

Click on Page Tab #2.

The Red Anchor will snap to count 16, leaving the Yellow Anchor at count 0. When advancing the Red
Anchor, the performer’s field locations will not appear to change even though we are now looking at count
16. This is because editing has not been done. Performers at count 16 are holding from count 0. In fact, 3D
has established a hold to the end of the drill.

To create the formation at set #2, you will be selecting shapes and then using edit tools to reshape them. In
this example, our Red Anchor is at count 16 and therefore the shapes we are editing are at count 16. Since
the Yellow Anchor is at count 0, the transitions will be created between count 0 and 16. From count 0 to
count 16, we will have the two lines Push (or move) forward towards the home sideline.

In order to Push the lines, we first need to select the lines on the field. In this example, we will choose a
Box Selection tool for that purpose. Select the Box Selection tool from the Tool Palette.

Click above and to the left of the first position of the left line and drag down and to the right until both lines
are encompassed within the rectangle you will be creating.
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The performers of both lines will be outlined in bold red indicating that the two lines are selected.

Now that we have selected the two lines, we need to choose a tool to manipulate them. Click on the Push
tool in the Tool Palette. A Push Tool Control Panel will appear.

Before committing this transition to the file, this would be a good time to experiment with various editing
options of the Push Tool Control Panel. Press the [DOWN ARROW] key of the computer keyboard 16
times. This procedure is used to push a shape implementing the down or up arrow keys.

You can drag any editing handle located on each performer in the selected lines to a new location. All
selected places will similarly move as well.

Click on the Revert button. The shape will return back to the original location.

In the Stride text box, enter the number “8”. This will cause each position to move a distance at a stride of 8
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steps to 5 yards in 16 counts (the number of counts between our Yellow and Red Anchors).

Located on the left side of the Count Track are the Animation Controls. Click on the Play button and the
selected line will move forward. When the pointer on the Count Track reaches count 16, the animation will
stop.

Click Accept to accept the movement of the selected lines.

Select Save from the File menu.

Splitting Shapes
There will be times when you will want one portion of a shape to separate and “split off” from the rest of the
shape.

You’ll first need to select a shape that you want to split into two parts. In this example, we will select the arc.
Select the Pointer Selection tool of the Tool Palette. You can also activate the Pointer Selection tool by
right-clicking on the field.

Click on any position of the arc. All performers in the arc will appear in bold red to indicate that the shape is
selected.
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Click on the Knife tool in the Tool Palette. A Knife Tool Control Panel will appear. The Knife tool is used to
cut a shape into two or more shapes.

The Knife Tool Control Panel behaves differently from other tool panels. By default, there is no active
Accept button. Every cut with the knife is accepted without having to click an Accept button. This is usually
preferred because the Knife tool is used quite frequently for single cuts. Requiring the click of an Accept
button would simply add an extra step. However, if you wish to make the Knife Tool Control Panel behave
like typical 3D control panels, you would uncheck the Accept each change and stick around… option.
When this option is off, the Accept button will be available, and if not clicked when you are finished cutting,
no changes will occur.

With your cursor, click on one of the two positions closest to the 50 yard line. A red bubble will appear on
the position.
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Click on the other position that is closest to the 50 yard line. A gap will appear between both positions. The
two arcs created will now act as two separate shapes.

Mirroring Motion
In one step, we are going to Push the two arcs in two different directions. On the Count Track, make sure
the Yellow Anchor is set to count 0 and the Red Anchor is set to count 16.

First, we will need to select the two arcs. Select the Pointer Tool in the Tool Palette.

Click on any position in one of the two arcs. All of the performers in the arc will appear in bold red to
indicate the arc is selected.
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Press and hold the [SHIFT] key while clicking on any position in the other arc. It will also display in bold red.
Holding the [SHIFT] key while selecting a shape will add that shape to any previously selected shapes or
positions.

The two arcs are selected. We will choose the Push tool to move these selected arcs to a new location.
Select the Push tool in the Tool Palette.
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Click on the Left/Right Mirroring option in the Push Tool Control Panel.

Click on the inside position of the RIGHT arc. Click and drag the position until the Location Indicator reads
40 yds 0.00 steps | 8.00 steps. Both arcs will move in motion mirroring left/right to each other. Light gray
lines indicating each selected performer’s path will appear as you move the cursor.

If adjustment needs to be done, simply click and drag the shapes to the desired location. The maneuver will
not be committed to the drill until you click the Accept button.

On the left side of the Count Track are the Animation Controls. Click on the Play button to preview the
moving arc with the moving lines.

Click on the Accept button to commit the new move to the drill.

Select Save from the File menu to save the changes to the file.
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Expanding Circle
!https://manula.s3.amazonaws.com/user/484/img/circledrawn-resize3.png!From counts 0 through 16, we will
expand the (color guard) circle.

On the Count Track, make sure the Yellow Anchor is set to count 0 and the Red Anchor is set to count 16.
Clicking on the page tab on count 16 will set both anchors at one time.

To select the circle for editing, click on the Pointer Selection tool in the Tool Palette.

Click on any position in the circle and all of the performers in the circle will be highlighted in red indicating
that they are selected.

Click on the Resize Tool in the Tool Palette. A Resize Tool Control Panel will appear.

In the Control Panel, if not already selected, click on the Scale option.

Let’s experiment with options in the Control Panel. Click and drag the lower left (red) handle until the
Location Indicator reads 40 yds 0.00 steps | 40 steps. The circle will expand away from the center. The
outside edge should touch both 40 yard lines.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 79 of 407



Click directly in the center of the Reposition Handle and drag until the Location Indicator reads 50 yds
0.00 steps | 36 steps. The circle will not only expand, but it will also move towards the home sideline.

On the left side of the Count Track are the Animation Controls. Click on the Play button to preview the
expanding circle with the movement of the other shapes in the formation.

Click the Revert button in the Control Panel so the circle will return back to its original shape.

Click and drag the lower left (red) editing handle until the Location Indicator reads 35 yds 4.00 steps | 36
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steps. The circle will expand away from the center.

Click on the Accept button to commit the change to the drill.

Select Save from the File menu.

Creating Set #3
You have completed the first 16 counts of drill. To continue to the next set, you must move the Red and
Yellow Anchors on the Count Track. From counts 16 through 48, we will reshape the two arcs using a
Follow the Leader maneuver.

Click on Page Tab #3. The Yellow Anchor will jump to count 16 and the Red Anchor will jump to count 48.

First we need to select the two arcs. In this example we will choose the Lasso Selection Tool. Select the
Lasso Selection tool from the Tool Palette.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 81 of 407



Using the cursor, click and drag a lasso around both arcs. Once selected, both arcs will be shown in bold
red to indicate they are selected. Since the Lasso Selection tool selects only places that are inside the
lasso, it is possible to miss some positions. Make sure all of the performers in the arcs are selected.

Click on the Follow the Leader tool in the Tool Palette.

Red “leader” dots highlighting the end performers on each arc indicate the performer that will be the leader
for the follow the leader movement. Depending on your application, the correct leaders may already be
chosen, and this step is not necessary.

We need both of the leaders to be the outer most performers of the arcs. If both red “leader” dots are not on
the proper position of one or both of the arcs, you will move the “leader” dots to the proper endpoint by
clicking on the incorrect “leader” dot. The red “leader” dot will automatically move from one end of the arc to
the other.
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The picture above is a sample of leaders where the leader in the left arc is on the incorrect endpoint.

The picture above is a sample of leaders who are correct.

In the Follow the Leader Control Panel, click on the Left/Right Mirror option.

Click the mouse on the RIGHT side of the field at the location where the Location Indicator reads 35 yds
0.00 steps | 44.00 steps to start a path. A straight path for both shapes will appear. A red editing handle
(square) will appear at the point where you clicked.
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Press and hold the [SHIFT] key while clicking the mouse approximately halfway up one of the pathways of
one of the arcs. A new editing handle (red square) will appear on the RIGHT path.

Click and drag the new editing handle until the Location Indicator reads 15 yds 5.00 steps | 41 steps.
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Using the Play button in the Animation Controls of the Count Track preview the animation.

Click Accept to commit the change.

Save your work.

Gluing Lines
There will be times when you will want to connect (or reconnect) one shape to another. This function is most
important when maneuvering two (or more) shapes into one large formation.

For this example, make sure the Count Track’s Yellow Anchor is at count 16 and the Red Anchor is set to
count 48.

Select the Box Selection tool from the Tool Palette.

On the field, select both lines.
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Select the Glue Tool in the Tool Palette. A Glue Tool Control Panel will appear.

With your cursor, click on one of the two positions closest to the 50 yard line. A red bubble will appear.

Click on the other position closest to the 50 yard line. A red line connecting both positions will appear. The
two lines will now behave as one line when selecting it.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 86 of 407



Save your work.

Morphing Lines
In this exercise we will “reshape” the lines into a new shape.

For this example, make sure the Count Track’s Yellow Anchor is at count 16 and the Red Anchor is set to
count 48.

If not already selected, select the line with one of these selection tools: Pointer Selection, Box Selection, or
Lasso Selection.

Click on the Morph Tool in the Tool Palette. A Morph Tool Control Panel and red editing handles will
appear over each performer of the selected line.
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Experimenting With Editing Options
Let’s experiment with some of the option in the Morph Tool and its Control Panel.

Drag any of the editing handles to any position on the field. When one handle is adjusted, pathways for
each position of the selected shape will be altered in order so that equal spacing is maintained in the new
shape.

Click Revert to return the shape back to its original shape.

Click on the Delete Half (handles) option in the Control Panel. The fewer number of editing handles you
work with, the more fluid shapes will become.
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Continue to click the Delete Half button until only three handles are remaining on the shape. If you click too
many times, click Revert and try again.

Drag the second editing handle until the Location Indicator reads (Right) 40 yds 0.00 steps | 12 steps.

Use the Play button in the Animation Controls to preview these changes.

Adding an Editing Handle
Now we are going to put an editing handle back in the shape. Press and hold [SHIFT] while clicking the
mouse on the left side of the second editing handle. A new editing handle will appear on the shape.
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Click and drag the new editing handle to the location indicated by the Location Indicator (Left) 40 yds
0.00 steps | 40 steps.

Use the Play button in the Animation Controls to preview these changes.

Removing an Editing Handle
Now let’s remove a single editing handle. Press and hold [SHIFT] and click directly on the second editing
handle to the left of the 50 yard line. The handle will vanish and the shape will change accordingly.
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Click and drag the next to last editing handle until the Location Indicator reads 50 yds 0.00 steps | 0.00
steps.

Click and drag BOTH outside editing handles (the endpoints) until the Location Indicator reads 15 yds
6.00 steps | 24 steps. If necessary, re-adjust the endpoints to connect with curvilinear forms on either side
of the circle.
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Use the Play button in the Animation Controls to preview these changes.

Click Accept to commit the morphed shape to the drill.

Save your work.

Pass Through Example
In this example we’ll transform the circle into a meshed vertical line. To achieve this, we will use the Knife
tool, Glue tool, and the Morph tool.

Make sure the Count Track’s Yellow Anchor is at count 16 and the Red Anchor is set to count 48.

If not already selected, select the circle on the field using one of the Selection tools.

Click on the Glue tool in the Tool Palette. A Knife/Glue Control Panel will appear.

Click the Regroup All button in the Control Panel. Observe that the circle shape will segment into
individual positions. Next, we will “reorder” the positions in a pattern to achieve our *X/O” grouping.

With the cursor, click on the position at the top of the circle and to the left of the 50 yard line. A red dot will
appear on that position.
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Move the cursor across the 50 yard line and click on the position at the top of the circle and to the right of
the 50 yard line.

Move the cursor to the left and select the next position left of the 50 yard line.
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Continue selecting each position of the circle in the same “zig/zag” pattern until all positions of the circle
have been selected. If you mess up, simply click the Undo Last or Regroup All and start again.

Once all positions in the circle have been regrouped, use a selection tool such as the Pointer Selection tool
to select the circle. Notice that the blue lines in the selected circle have now been rearranged to indicate the
new grouping order.
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Now that we have regrouped the circle to a zig-zag pattern, if we morph the circle into a line, it will make the
circle positions mesh. Click on the Morph tool in the Tool Palette.

Click on the Delete Half button to remove editing handles in the Morph Tool Control Panel until all but the
handles at the end points of the shape remain.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 95 of 407



Click and drag the upper editing handle until the Location Indicator reads 50 yds 0.00 steps | 72 steps.

Click and drag the lower editing handle until the Location Indicator reads 50 yds 0.00 steps | 12 steps.
The red line drawn from one of the positions designates the performer who is traveling the furthest distance
during the transition. The Step Length and Distance Traveled by this performer is displayed (in red) in the
Console.
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Use the Play button in the Animation Controls to preview these changes.

Click Accept to commit the changes to the drill.

Save your work.

Creating Set #4
You have completed the first 48 counts of drill. Let’s move on to the next set. In the final set of the drill we
will:

1. Segment the large arc into two smaller arcs
2. Draw two new mirrored shapes on count 72 with performers coming from two preexisting arcs
3. Match the positions of the preexisting arcs on count 48 to positions of the two new mirrored shapes on

72

Click on Page Tab #4. The Yellow Anchor will jump to count 48 and the Red Anchor will jump to count 72.

Select the large arc using a Selection tool.

Click on the Knife tool in the Tool Palette. A Knife/Glue Control Panel will appear

We will cut the arc into two smaller arcs. With your cursor, click on one of the two positions closest to the
left of the 50 yard line. A red bubble will appear.
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Now click on the other position closest to the 50 yard line. A gap will appear between the two positions
indicating the large arc is now two smaller arcs.

Select both arcs again using either the Pointer Selection tool, Box Selection tool, or Lasso tool.

Click on the Curve tool in the Tool Palette. A Curve Tool Control Panel will appear.

In the Curve Tool Control Panel, enter “20” in the Positions text box.
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Uncheck the Omit Overlaps option. Check the Predict Next option.

On the field, click the following points to create the shape of the curved form.

LEFT 45 yds 6.00 steps | 16.00 steps
LEFT 35 yds 4.00 steps | 4.00 steps
LEFT 25 yds 0.00 steps | 20.00 steps
LEFT 10 yds 0.00 steps | 12.00 steps

While entering these points, the red editing handles will appear at each point. These editing handles can
be dragged to adjust the shape. We are creating this curve with only four points because the fewer number
of editing handles the smoother the curves of the shape will be.

Enter in the Clone text box “1”. Two mirrored shapes of 20 positions will appear.

Matching Positions
Currently displayed are gray matching “crisscrossing” lines, connecting some of the performers of the
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preexisting arcs to the places in the newly designed curves. The matching lines indicate which performers in
the preexisting arcs will move into the places in the new curved shapes. These gray matching lines display
the current “matching order”. Criscrossing paths typically aren’t a desired result, so we’ll need to change the
pathways of these performers. We will enter a new matching order by rearranging the matching lines to
connect or “move” the performers from their current positions in the arcs to their new places in the curves.

Click on the Clear button in the Curve Tool Control Panel. All of the gray matching lines will vanish, and a
red bubble will appear on the endpoint of one of the new curves. The red bubble indicates the new place
that we will be matching first.

3D has a matching prediction function that will attempt to complete the matching order based on your first
few matches. In the Control Panel, click the Predict Next option ON in order to enable this feature.

To get the matching prediction function started, you will need to make the first match. The new position
inside the red bubble needs to be matched with one of the performers of the arc. To do that, click on the
performer at the endpoint of the LEFT preexisting arc. This is the performers that we want to be moved into
the new place highlighted by the red bubble.

As shown here, the red bubble advances to the next place in the new curve after the first match was made.

Click on the next performer of the preexisting arc. Again, this will move the performer currently located in
the arc to the new place in the curve highlighted by the red bubble. After this match, the Predict Next
function will take over and attempt to correctly match the remaining positions of the first shape according to
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your initial matches as shown here.

Move to the opposite shape and repeat the shame process.

Animate the drill if you want to preview your matching. Should you think you made mistakes and want to
start over, click the Clear button and try this section again.

Click Accept to commit the curves to the drill.

Save your work.

Reviewing Sets
Let’s see what we have so far.

On the Count Track, drag the Yellow Anchor back to count 0.

Make sure the Red Anchor is on count 72.
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In the Animation Controls, click on the Play Button.

Printing Your Drill
Since Page Tabs have already been inserted, it will be very simple to print desired pages.

From the File menu, choose Print Charts. A dialog box will appear allow you to configure the way in which
your charts are to be printed.

In the Print Selection options, choose From Page Tabs.

In the Overlay Set options, choose Use Previous.

Click the Print/Preview button. A dialog box will appear allowing you to preview the printout and configure
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Page Setup options. The Page Setup dialog box can differ, depending on the printer you are using.

Click Print and your printer’s dialog will appear. Click OK (or Print) will start your print job.

Finish
You have completed the Pyware 3D tutorial!

We’ve tried to show you many of the basic design elements of 3D to get you accustomed to our drill design
application, however there is still much more! We encourage you to review the manual to get the most out of
your design efforts.

If you have designed drills prior to completing the demo, we recommend charting those
drills in 3D. You’ll be able to pick up 3D’s functionality quicker as you already know how the
drill is supposed to progress. This allows you to focus more on program use as opposed to
design.

*
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Menu Bar
The following topics cover everything you will find in 3D’s menu bar.

Click on the arrow next to Menu Bar in the Table of Contents to the left to expand this section and begin.

File Menu
The File menu contains standard File menu options; options for creating new drills or opening existing ones,
saving, and printing. You’ll also find options for both the drill you’re working on (Document Options), or
options that apply to the entire program (Application Options).

File: New Drill

3D Data File Types
3D has three types of data files:

• 3D Drill file, the original data file in Pyware 3D.
• 3D Drill Package file which is a combination of a 3D Drill file and its external files. External files

consist of audio files, prop images, floor covers, fabrics, surfaces and grounds.
• 3D Production files which are a collection of 3D Drill Packages. When Drill Packages are combined,

they make an entire show (production).

New Drill
New Drill is used to create a new drill file or continue an existing drill from another file. Selecting New Drill
from the File menu will display the New Drill File dialog.
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Drill Title is the title of the drill as it appears on printouts and in productions.

Field/Stage Grid Layout is the type of grid that is used for the design and performance surface. Clicking
Browse will display the list of available fields. You can create your own grid layouts from the Grid Designer
found in the Utilities menu.

Maximum Counts is the number of counts in the new drill file.

Real View Venue will add an environment setting, such as a stadium, gymnasium, or parade route to the
Real View window.

Real View Sky option has various skies to choose from to enhance the Real View scenery.

Real View Ground will replace the ground surface and surrounding field areas with whichever option you
choose. When loading a Ground, we recommend choosing a surface file as well, such as a High School
Football Field.

Real View Surface allows you to import a performance surface to overlay on the field. This aids with
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customization of the performance surface, as you could use images that represent tarps, football fields,
basketball courts, etc.

File: Open Drill
Open is used to open a file located on a storage device such as your hard drive. Selecting Open from the
File menu will display the Open a Drill File dialog.

“Drill files in” shows the directory on the storage device that is displayed in the file list. Browse allows you
to choose a different directory to look in.

The drill file list contains drill files, drill packages and folders. Clicking on any of them and clicking Open will
open the selection in the list.

We recommend that you create separate files of major segments of the show or each
musical selection. This will make writing and teaching the drill much more manageable. 3D
will allow you to copy the last set of one drill in a file and paste it to a new file as the first
set.

*
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The Get a 3D File Online button will open the Online File Manager where you can select a file to download
from a 3D online account. The Online File Manager is covered in detail in the Interactive menu. (This
features is available in Interactive and Professional editions only)

Go to Drills Directory will show the list of drill files in the default drill files directory.

Go to Backups Directory will show the list of drill files in the default backup drill files directory. The location
of the backup drill files directory can be changed from the Application Options: Backups tab of the File
menu.

Go Up One Directory will move up one directory from any sub-folders found in the directory you are
currently viewing.

File: New Production
Since a production is essentially a collection of drills that when combined make a whole show, you must
have at least one saved drill available to put into your new production before you can create the production.
When a drill is added to a production it is moved from the “Drills” folder into the production file. You will no
longer find your drill in the “Drills” folder. You will, however, find your drill when you open the production.

A production will appear in the Open Drills dialog just like a drill or drill package. When you open the
production you will see the list of drills in the production in the Open Drill dialog. The production behaves
similarly to a sub-folder in the “Drills” folder.

Select New Production from the File menu and the following dialog will display. Click Next to continue to
the next step.
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Enter the title of the production. The production title will be used as the file name of the production’s main
title. After entering the production title, click Create and then click Next to continue to the next step. If there
is a production with the same title in your Drills folder you will be asked to choose another.
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Enter the description of the production that will appear on cover sheets. Click Next to continue.
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The 3D production file is a very powerful file. 3D Productions can be sent online (using a 3D Online
Account) for performers (students) who can in turn download directly into their 3D Performer’s Practice
Tools program where they can use the Production file to do the following:

• Productions can be opened in the 3D Performance Simulator where performers can practice their
drills for scores.

• Production drill books can be printed that include all of the drills in a production in a single book.
• Production coordinates can be printed that include all of the drills in a production in a single list.
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Setting Enable Print Functions will control whether or not a production can be printed from within the
Performer’s Practice Tools program. Occasionally, if a designer has uploaded a production for preview only,
they do not want the performers to be able to print. Drills can also be individually locked from printing and
editing. If a drill has been locked it will not be able to print even if the Enable Print Functions is selected.

Setting Enable Leader Board Functions will control whether or not a production will have leader boards.
Some designers or directors) may choose to disable the *Leader Board functions.

Choose which drill files you want included in your production. The drill files must have been saved as Drill
Packages and they must have any audio files included. To move a drill into the production click on the drill,
and then click the move (right) button. To move a drill out of a production, click on it in the production list,
and then click move (left).
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You can also rearrange the order the drills will appear in the production by clicking on a drill in the
production list and clicking move up or down.

Remember, when you move a drill into a production you will no longer find it loose in the drills folder. You
will find it by opening the production then opening a drill within the production. The production is like a sub-
folder in the “Drills” folder.

The summary will display showing the production setup. Click Build Production and you are done. Now if
you want performers to download the production, you must first upload it to your 3D account. Use the
Online File Manager from the Interactive menu to do that.
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File: Open Production
Productions are collections of drills combined into one file to make a production. When you select Open
Production you will see the list of drills within the production to open.

Select Open Production from the File menu.

You will see in the Open dialog the list of productions. Click on a production you want to open and click
Open.

The list of drills found in the production will display. Click on the drill within the production you want to open
and click Open.

When a production is opened you can only work with drills in that production. To work with other drills not in
the production you will need to first close the production by using Close Production from the File menu.
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File: Add/Remove Drills In Production
When a production is opened you can change which files are in the production with this function. You can
also create a new drill or create a continuation drill of an existing drill in the production. This is handy when
you have finished one drill and want to move on to the next.

File: Production Options
Production Options consist of the production description, Performer’s Practice Tools settings, and the
list of drills that are in the production. Production Options will be available only if you have a production
currently opened. (see Open Production or New Production). The Production Options are the same as the
options that you set when you create a New Production (see New Production for details).

File: Close Production
When productions are opened, you can only work with drills that are in that production. When you are ready
to work with a drill that is not in the production you will need to close the currently opened production first.
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To close a production, select Close Production from the File menu.

File: Save / Save As

Save
Selecting Save from the File menu will save your recent changes to the file. If a file has not been saved
before, a Save As dialog will display for you to name the file on the storage device (typically the hard disk).

Save As
You can also choose Save As for a file that has already been saved. This will allow you to save another
copy of the drill file with a new name. This is a great way to keep copies of earlier versions of a file should
you choose to go back for some reason. To keep your file versions straight we recommend you rename the
file by adding a number to the end of the name such as: opener01, opener02, opener03…

This is the dialog that appears for Save As:

Drill files in shows the directory on the storage device that is displaying in the file list. Browse will change
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the directory shown in the list.

The drill file list contains drill files, drill packages and folders. Clicking on any of them and clicking Save will
save the file to the location in the list.

The Go To Drills Directory will show the list of drill files in the default drill files directory.

Go Up One Directory will move up one directory from any sub-folder of the currently viewed directory.

Save Options
The Save Options contain options available for the type of file that is being saved.

3D Interactive Package is a package that contains not only the standard 3D Drill file but also contains any
external files such as audio, fabrics, props, and floor covers used within the drill file. All external files are
optional.

3D Drill File is a standard drill file that includes no external files, only drill data.

Save as type (Interactive and Professional editions only): Unless otherwise specified, drill files will save
with your current version compatibility. Any user with any edition of your same version will be able to open
these files (example: version users can open your version 8 files). To share a file with a user that has an
older version of 3D, select the compatibility option appropriate for them. Newer features will not be saved
with this compatibility.

All Basic Edition files are saved as that version file type.

Auto-Save
See the Backups section of Application Options for Auto-Save options.

File: Save As Template
Save As template will save a drill file as template file. Template files are helpful for those of you that
frequently design with grids and layouts setup in a particular way. The Include Performers option will save
any performers on the field, when selected.

Before editing a template you open, be sure to immediately save the template as a different
name so you will not overwrite your template file.*
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File: Export 3D App File
The Export 3D App File option in the file menu will create a copy of the currently open drill as a .3da file
type. These .3da file types, also known as mobile app files, can be viewed in the 3D Viewer application.

To create a mobile app file, first open the drill from the File menu. Once the drill is open, go to the File menu
and choose Export File then Export 3D App File. A new window will open where you can give the file a
name, and specify which directory you would like to save the file to. Once you have decided on a destination
and file name, press Save.

File: Export UDBapp File
The Export UDBapp File option in the file menu will create a copy of the currently open drill as a .3dudb file
type. These .3dudb file types, also known as UDBapp files, can be viewed in the UDBapp.

To create a UDBapp file, first open the drill from the File menu. Once the drill is open, go to the File menu
and choose Export File then Export UDBapp File. A new window will open where you are prompted to sign
in with your UDBapp Ensemble Code and Password. Once entered, you’ll be able to upload the UDBapp file
to the UDB servers.

For more information, please visit the UDBapp tutorial page.

File: Backup
This function is used to backup the currently opened drill file. The backup is saved in the default backup
files directory. Selecting Backup from the File menu will display:

Backup Options opens the Application Options dialog to the Backup tab where you can change the
default backup directory as well as other backup options. See Application Options for details.
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File: Revert to Saved
The Revert to Saved will roll back your file to the last saved copy of your file. Any changes you had made
since the last save would not be kept.

File: Print…
Opens the Unified Print window, where you can set preferences and print any or all of 3D’s available
outputs.

See the Printing section for detailed explanations of this window.

File: Document Options
Document Options contains many features to change the properties and preferences of a particular file. For
example, you can change a file’s symbol fonts, file locking properties, copyright information, and drill title.
To display the Document Options, select Document Options from the File menu.

Properties
The Properties tab contains settings that are the file characteristics which define the use of a file you are
creating. There is a section for entering and displaying your Author Information and Copyright, as well as
an image, such as a company logo, to be displayed/printed.

You can set the file up to not allow editing, if for example, you wanted the file strictly to be used as a demo.

The properties can be changed and then locked with a Master password. This is useful if you would like to
distribute your drill file but make it operate as a demo. Its value is most seen on the internet.

You can create a drill file, put a company name and contact number in the file that displays when the file is
opened, restrict its use for only previewing, and post it on your web site for sale or upload the file to your
Pyware account. Anyone can download your file for preview. Should they want to purchase your drill, you
can unlock their copy of the file for use by giving the customer a key that only works one time.

We recommend a 4×1 ratio for images with a maximum file size of 1600 × 400.*
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Preferences
Preferences contains settings that define the characteristics of the file you are working on.

Drill Title is the title that is used when printing. If this title is left blank then printouts will use the name the
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file was saved as.

Symbol Font is the font used to represent the performers on the field.

Label Font is the font used to label (or number) the performers on the field.

Default Label Position is the location of a label that appears next to a performer symbol on new
formations.

Default Interval is the interval first entered into a drawing tool control panel to determine the spacing
between performers in a shape. This is just the initial value and can be changed while using a drawing tool.
Its default is 2 steps. You may want to change this value if you find you consistently use an interval other
than 2.

Audio File is the music file that contains music you wish played during animation of the drill.

A drill file can be synchronized to one of three types of sound files: (MID=MIDI, WAV=wave audio file,
OGG=Ogg/Vorbis audio file). To set up an audio file for use with a drill file, do the following:

1. With a drill file opened, select the Preferences section of Document Options of the File menu.
2. Click Choose File for the audio file and select an audio file.
3. The next time you click ON the animate with music button, you will be instructed to synchronize the

music to the drill.

Animation Fixed Tempo is used to set the speed of the animation that is played with no music.

Real View Perspective
The Real View Perspective tab contains options for settings used in the Real View window, such as
uniform fabrics, flag fabrics, performance surfaces and venues, and any starting visuals.

While not required, entering music before writing the drill provides an excellent musical
reference during the creative process.*
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The Performing Venue section is where you would import performance surfaces and set venues, such as
stadiums, to display in the Real View.

Venues will add an environment setting, such as a stadium, gymnasium, or parade route to the Real View
window.

The Sky option has various skies to choose from to enhance the Real View scenery.

The Ground option will replace the ground surface and surrounding field areas with whichever option you
choose. When loading a ground, we recommend choosing a surface file as well, such as a High School
Football Field.

Surface allows you to import a performance surface to overlay on the field. This aids with customization of
the performance surface, as you could use images that represents tarps, football fields, basketball courts,
etc.

The Selected Fabrics section is where you edit which fabrics are used for a specific drill. There are two
options in this section, to let the end user (such as your client) use their own fabrics from their machine, or
to use the fabrics from the table below.

Allowing the user to select fabrics from their machine is an absolute time saver. If the user has favorite
fabrics set in their 3D program, these will be used for any drill they open, as opposed to having to sort
through a list and choose which fabrics to use for their drills.

Opting to use the fabrics from the table will save any selected fabrics in the table and include them in a drill
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package (.3dz). Fabrics will not be included in a standard (.3dj) drill file.

If you have a custom fabric (such as a uniform, flag silk, or drum shells) that you would like to use in the
drill, you can import the fabric by selecting the Edit button for the respective fabric you would like to change.
A new window will open where you can browse your machine for the fabric to use.

To clear a used fabric, press the Delete button for the fabric you would like to remove. This will not delete
the fabric; it will only be removed for use in this drill.

Any fabrics left blank will use the Favorite Fabrics specified in the Application Options of 3D. Click the
Favorites button to open the Favorite Fabrics tab in Application Options.

The Starting Visuals section allows you to change default uniforms, equipment carried, march & hold style,
as well as facing when working on new drills. These values will be used until performers are edited using
the Visuals Editor.

File: Application Options
Application Options is used to change the preferences of the 3D application. These include, but are not
limited to: secondary and new symbol display size/color, count track settings, tool palette setup, and
installation information.

Ease of Access
Ease of Access allows users to customize options in 3D that would make the program more accessible for
various size of monitors and displays.
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Always check “Show Only Symbols” will always display the symbols when in a tool control panel.

Always check curved path and shape options will always create a curved path or shape, if the form
allows it.

Hide Cursor for pen devices will hide the cursor for users that are designing with a stylus.

Console Panel Size adjusts the size of the console window.

User Interface Size adjusts the size of various aspects of 3D, such as menus, the Count Track and
animation controls, many buttons, and windows.

Toolbar – select the checkbox to show the toolbar in its own palette. If this is not selected, then the toolbar
will be a tab on the console.

Tool Button Size adjusts button size on the tool palette. We recommend moving the slide bar to “largest”
for Whiteboard and touch screen monitor use.

Orientation – choosing the “horizontal” or “vertical” radio buttons will switch the direction that the Toolbar is
displayed. You can change the number of rows the toolbar has by adjusting the “rows” number.

Count Track – changes the “count increments” of the count track. Typically showing a number every 8
counts is preferred.

Position Indicators allow you to adjust size and color of both new and secondary count positions. At low
screen resolutions the secondary dots will be larger on the screen, so you may want to draw the smaller
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symbols than the default settings. If you are new to 3D, this setting can be changed anytime. Its usefulness
will become easier to understand after using the program.

Adjust the size of Edit Handles by moving the slide bar.

Select the color box to change the color of the Stride Zone, or adjust the slide bar to change transparency.

Reset Prompts & Helpers – Some prompts will appear during the use of the program for the purpose of
providing extra guidance. These prompts could pop up in tools, functions, and options throughout the
program. The prompts will only appear once if the user clicks “Don’t display this again”. Reset Prompts &
Helpers will reset the “Don’t display this again” check box on all of these prompts.

Display
The Display tab contains options pertaining to the appearance of items and windows.

Show Perspective Window – shows or hides the perspective window. This is useful on slower computers
or computers that are close to or below the hardware requirement threshold. Unchecking “Show Perspective
View” will make 3D run faster and with less memory and graphics demand.

Show “Real View” Perspective Window – enables the Real View window.

Reload Real View Models will download the current set of models and optional assets available from
Pygraphics, Inc.
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Use Shadowing displays shadows in the Real View window for any models or props. While this adds
realism, it can increase demand on your graphics card. Disabling this function may improve sluggish
performance.

Use Image Smoothing (or multi-sampling), simply put, smoothes pixels on images where they might look
jagged from pixels not representing lines and curves perfectly. This is one of the more demanding (in terms
of graphics power) features of our software. If you notice sluggish performance in the Real View window, try
disabling this feature. Disabling Image Smoothing requires a restart of the program to take effect.

Show Classic Perspective is an option available for machines that do not meet the graphics requirements
of the 3D Real View.

Use 3D Figurines shows figures with uniforms defined through the Figurine Editor.

Flash Pace during mark time – when this is enabled, performers that are “marking time” will flash yellow
during animation. To disable this flash, uncheck this option.

Show bridges (paths) during preview animation – switches on or off the matching bridges to help provide
a cleaner animation while drawing new forms.

Show Production Sheet – enables the Production Sheet to be displayed in 3D. This is only available on
3D Interactive and Professional editions, and can be set to start in it’s own window or as a pop-up.

Customize opens a new window where each column on the Production Sheet can be renamed to the user’s
choice.
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Window Animation Effects will turn on or off the animation effects of windows in 3D.

Reset Window Locations – resets the location of windows and tool palettes to their default location on the
screen.

Favorite Fabric
The Favorite Fabric tab lists all fabrics to be used on the performer and equipment models in the 3D Real
View. Fabrics in 3D include, but aren’t limited to: model skin tone, uniforms, equipment, flag silks and drum
shells.

When opening a drill, if no fabric has been specified, the fabrics from the list on this tab will be used.

To change a fabric, select the Edit (pencil) button on the row for the fabric you would like to change. A new
window will appear where you may select the fabric of your choice.

To create your own custom fabrics for use in the 3D Real View, please visit the Custom Fabrics guide.
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Plug-ins
The Plug-ins tab lists all of the plug-ins that are installed on your installation of Pyware 3D.

3D Plug-in Instant Purchasing information – selecting this button brings up a new window with pricing
and accessibility for purchasing 3D Upgrades and Accessories. A valid credit card and internet access is
required to complete the purchase.

Reactivate Plug-ins – selecting this button brings up a new window that allows you to reactivate a 3D Plug-
in you have previously purchased. It will be necessary to reactivate your plug-ins should you need to
reinstall your software.

Backups
The Backups tab contains options for controlling the automatic backup and auto-save features.

Enabling Auto-Save will save every X minutes (where X is the number you specify from the menu) if any
changes have been made to the drill, and after you have selected a selection tool. Auto-Save will not begin
to automatically save the file until the file has been created and saved at least once.
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Backup Directory is the location of your backup file folder.

Number of backups maintained per drill option changed the maximum number of copies created.

Always backup after using Save option turns on or off the automatic backup feature. When on (checked) a
new backup file is saved every time you choose Save from the File menu.

Internet
The Internet tab aids in connecting to Pygraphics’ servers when your network might be blocking access.
Included on the tab are options to enter HTTP and/or FTP Proxy Server information.

The HTTP Proxy Server information is helpful in allowing items such as new Real View models to be pushed
out to your machine.

The FTP Proxy Server information is helpful in allowing authorization of the installation of 3D as well as
access to the Online File Manager.

Disabling the Online Message Board will not allow 3D to check for any messages from Pygraphics’
headquarters.
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Installation
The Installation tab contains activation and registration information. If you have not entered your activation
information, the 3D program will function as a demo. The activation information is entered the first time the
program is run.
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System Info
The System Info tab displays system information such as the computer’s operating system and version of
the Java™ machine.
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Edit Menu
The Edit menu contains many standard Edit menu functions (such as undo and redo, copy, cut, and paste),
as well as some functions that are unique (Snap To, Shorten/Lengthen Transition) to 3D.

Edit: Undo
Undo will undo the last performed function in a drill file. 3D remembers the last 100 changed in a drill, so
there will always be a list of undo-able action to cycle through.

To Undo a function in 3D, go to the Edit menu and choose “Undo ____.” A notification will appear in the
middle of your screen stating what function was undone. The Undo function will reselect performers and
open the last tool that was used.

Edit: Redo
The Redo function will revert the last change that the Undo function removed. If multiple changes were
removed via the Undo function, reverting them via the Redo function will add the changes back in order that
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the changes occurred.

For example: If you add a page tab on count 0, then choose to Undo the change, the page tab on count 0
would be removed. Selecting Redo will add the page tab back to count 0, as that was the last action that
was undone.

Edit: Delete
Both performers and transitions can be “deleted” from a drill.

Highlight performers on the field, then go to the Edit menu and choose Delete. A Delete Options will
appear, where you will have two choices:

Delete Transition resets the transition between counts X and X (whichever page tabs your red and
yellow anchors are on at the same time) of the selected positions to a “Hold” (or mark time). After selecting
the Delete Transition radio button and clicking the Delete Transition button, you will not be prompted to
confirm.

Delete Performers permanently deletes the selected positions from the entire drill. Upon selecting the
Delete Performers radio button, then clicking the Delete Performers button, you will be prompted to
confirm the permanent deletion of the marked positions. For your safety, on this window, you cannot
hit [ENTER] to confirm the deletion. You must click the *Delete button.

Edit: Copy
If performers are selected, the copy function will copy the selected performer (including visuals, equipment,
and uniform) between your secondary and primary anchors.

If no one is selected, the copy function will copy the entire range of drill between your secondary and
primary anchors.

To copy a selection of drill, spread your anchors over a range of counts you would like to copy, then go to
Edit and choose Copy Range.
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Any selection you would like to copy can encompass multiple page tabs.

Edit: Cut Range
Choosing Cut Range from the Edit menu will copy all information within the anchors on your Count Track,
and remove counts and range from the drill. Once a range has been cut, the Count Track will adjust
accordingly. All performers and drill data (including but not limited to: transitions, text boxes, prop locations,
arrows, etc.) are copied.

To cut a range of drill, spread your anchors for the section of drill you would like to cut, then choose Edit
and Cut Range.

Edit: Paste Range
Paste Range will paste a copied (or cut) range of counts into a new range of counts. When pasting a range
of drill, you can choose to either insert counts or overwrite an existing range of counts.

To paste a section of drill, it must first be copied or cut. Once you have copied/cut a range of drill, move
your yellow (secondary) and red (primary) anchors on the count track to where you want the pasted drill to
begin, then choose Edit > Paste Range. The dialog below will appear with options for you to either insert or
overwrite the existing drill.

When inserting counts (the top radio button), the count at which your secondary (yellow) anchor is will be
replaced with copied secondary (yellow) anchor information. Or in other words, the drill that you copied/cut
from, starting at the yellow anchor, will replace the drill that you are inserting at, or where the yellow anchor
is now. Pasting a range this way will paste counts to the range you have selected. 3D will then shift the
existing transitions forward and create new bridges automatically.

When overwriting counts (the 2nd radio button), the pasted range will overwrite any drill from your
secondary (yellow) to primary (red) anchor. No counts will be added to the drill.

Invert Copied Range will flip, or invert, the transitions when pasted. For example, if you copy a range of
transitions that moves from a box, to an arc, to a wedge, when you choose Invert Copied Range and paste
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the range, the transition would start with a wedge, which goes to the arc, then ends with the box.

There are two options to bridge the pasted range to the page tabs before and after the pasted range
automatically. If either option is selected, 3D will attempt to bridge the transitions from the pages before and
after the pasted range. If you choose to not use this option, you may have to go back and manually regroup
performers to avoid any possible collisions.

Edit: Paste Performers
This function pastes performers that have been stored in the clipboard with the Copy function. If nothing is
stored in the clipboard the Paste function will be dim. Select Paste from the Edit menu and the following will
display:

Paste with the same matching order

Pastes the performers into current count of drill and maintains their same identity (matching order) as the
performers they were copied from.

Paste with different matching order

This option will only be available if performers were selected on the currently displayed count prior to
choosing Paste. The selected performers will be performers 3D will try to move (match) the pasted
performers into. Matching Controls will display in the right area of the Paste Control Panel. Matching
Controls are used to match the positions of the pasted shape to their respective performers in the drill. On
the field display matching lines are drawn between the positions of the pasted shape and the selected
performers. Often the positions in the line are matched correctly or simply need to be flipped over to be
correct using the Flip button. If more matching control is necessary, clicking the Clear button will clear all of
the matching lines for you to replace manually.

Paste as new performers

This option will enter the performers as new performers. This is typically done at count 0 of the drill. New
performers are rarely entered at any other count. The only time you might want to enter new performers at a
count other than count 0 is when you are starting a new drill by creating your first time performers at set #2
and plan to chart backwards to set #1.
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Mirroring / Less Options

Clicking this button expands the Paste Control Panel to show Mirroring Options, which allow you to
Invert paste shape vertically, horizontally, and across mid stage. This inverts the copied shape prior to
pasting it on the current count of drill.

Edit: Paste Visuals
This function pastes visuals that have been stored in the clipboard with the Copy function. If nothing is
stored in the clipboard the Paste Visuals function will be dim.

Pasting Visuals is a great way to quickly create ripple effects, as well as copy and paste frequently used
visuals.

Select Paste Visuals from the Edit menu and the following will display:

The drop down menu shows both saved visuals (See: *Visuals Presets Editor)as well as copied visuals from
the drill file.

The Sequence option will have the performers perform the pasted visuals every X number of counts, where
X is the number of counts you specify.

For example, let’s say you wanted to have a flag toss ripple every 2 counts. You would copy a performer’s
flag toss, set your anchors for the range duration, and select the performers to perform the ripple. Choose
Paste Visuals from the Edit menu, then choose to Sequence every 2 counts. Be sure to have the
“Equipment Movements” option checked.

Visuals Presets Editor

The Visuals Presets Editor allows you to save presets of visuals. This grants the option to have even less
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setup for pasting in frequently used visuals, as Visuals Presets can be saved outside of the drill file (vs.
copied visuals, which are not remembered once a drill is closed).

To save a visual as a preset, you must first copy the visual. Once copied, highlight performers where you
would like the visual to occur, and choose Edit > Paste Visuals. In the Paste Visuals window, choose Edit
List. This will open the Visuals Presets Editor. Pressing “Add” will open a new window, prompting you to
name the visual preset you would like to save. Press OK once you have entered a name, then Save in the
Visual Presets Editor. The visual preset will now be remembered and can be used in any drill in 3D.

Paste in reverse order will invert any pasted visuals. For example, if you had a horizontal line that had a
ripple from left to right, if you choose to copy and paste in reverse order, the ripple will go from right to left.

Any options you choose to include when pasting visuals will be remembered for quick access the next time
you open the Paste Visuals dialog. Be sure to include/exclude the options you want pasted when pasting
visuals.

Edit: Select Recent
Choosing Select Recent from the Edit menu re-selects the last made selection of performers. If a new
shape is entered, then the performers of that shape will be selected. Double-clicking on the Pointer tool
does the same as Select Recent.
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Edit: Select All
Choosing Select All from the Edit menu selects all performers displayed on the current count of drill.

Edit: Snap To
This function snaps the selected performers to the nearest whole, half or quarter step. Choosing Snap To
from the Edit menu will display the Snap to dialog where you can choose the snap resolution.

Edit: Adjust To
The Adjuster editing tool is used for quickly moving and/or adjusting performer’s locations and transitions
without having to first select the individual performers.

Edit: Swap Two Positions
Swap Two Positions is a way to quickly switch the spots of two performers in a drill. When two performers
are selected, you can go to the Edit menu and choose Swap Two Positions. The Swap Two Positions
window will appear with the following options:
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From this count to the end of the drill – the selected performers will switch positions at the count your
Primary (red) Anchor is located at on the Count Track, and apply to every count after, until the end of the
drill.

From the beginning of the drill to this count – the selected performers will switch positions from the
beginning of the drill up to the count where your Primary (red) Anchors is located at on the Count Track.

At this count only – the selected performers will switch positions on the count where your Primary (red)
Anchor is located on the Count Track.

Press Swap in the window to commit the change.

Edit: Lengthen/Shorten Transition
Transitions between pages (sets) can be quickly lengthened or shortened, depending on your need. To
lengthen or shorten a transition, do the following:

• Set your anchors at the beginning and end of the transition you would like to edit. This can be done
quickly and accurately by clicking on the page tab at the end of the transition. Your anchors will snap
to the appropriate page tabs.

• Go to the Edit menu, choose Lengthen/Shorten Transition.
• If you know the new count structure (total counts) for the transition, choose the top button, to change

to X counts (X being the new count structure you want for the transition). Otherwise, choose to
Expand or Shrink (both separate options) by X counts.

• Once you make your selection and press Okay, 3D will lengthen or shorten the existing transition,
depending on the choice you made.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 138 of 407



Tools Menu
The Tools menu contains many of the same tools as in the Tool Palette. The tools in this menu are some of
the most used tools. They are found in the Tools menu as another handy way to select tools, especially
through the menu shortcuts. Your preference of shortcuts used in the Tools menu can be changed through
the Shortcut Editor of the Utilities menu.

Display Menu
The Display menu contains functions which control the way the counts of drill appear on the field. Many of
which are also shown as buttons on the title bar of the Field Display window and the Console. These are
some of the most used display related tools. They are found in the Display menu as another handy way to
change display characteristics, especially through the menu tools shortcuts. Your preference of shortcuts
used in the Display menu can be changed through the Shortcut Editor of the Utilities menu.

Step Resolution
Whole Step option causes the cursor to jump to whole step intervals when entering location on the field.

Similarly Half Step, Quarter Step, Eighth Step, and Sixteenth Step behave like Whole Step. These
options are also found as buttons in the upper right corner of the Console.

Field Display Window
Show Stride Zone switch controls the display of the stride zone. This switch is also found on the right side
of the title bar of the “Field Display Window”.

Show/Hide Props switch controls the display of props on the field. This switch is also found on the right
side of the title bar of the Field Display Window.

Show/Hide Labels switch controls the display of labels on the field. This switch is also found on the right
side of the title bar of the Field Display Window.
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Show/Hide Text switch controls the display of text on the field. This switch is also found on the right side of
the title bar of the Field Display Window.

Show Facing switch controls the display of performer facing on the field. This switch is also found on the
right side of the title bar of the Field Display Window.

Show Secondary Dots controls the display of secondary dots (previous sets) displayed on the field.

Zoom Grid function zooms the display on the field in or out. This function is also found on the right side of
the title bar of the Field Display Window.

Shift Grid function slides the display of the field in any direction. This function is also found on the right side
of the title bar of the Field Display Window.

Center Grid function centers the field back to the middle of the Field Display Window. This function is also
executed by clicking on the Shift Grid function while holding the [ALT] key.

Measure function measures the distance between any two points on the field. After selecting measure,
clicking on two points shows the distance in the Console. This continues until the Measure function is
deselected or the mouse is double-clicked.

Hide and/or Lock Performers
Hide Selection hides the selected performers throughout the drill. This is useful when performers that you
are not currently editing are in the way of performers that you are editing.

Lock Selection locks your selection of performers from editing and/or selecting.

Unlock All will unlock any performer(s) that were locked in the drill.

Show All sets any performers that you have currently hidden to be visible again.

Real View Settings
The Real View can be sized to various defaults, such as 360P, 720P, or 1080P, depending on your
selection from the menu.

Track Menu
Track contains options that pertain to the Count Track. While many of the options here are obvious with
buttons on the Count Track themselves (such as the animation controls), some Track menu items may be of
use to shortcut if you frequently jump pages (sets) or count ranges. Your preference of shortcuts used in the
Track menu can be changed through the Shortcut Editor of the Utilities menu.
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Animation
Animate function is the same as clicking Animate from the Animation Controls on the Count Track.

Loop will repeat the range of animated counts.

Play All Count will animate the file from the beginning to the end.

Step Animation enables the user to animate one count at a time by pressing the space bar for each count.

Fast Animation ignores the synced tempo and plays the animation at a quicker pace.

Enable Sound will play back any synced audio with the animation.

Audio Sync Options opens the Audio Sync Options window where you can choose which method to sync
the audio file to the drill.

Anchors
Lock Anchor Range will lock the anchors at their current range (or spread). When you move the anchors
on your Count Track, the anchors will remain at the same range until unlocked.

Increment Primary Anchor moves the primary anchor forward 1 count.

Decrement Primary Anchor moves the primary anchor backwards 1 count.

Increment Secondary Anchor moves the secondary anchor forward 1 count.

Decrement Secondary Anchor moves the secondary anchor backward 1 count.

Page Tab Bin Lock unlocks the Count Track for adding page tabs.

Next Page Tab jumps the Red and Yellow Anchors of the Count Track on page tab to the right.

Previous Page Tab jumps the Red and Yellow Anchors of the Count Track one page tab to the left.

First Count jumps the Red and Yellow Anchors of the Count Track to the first count on the track.

Last Count jumps the Red and Yellow Anchors of the Count Track to the last count on the track.

Utilities Menu
The Utilities menu contains various options for customizing the drill file, as well as the ability to create
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movies of your drills.

Utilities: Create Movie

Movies of drills are a fantastic way to share your creation with clients, potential clients, and students
(performers). Recording the drill animation is especially useful if your client does not have a copy of 3D to
view the drill on their personal machine.

To create a movie of your drill, you’ll need to go to the Utilities menu and choose Create Movie. A new
window will open with various recording options.

Set the size of the movie you would like to create, and then specify if you’ll be recording the Real View or
the design grid. Once these are set, be sure to prep your playback options (play from beginning to end, a
certain range, audio, etc.) and then launch the recorder.

Two new windows should open, one from 3D with further instruction and the other for the screen recording.

Once you have set up the recording and are ready to start, press the record button. You’ll have a small
countdown before recording actually occurs so you may press Play.

For a step by step guide on recording your drill’s animation, click here.*
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Utilities: Drill Rewriter
The Drill Rewriter is found in the Utilities menu. The Drill Rewriter changes the number of performers in a
drill by adjusting the spacing of the shapes within the drill. Performers can be removed or added to a set
and the adjustment is made throughout the drill.

Utilities: Shift All Performers
Shift All Performers is a function found in the Utilities menu that will adjust all performers in a certain
direction (that you specify) for the entirety of the drill. This is helpful if the show was written too far from the
front side line and needs to be adjusted forward without rewriting each set.

Utilities: Count Editor
The Count Editor is found in the Utilities menu. The Count Editor adds or removes counts from a drill.
Counts can be inserted or removed at any place within the drill. This function is most useful to extend the
length of a drill when additional counts are needed at the end of the drill.

Utilities: Cast List Editor
The Cast List Editor is found in the Utilities menu. The Cast List Editor is an editor for creating a
customized cast list or importing the cast list from an existing drill file.

In the Cast List Editor you’ll also find the Symbol Map Editor, where you can assign details for performers
(such as uniforms and equipment carried) based on which symbol is assigned to them.

Utilities: Grid Designer
The Grid Designer is found in the Utilities menu. The Grid Designer is an editor for customized field grids.
You can use this editor to design any type of grid such as winter guard floors, soccer fields, and parades.

Utilities: Page Tab Editor
This feature is only found on the Basic Edition, or versions 3 and earlier of 3D.

The Page Tab Editor is found in the Utilities menu. The Page Tab Editor is useful for entering page tab
titles. Page tabs are considered sets when printing. If titles are entered, then the title is printed on the chart.
Use this when you want to title a set for clarification. For example, Set #1 could be titled “Opening
Formation” and Set #4 could be titled “Concert Formation”. The Page Tab Editor is also another way to
enter page tabs. Typically, page tabs are entered from the Page Tab Editor button on the Count Track,
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however, they can be entered from this editor just as easily.

Page tabs can also represent sub-sets. Sub-sets (or sub tabs) are useful if you need to define a hit point for
only part of the ensemble without advancing the total number of pages (sets).

For example, with two sub-tabs between set 2 and 3 the numbering sequence would be 1, 2, 2A, 2B, 3, 4,
etc.

The option to print or not print sub-tabs is found in the Print Charts function.

Utilities: Production Sheet
Interactive and Professional editions only.

The Production Sheet allows you to map out your drill from beginning to end with helpful instructions or
notes that can be quickly added to a chart. You may import any information on the Production Sheet into a
Text Box by using the Text Box tool.

Utilities: Shortcut Editor
The Shortcut Editor is used to change the shortcuts assigned to menu items. You can set up shortcut
profiles so each user can establish their own preferences for shortcuts.

Utilities: Helper Editor
The Helper Editor allows you to choose which helpers are displayed and which aren’t. If you would like to
turn all helpers off, or if you would like to set a helper to display again, this would be the tool for you.

Utilities: Figurine Editor
This feature is only used for figurines when the Classic Perspective View is enabled, and the Real View is
disabled.

The Figurine Editor is used to change the uniform colors and types for the perspective view figures.

Utilities: Command Editor
The Command Editor allows you to edit Group Names and Transition Descriptions for Instruction printouts.
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Utilities: Fabric Editor
The Fabric Editor allows you to customize fabrics (included, but not limited to: model skin tone, uniforms,
equipment, flag silks, and drum shells) for use in the 3D Real View. When the Fabric Editor is opened, a
new window will appear:

If fabrics were included with a drill (a drill package, or .3dz file) you can view these fabrics by selecting the
Open Drill’s Temp Folder option.

To see the fabric files that were included with 3D, choose Open General Fabric Folder.

You can also launch an image editing software directly from 3D. Choose the Launch Editor button to
customize fabrics.

If you do not have an image editing software installed on your machine, click the Setup button to download
the program we recommend.

Clinic Menu
Here you will find settings for the Virtual Clinic analyzers. See the Virtual Clinic page for details.

Interactive Menu
This menu contains all of the Interactive functions that use the 3D Online Account Service as well as
Pyware messages and web sites.

Unlock This Drill

This is a utility that will allow a user to unlock a locked drill using a key that has been given to them by the
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creator of the drill.

Drill Lock Decoder

This is a utility that allows you to create keys to unlock files that have been locked by the creator so that the
master password does not have to be released.

Check For Messages…

The Pyware Message Board is an automated information system that checks with Pygraphics Headquarters
for any important notices such as updates that are currently available for you to download.

3D will check Pygraphics Headquarters for any new updates or important notices that you might be
interested in and display the list of messages in the Subject box. If you want to read a message, click on the
message listed in the Subject box and it will display.

Pyware Website

Launches your default browser to the Pyware website.

Frequently Asked Questions

Launches your default browser to the page of Frequently Asked Questions on the Pyware website.

De authorize This Computer

This function allows the computer 3D is installed on to be de authorized so that another machine may be
authorized on the account.

Get Plug-ins & Accessories

This function allows you to instantly purchase plug-ins and program updates and upgrades online.

Instantly Upgrade My 3D Now

This function will allow you to instantly purchase an update or upgrade available for your installed version.

Contact Pygraphics

This will launch the Pyware website with contact information in your default web browser.

Reference: About 3D
About Pyware 3D is found in the Reference menu. This shows the program version information and the
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copyright information. Click on the License Agreement button to view the License Agreement.
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Sketch Mode
In version 10 we have introduced sketch mode. This modes allows you to create sketched shape paths
using your drawing tools. These shapes appear only on the count that you created them on. You can apply
any number of performers to these sketched forms at any time. The performers will be evenly spaced
throughout the designed shape. You can cut and glue different sketched shapes together to create a more
complex form to apply a group of performers to. Sketches can be copy and pasted to other counts as well.
Once performers are applied to a sketch that sketch is deleted. Sketches can be selected and modified
using any editing tools as well.

Turn Sketch Mode On/Off
• To enter and exit sketch mode you can click the sketch toggle in the upper right corner of the design

window.

• This can also be set as a shortcut and can be found in the Display Menu.
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Create a Sketch
Creating a sketch is easy. It is done in the same way that you draw forms with performers, except you are
just creating path waypoints. When sketch mode is enabled all eligible drawing tools will be enabled and
marked with a red sketch icon indicating that you are drawing a sketch.
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1. Enable Sketch Mode
2. Select a Sketch drawing tool

3. Draw the new sketch form.

4. Accept the Sketch Form

Pygraphics Pyware 3D User Guide - 11.0_en

Page 150 of 407



Pygraphics Pyware 3D User Guide - 11.0_en

Page 151 of 407



Drawing Tools
Drawing tools in 3D can be used two ways: to add new performers to the file for the “First Time”, or create a
shape that is the destination, or “Transition”, for existing performers.

First Time

When the Red and Yellow Anchors of the Count Track are on the same count of drill, drawing tools will be
accessible on the Tool Palette. If no performers are selected on the field, the places in the new shape
created by a drawing tool will be filled with first time performers. This means that the performers of the
shape do not yet exist anywhere in the drill.

To create a shape of first time performers the Red and Yellow Anchors must both be set to the same
count, and NO performers should be selected on the field at that count when choosing a drawing tool. Only
in rare cases are first time performers entered at any count other than count 0, such as when it is more
convenient to start elsewhere in a file other than the beginning.

Transition

When designing on counts other than count 0, drawing tools are typically used to create shapes that define
the end of a transition of existing performers. For example, let’s take a line moving into a circle. The Circle
tool will be used to create the destination of the transition from the line. the Red Anchor will be set to the
count of drill where the circle will be drawn. The Yellow Anchor is set to the beginning of the transition into
the circle which is usually the previous page tab. To indicate which performers on the field are moving into
the circle they must be selected. In this example, you would select the line using a selection tool, then
choose the Circle drawing tool. After the circle is created, Matching Lines indicate which performers in the
line are moving into which new place in the circle.

Click on the arrow next to Drawing Tools in the Table of Contents to the left to expand this section and
begin.

Line Tool
The Line tool is used to create a line of performers between two points.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the line to be drawn. To transition EXISTING performers into a line, move the Red Anchor to the count
where the selected performers should “hit” the line shape. Move the Yellow Anchor to the beginning count
of the transition into the new line. This is usually the previous set in the drill. Select the existing performers
that will be moving into the line using a Selection Tool. See the Drawing Tools overview for more
explanation between new performers and transitioning existing performers.
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Clicking on the Line tool will display the Line Tool Control Panel.

Drawing a Line

The line is drawn by clicking two points on the field display. The first click will enter the first endpoint and the
second click will be the second endpoint.

While entering endpoints, the cursor location is displayed in the console. The resolution of the cursor can be
controlled by the whole, half, quarter, eighth, and sixteenth step switches in the upper right corner of the
Console.

Editing Handles will appear at the endpoints of the line. These handles appear as small red squares and
can be dragged to reposition the line by changing the location of the line’s endpoints.
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A Reposition Handle also appears at the midpoint of the line. This handle is useful for dragging the entire
shape to a different location on the field. Drag the inner circle of the Reposition Handle to move the entire
shape. The extended arm from the center of the Reposition Handle is called the Rotator and can be
dragged to rotate the line to a new location. The Point of Rotation is the center of the Reposition Handle.
To change the Point of Rotation, drag the outer circle of the Reposition Handle to a different place on the
field.

Line Tool Control Panel Options

Entering the number of positions in the Positions box will lock the positions and the line will maintain the
number entered while you move its editing handles. Since the number of positions of the line is locked, the
line would grow or shrink by changing the interval between the positions.

Similarly, entering the interval in the Interval box will lock the interval and the line will maintain the interval
while you move its editing handles. Since the interval between positions is locked, the line would grow or
shrink by changing the number of positions in the line.

Mixed Intervals are also entered by pressing the button. This option will allow you to have different
intervals in one form. Mixed Intervals are extremely useful when charting large instruments or instruments
that are close together but vary in size (drum lines, for example).

To create a Mixed Interval, type the Interval value, followed by an “x”, followed by the number of positions
at that interval. For example, a form with 5 positions at a 3 step interval, followed by 10 positions at a 2 step
interval, ending with 5 positions at a 3 step interval would be entered like this:
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5×3,10×2,5×3

Mixed Intervals can be entered before or after you create your shape, but must be entered before you
Accept the form.

Line intervals can also be entered in Rise over Run or slope format. Press the button to switch the
interval text bot to a Rise over Run format. The Rise is the vertical distance between performers, and the
Run is the horizontal distance between performers.

In the example above, a 12 position line would have each performer set 3 steps behind, and 2 steps across
from the previous performer.

Positions and Intervals can be locked or unlocked by clicking on the respective padlock. When locked, the
value cannot be recalculated by the computer if the size or shape of the form is modified.

Entering a number in the Clone box will create clones of the line. The direction and format of the clones
depend on the type of clone selected.The Cloning Handle will be placed in the center of the field and can
be moved or rotated to reposition the cloned lines.
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Radial Clone

When radial clone is selected, the cloned shapes will reflect radially from the clone handle. This handle can
be moved, similar to edit handles, by clicking and dragging around the field.

Linear Clone

When linear clone is selected, the cloned shapes will reflect linearly from the clone handle. This handle can
be moved, similar to edit handles, by clicking and dragging around the field.

Forms can align their intervals to the endpoints (edit handles) of a form. To align a form, both positions and
interval options must be locked in the tool’s control panel. Forms can align Left, Center, or Right, depending
on the alignment button selected.

Omit Overlaps will watch for places where performers of a line are on top of other performers in the drill.
The overlapping places in the line will be omitted. Omit Overlaps can watch for either overlaps involving
only performers at the line’s endpoints or overlaps involving any performer anywhere in the line.
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Restrict Horizontal/Vertical forces the second endpoint to a location on the field that is in the line
horizontally, vertically or 45 degrees diagonally with the first endpoint.

When entering the line as NEW performers, Symbol and Color is used to enter the symbol and colors for
the new performers entered. Symbol and Color options are only shown for first time performers. To enter a
symbol sequence such as X O X O, type the sequence one time. For example, “XO” will enter symbols X O
X O X O throughout the line. Clicking on the Color Palette will display color options for the first time
performers. The performer’s symbol and color can be changed for existing performers using the Performer
Labeling tool.

When creating a line from EXISTING performers, Matching Lines options are used to match the positions
of the line to their respective performers in the drill. Matching Lines options are only shown when a shape
is entered as the destination of a transition from a previous set. On the field display, matching lines are
drawn between the positions in the line and the selected performers of the drill. Often the positions in the
line are matched correctly, or simply need to be flipped over to be correct using Flip button. If more
matching control is necessary, clicking the Clear button will clear all of the matching lines for you to replace
manually. See the Matching Lines for details on matching.

At any time the Animation Controls can be used to preview the line in the drill. Other useful options that can
be accessed during entry of the line are located in the upper right corner of the Field Display Window.
These functions control the field display appearance such as moving or zooming the field, showing/hiding
the text boxes, and showing/hiding the performer labels.

The Accept button will commit the line to the drill page. Clicking on any tool without clicking Accept will
cancel the line. The line can also be canceled by moving an anchor on the Count Track, right-clicking
anywhere on the field, or pressing [ESC] to close the tool.

Circle Tool
The Circle tool is used to draw circles of various sizes.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the circle to be drawn. To transition EXISTING performers into a circle, move the Red Anchor to the count
where the selected performers should “hit” the circle shape. Move the Yellow Anchor to the beginning
count of the transition into the new circle. This is usually the previous set in the drill. Select the existing
performers that will be moving into the circle using a Selection Tool. See the Drawing Tools overview for
more explanation between new performers and transitioning existing performers.

Clicking on the Circle tool will display the Circle Tool Control Panel.
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Drawing a Circle

The circle is drawn by clicking two points on the field display. The first click on the field will be the center
point of the circle. The second click will be the first performers along the edge of the circle. The remaining
performers will be drawn counter-clockwise from the first performer.

Circle Tool Control Panel Options

Many of the options in the Circle Tool Control Panel are exactly the same as options in the Line tool. Refer
to the Line tool for details on the Symbol, Color, Editing Handles, and Reposition Handles. See Matching
Lines for an explanation of the Matching Lines functions.

Concentric Clone

When concentric clone is selected, the cloned shapes will reflect concentrically from the clone handle. This
handle can be moved, similar to edit handles, by clicking and dragging around the field.

Entering a number in the Data Points box will change the number of points in the circle. This is useful to
create different shapes. For example, 3 data points creates a triangle, 4 would create a rectangle, and 5
data points would create a pentagon.

Similarly, entering the interval in the Interval box will lock the interval and the line will maintain the interval
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while you move its editing handles. Since the interval between positions is locked, the form would grow or
shrink by changing the number of positions in the form.

Mixed Intervals are also entered by pressing the button. This option will allow you to have different
intervals in one form. Mixed Intervals are extremely useful when charting large instruments or instruments
that are close together but vary in size (drum lines, for example).

To create a Mixed Interval, type the Interval value, followed by an “x”, followed by the number of positions
at that interval. For example, a form with 5 positions at a 3 step interval, followed by 10 positions at a 2 step
interval, ending with 5 positions at a 3 step interval would be entered like this:

5×3,10×2,5×3

Mixed Intervals can be entered before or after you create your shape, but must be entered before you
Accept the form.

The Offset Spacing option will offset the first performer of the circle by half the interval. This is useful when
you want an equal number of performers on each side of a yard line. Place the circle edge handle on the
yard line and the performers will be spaced equally on each side of the line.

The Lock to Circle option will create a circle. Turning off this option will create an oval shape. When
creating an oval there will be two Editing Handles which are used to define the inner size and outer size of
the oval. Should you want to rotate the oval, use the Rotation Arm of the Reposition Handle located at the
center of the oval.

The First Place at Top of Circle will make the matching order begin at the top of the circle. This can be aid
in making matching of the circle easier.
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Point Tool
The Point tool is used to add performers one at a time.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the point(s) to be entered. To transition EXISTING performers into the point(s), move the Red Anchor to the
count where the point(s) should be drawn. Move the Yellow Anchor to the beginning count of the transition
into the new point(s). This is usually the previous set in the drill. Select the existing performers that will be
moving into the point(s) using a Selection Tool. See the Drawing Tools overview for more explanation
between new performers and transitioning existing performers.

Clicking on the Point tool will display the Point Tool Control Panel.

Drawing Points

For NEW performers, each click on the field will add a performer at the exact spot on the field you clicked.
To transition EXISTING performers into points, with the existing performers selected, open the Point tool.
Add a click anywhere on the field for each selected position. Performers will be automatically matched to
each point on the field you add.

Point Tool Control Panel Options

Many of the options in the Point Tool Control Panel are exactly the same as options in the Line tool. Refer
to the Line tool for details on the Clone, Symbol, Color, Editing Handles, and Reposition Handles. See
Matching Lines for an explanation of the Matching Lines functions.

Arc Tool
The Arc tool creates an arc shape.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
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the arc to be drawn. To transition EXISTING performers into an arc, move the Red Anchor to the count
where the selected performers should “hit” the arc shape. Move the Yellow Anchor to the beginning count
of the transition into the new arc. This is usually the previous set in the drill. Select the existing performers
that will be moving into the arc using a Selection Tool. See the Drawing Tools overview for more explanation
between new performers and transitioning existing performers.

Clicking on the Arc tool will display the Arc Tool Control Panel.

Drawing an Arc

An arc is drawn by clicking three points on the field display. The first click on the field is the first endpoint of
the arc. The second click on the field is the second endpoint of the arc. The third click on the field is a point
along the edge of the arc.

Arc Tool Control Panel Options

Entering a number in the Data Points box will change the number of points in the arc. This is useful to
create different shapes. For example, 3 data points will create a wedge.
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Similarly, entering the interval in the Interval box will lock the interval and the form will maintain the interval
while you move its editing handles. Since the interval between positions is locked, the form would grow or
shrink by changing the number of positions in the form.

Mixed Intervals are also entered by pressing the button. This option will allow you to have different
intervals in one form. Mixed Intervals are extremely useful when charting large instruments or instruments
that are close together but vary in size (drum lines, for example).

To create a Mixed Interval, type the Interval value, followed by an “x”, followed by the number of positions
at that interval. For example, a form with 5 positions at a 3 step interval, followed by 10 positions at a 2 step
interval, ending with 5 positions at a 3 step interval would be entered like this:

5×3,10×2,5×3

Mixed Intervals can be entered before or after you create your shape, but must be entered before you
Accept the form.

Many of the options in the Arc Tool Control Panel are exactly the same as options in the Line tool. Refer to
the Line tool for details on the Clone, Alignment, Symbol, Color, Editing Handles, and Reposition
Handles. See Matching Lines for an explanation of the Matching Lines functions.

Curve Tool
The Curve tool is used to create curvilinear shapes, both symmetrical and asymmetrical.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the curve to be drawn. To transition EXISTING performers into a curve, move the Red Anchor to the count
where the selected performers should “hit” the curve shape. Move the Yellow Anchor to the beginning
count of the transition into the new curve. This is usually the previous set in the drill. Select the existing
performers that will be moving into the curve using a Selection Tool. See the Drawing Tools overview for
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more explanation between new performers and transitioning existing performers.

Clicking on the Curve tool will display the Curve Tool Control Panel.

Drawing a Curve

The curve is drawn by clicking three or more points on the field display. The first click on the field is the first
endpoint of the curve. Each consecutive click on the field will continue the curve shape, adding an editing
handle for every click. You can use these handles to further modify the shape of the curve.

Curve Tool Control Panel Options

The Del Last button is used to remove the last entered point when creating the curve.

The Del Half button is used to reduce the number of points entered in half by deleting every other point
entered on the field. This is useful if you have too many points to form a smooth curve.

Entering the interval in the Interval box will lock the interval and the form will maintain the interval while you
move its editing handles. Since the interval between positions is locked, the form would grow or shrink by
changing the number of positions in the form.

The fewer points you have on the curve, the smoother it will be.*
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Mixed Intervals are also entered by pressing the button. This option will allow you to have different
intervals in one form. Mixed Intervals are extremely useful when charting large instruments or instruments
that are close together but vary in size (drum lines, for example).

To create a Mixed Interval, type the Interval value, followed by an “x”, followed by the number of positions
at that interval. For example, a form with 5 positions at a 3 step interval, followed by 10 positions at a 2 step
interval, ending with 5 positions at a 3 step interval would be entered like this:

5×3,10×2,5×3

Mixed Intervals can be entered before or after you create your shape, but must be entered before you
Accept the form.

Many of the options in the Curve Tool Control Panel are exactly the same as options in the Line tool. Refer
to the Line tool for details on the Clone, Alignment, Symbol, Color, Editing Handles, and Reposition
Handles. See Matching Lines for an explanation of the Matching Lines functions.

Free Form Tool
The Free Form tool allows you to draw freely without the restriction of a certain shape. This tool would be
most similar to a paintbrush/pencil/pen tool of graphic design applications.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the free form shape to be drawn. To transition EXISTING performers into a free form shape, move the Red
Anchor to the count where the selected performers should “hit” the free form shape. Move the Yellow
Anchor to the beginning count of the transition into the new shape. This is usually the previous set in the
drill. Select the existing performers that will be moving into the free form shape using a Selection Tool. See
the Drawing Tools overview for more explanation between new performers and transitioning existing
performers.
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Clicking on the Free Form tool will display the Free Form Control Panel.

Drawing a Free Form Shape

The free form is drawn by clicking points on the field display. The first click on the field is the first endpoint
of the free form. The second click on the field places an editing handle at the second point of the free form
shape. By continuing to click on the field you add more editing handles that extend the shape.

You could also draw a free form shape by continuously holding the mouse button while moving the mouse
across the field.

Free Form Tool Control Panel Options

Edit Handle Spacing allows you to adjust the frequency that new editing handles (red box) are added to a
shape while drawing. For example, if you enter “2” the in Edit Handle Spacing box, while using the Free
Form tool, an edit handle will appear every two yards on the shape you create.

The Del Last button is used to remove the last entered point when creating the free form.

The Del Half button is used to halve the number of points entered by deleting every other point entered on
the field. This is useful if you have too many points to form a smooth shape.

Entering the interval in the Interval box will lock the interval and the form will maintain the interval while you
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move its editing handles. Since the interval between positions is locked, the form would grow or shrink by
changing the number of positions in the form.

Mixed Intervals are also entered by pressing the button. This option will allow you to have different
intervals in one form. Mixed Intervals are extremely useful when charting large instruments or instruments
that are close together but vary in size (drum lines, for example).

To create a Mixed Interval, type the Interval value, followed by an “x”, followed by the number of positions
at that interval. For example, a form with 5 positions at a 3 step interval, followed by 10 positions at a 2 step
interval, ending with 5 positions at a 3 step interval would be entered like this:

5×3,10×2,5×3

Mixed Intervals can be entered before or after you create your shape, but must be entered before you
Accept the form.

Many of the options in the Free Form Tool Control Panel are exactly the same as options in the Line tool.
Refer to the Line tool for details on the Clone, Alignment, Symbol, Color, Editing Handles, and
Reposition Handles. See Matching Lines for an explanation of the Matching Lines functions.

Filled Shape Tool
The Filled Shape tool creates filled shapes. These shapes can have any number of sides. Typically, the
Filled Shape tool is used to fill rectangles and triangles.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the filled shape to be drawn. To transition EXISTING performers into a filled shape, move the Red Anchor
to the count where the selected performers should “hit” the filled shape. Move the Yellow Anchor to the
beginning count of the transition into the new shape. This is usually the previous set in the drill. Select the
existing performers that will be moving into the shape using a Selection Tool. See the Drawing Tools
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overview for more explanation between new performers and transitioning existing performers.

Clicking on the Filled Shape tool will display the Filled Shape Tool Control Panel.

Drawing a Filled Shape

The filled shape is created by clicking three or more points on the field display. For example, the first click
on the field could be the first point of the first side of a multi-sided block. The second click on the field
finishes the first side and starts the next side and so on. A filled form can have as many sides as you prefer.

Filled Shape Tool Control Panel

Entering a value in Positions will lock the positions box to the value entered. If both of the Horizontal and
Vertical boxes are locked, one will be unlocked automatically in order to adjust the intervals to maintain the
value entered for positions. If the shape of the block is such that the positions value can not be maintained
with reasonable intervals, a message will appear above the Accept button in the Control Panel.

Entering a value in both Horizontal and Vertical intervals will unlock (if locked) the positions value. The
value in the positions box will be calculated to maintain the intervals entered.

Stagger will stagger the spacing of each row in the block.
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Show Bridges shows the matching lines when a block is entered as a “transition”.

Del Last will remove the last editing handle entered.

Many of the options in the Filled Shape Tool Control Panel are exactly the same as options in the Line
tool. Refer to the Line tool for details on the Clone, Symbol, Color, Editing Handles, and Reposition
Handles. See Matching Lines for an explanation of the Matching Lines functions.

Block Tool
The Block tool quickly creates block and rhombus shapes from user defined lines. To open the Block tool,
select the tool from the Tool Palette. This will open the Block Tool Control Panel.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the block to be drawn. To transition EXISTING performers into a block, move the Red Anchor to the count
where the selected performers should “hit” the block shape. Move the Yellow Anchor to the beginning
count of the transition into the new block. This is usually the previous set in the drill. Select the existing
performers that will be moving into the block using a Selection Tool. See the Drawing Tools overview for
more explanation between new performers and transitioning existing performers.

Drawing a Block

Using the Block tool is quite simple. In the following example, let’s say we want a 64 performer block. Enter
the number of performers you would like for one side of the block (since we want 64 performers, this would
be 8) in the Control Panel in the P1 to P2 box. Do the same for the second side (once again, this would be
8) in the P1 to P3 box.

Click three positions on the field. The first click would be P1, the second click P2, and the third click would
be P3. The Block tool will automatically create a block based off the numbers you input for the sides, and
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where you clicked on the field. Since each click you placed on the field is an edit handle for the block, you
may adjust the size my maneuvering one of the edit handles, or location by moving the Reposition Handle.

Many of the options in the Block Tool Control Panel are exactly the same as options in the Line tool. Refer
to the Line tool for details on the Clone, Symbol, Color, Editing Handles, and Reposition Handles. See
Matching Lines for an explanation of the Matching Lines functions.

Bezier Curve Tool
The Bezier Curve tool will create a bezier curve. Think of the Bezier Curve tool as a more sophisticated
Curve tool, with more control over curvature, especially at endpoints.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the curve to be drawn. To transition EXISTING performers into a curve, move the Red Anchor to the count
where the selected performers should “hit” the curve shape. Move the Yellow Anchor to the beginning
count of the transition into the new curve. This is usually the previous set in the drill. Select the existing
performers that will be moving into the curve using a Selection Tool. See the Drawing Tools overview for
more explanation between new performers and transitioning existing performers.

Clicking on the Bezier Curve tool will display the Bezier Curve Control Panel.
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Drawing a Bezier Curve

The curve is drawn by clicking two or more points on the field display. The first click on the field is the first
endpoint of the curve. The second click on the field develops the curve initially as a line. The ends of the
line have editing handles.

Dragging the red square in the editing handle will move the endpoints.

Dragging the red circle extending from the square handle will shape the curve.

Entering the interval in the Interval box will lock the interval and the form will maintain the interval while you
move its editing handles. Since the interval between positions is locked, the form would grow or shrink by
changing the number of positions in the form.

Mixed Intervals are also entered by pressing the button. This option will allow you to have different
intervals in one form. Mixed Intervals are extremely useful when charting large instruments or instruments
that are close together but vary in size (drum lines, for example).

To create a Mixed Interval, type the Interval value, followed by an “x”, followed by the number of positions
at that interval. For example, a form with 5 positions at a 3 step interval, followed by 10 positions at a 2 step
interval, ending with 5 positions at a 3 step interval would be entered like this:
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5×3,10×2,5×3

Mixed Intervals can be entered before or after you create your shape, but must be entered before you
Accept the form.

Many of the options in the Bezier Curve Tool Control Panel are exactly the same as options in the Line
tool. Refer to the Line tool for details on the Clone, Alignment, Symbol, Color, Editing Handles, and
Reposition Handles. See Matching Lines for an explanation of the Matching Lines functions.

Polygon Tool
The Polygon tool is used to create outlined polygon shapes.

For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the polygon to be drawn. To transition EXISTING performers into a polygon, move the Red Anchor to the
count where the selected performers should “hit” the polygon shape. Move the Yellow Anchor to the
beginning count of the transition into the new shape. This is usually the previous set in the drill. Select the
existing performers that will be moving into the polygon using a Selection Tool. See the Drawing Tools
overview for more explanation between new performers and transitioning existing performers.

Clicking on the Polygon tool will display the Polygon Tool Control Panel.
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Drawing a Polygon

The Polygon tool operates similar to the Circle tool. Use the Sides text box to enter the number of sides on
the polygon. Polygons are drawn by clicking two points on the field display. The first click on the field will be
the center point of the polygon. The second click will be one of the performers furthest from the center of the
polygon (a corner). The remaining performers will be drawn in automatically, depending on the number of
sides you specified. You can change the number of sides of the Polygon before committing the form to drill.

Polygon Tool Control Panel

Many of the options in the Polygon Tool Control Panel are exactly the same as options in the Line tool.
Refer to the Line tool for details on the Clone, Symbol, Color, Editing Handles, and Reposition Handles.
See Matching Lines for an explanation of the Matching Lines functions.
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Selection, Adjustment, Regrouping Tools
Many tools used to design drills work with existing shapes. In order to use these tools that modify existing
shapes, one must select the performers that will be edited. That process is called “selection” and is
accomplished using Selection tools. This section covers using all Selection tools: the Pointer tool, the Box
Selection tool, the Lasso tool, the Spotlight Selection tool, and the Profile Selection tool.

Adjustment tools are used to make quick adjustments in the transition and placement of formations. The
adjustment tools include the Snap To and Adjust To functions.

You’ll find that while designing it is often quite useful to cut or split a shape into smaller shapes, or combine
two or more shapes into larger shapes. For example, imagine an arc splitting into thirds and each third
floating into one of three lines. To make the editing easier, we would first want to split the arc into three
parts. That can be done using the Knife tool. After cutting the arc, we can select one part of the arc
independently of the others. We would then select the first part of the arc and morph it into a line, and
repeat the process for the remaining parts. The process of splitting and combining performers is called
“regrouping” and is done using the Regrouping tools. This section covers using the Regrouping tools: the
Knife and Glue tool.

Click on the arrow next to Selection, Adjustment, Regrouping Tools in the Table of Contents to the left to
expand this section and begin.

Pointer Selection Tool
The Pointer Selection tool is the basic tool for selecting shapes. This tool is used to quickly select all of the
performers of a shape.

The Pointer Selection tool only selects whole shapes. In other words, when you use the Pointer Selection
tool you will get ALL of the performers in a shape. If you only want to select a portion of the performers in a
shape, other selection and regrouping tools will be used.

To select the Pointer Selection tool, click on the Pointer tool on the Tool Palette.

Clicking on a shape on the field will select all of the performers of the shape. When only one shape is
selected, the Console will display the Average Interval of the selected shape in steps.

Double-clicking on the Pointer tool on the Tool Palette is the same as choosing Select
Recent from the Edit menu.*
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To add another shape to the selection, hold the [SHIFT] key and click on another shape. Similarly, to
remove a shape from the selection, hold down [SHIFT] and click on the shape you wish to deselect.

With the Pointer Selection tool activated, dragging across performers on the field selects all of the shapes
that have performers found within the drag region.

Even if you only catch one performers within the drag region, the entire shape that the performer is a
member of is selected.

Holding down [SHIFT] while dragging across performers will add the shapes of the performers falling inside
the drag region to the selection.

Clear a Selection

Click anywhere on the field (but not a performer!) to clear a selection.
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Box Selection Tool
The Box Selection tool is used to select a group of performers by dragging a selection box around the
performers. Unlike the Pointer Selection tool where whole shapes are selected, the Box Selection tool is
capable of selecting portions of a shape. When using the Box Selection tool all performers that are
included in the boxed area (drag region) are selected.

To select the Box Selection tool, click on the Box Selection tool on the Tool Palette.

With the Box Selection tool selected, clicking and dragging a boxed region around the performers will
select the performers inside the drag region.

Holding down the [SHIFT] key while dragging the boxed region around unselected performers adds the
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performers to the selection. Likewise, holding down the [SHIFT] key while dragging around selected
performers removes them from the selection.

Clicking on the field but not on a performer clears the selection.

Lasso Selection Tool
The Lasso Selection tool is used to select a group of performers by drawing a line around the performers.
Unlike the Pointer Selection tool, the Lasso Selection tool is capable of selecting portions of a shape.
When using the Lasso Selection tool all of the performers found within the lasso region are included in a
selection.

To select the Lasso Selection tool, click on the Lasso Selection tool on the Tool Palette.

Clicking and dragging a line around the performers will select them.

Holding down the [SHIFT] key while dragging the line around unselected performers adds the performers to
the selection. Likewise, holding down the [SHIFT] key while dragging a line around selected performers
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removes them from the selection.

Clicking on the field but not on a performer clears the selection.

Spotlight Selection Tool
The Spotlight Selection tool is used to select and highlight a position to help a performer watch their
movement while animating a drill.

To select the Spotlight tool, click on the Spotlight tool on the Tool Palette and the Spotlight Tool Control
Panel will display.

To spotlight a position, you can either type in the position’s Name, Symbol, and/or Label.

There are options that allow you to see the bridges or paths that the positions will take to go to their next
location.

The No Bridge option will not display bridges or paths.

Bridge Spotlight will display the spotlit position’s bridge or path.

Bridge All will show bridges or paths of all positions visible on the design grid.

Clear remove the spotlight from the display and resets the Spotlight Tool Control Panel.

Profile Selection Tool
The Select by Profile tool is for selecting performers by Color, Label, Symbol, or Name. This tool is used
to quickly select groups of performers with similar characteristics.
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To select the Profile Selection tool, click on the Profile Selection tool on the Tool Palette and the Profile
Selection Control Panel will appear.

Selecting by Profile

Click on the filter to use when searching for performers you wish to select (or deselect). For example, if all
of the performers you want selected are drawn in purple symbols, then you would click on the Color filter to
search by color. If all trumpets are the symbol “T”, then click the Symbol filter to search by symbol.

After selecting the filter, enter a search value in the Search for… box. The performers matching that filter
value will be highlighted with red boxes. As a shortcut, you can also click on a performer on the screen that
has the search value and it will be entered for you. For example, when searching for a color, click on a red
performer and all of the red performers will be highlighted.

If the highlighted performers (performers in red boxes) are performers that you want to include in the
selection, click Include. The selection will be modified. All performers in the selection will be marked with a
red dot.

You can repeat the process of picking a filter, entering a filter value, then clicking Include (or Exclude).

The buttons Include, Exclude, All, Clear are used to modify the current selection with the highlighted
performers.
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Include will include the highlighted performers in the current selection.

Exclude will remove the highlighted performers from the current selection.

All will add all performers to the current selection.

Clear will remove all performers from the current selection.

You can use combinations of these buttons to modify your selection.

For example, let’s say you want to select all trumpet players. Let’s assume the trumpet and trombone
players are both labeled, T1, T2, etc. Also, the upper brass are colored red and the lower brass are colored
blue. If we search by labels starting with “T” we will get both trumpets and trombones. Likewise, if we search
for upper brass we will get all the upper brass instruments including the trumpets. Here’s the solution:

• Search for labels starting with “T” to highlight both trumpets and trombones.

• Click Include to include both trumpets and trombones in the selection.

• Search for performers with the color “Blue” to highlight the trombones as well as the other lower brass
instruments.

• Click Exclude to remove the lower brass instruments from the current selection, therefore leaving
only the trumpets selected.

Selection History Tool
The Selection History tool is a selection tool that has a memory of previous selections of grouped
performers. To access the tool, select the tool from your Tool Palette.

This will open the Selection History window. This window is comprised of two portions: the Favorites list
and History list.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 179 of 407



History List

The History list is populated with selections that were used with an editing or drawing tool. Selections are
remembered per set, per drill and saved with drill files.

The History list keeps 16 of the most current selections in the list. When more than 16 selections have been
made on a set, the most recent will be kept, and those furthest back will be pushed off the list.

To keep a selection in the History list remembered, select the Keep check box for that selection. This will
keep that particular selection available at the top of the History list on that particular page.

Favorite List

Select the Favorite option for quick access to the grouped selection at any point in the drill. Selections that
have been added to the Favorites list will be accessible on any page of the drill.

Any selections can be renamed by clicking under the Name column for the particular selection you would
like to rename.

Selecting the Tool button for a grouped selection will highlight the selected performers and open the tool’s
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control panel for the tool that was used.

Glue Regrouping Tool
The Glue Regrouping tool is used for combining two or more shapes into single shapes. For example,
imagine three lines floating into a curve. To make the editing easier, we would first want to glue the three
lines into a single shape using a Glue tool. After gluing, we can select all three lines at one time as a single
shape. We would then simply morph the selection into a curve.

To select the Glue tool, click on the Glue tool and the Glue Tool Control Panel will display.

The Glue Tool Control Panel behaves differently from other tool panels. By default, there is no active
Accept button. Every glue with the glue tool is accepted without having to click the Accept button. This is
usually preferred because the Glue tool is used quite frequently for single glues. Requiring the click of the
Accept button would simply add an unnecessary step. However, if you want to make the Glue Tool Control
Panel behave like typical 3D Control Panels, click off the Accept each change and stick around… option.
When this option is off, the Accept button will be available and if not clicked when you are finished gluing,
then no changes will occur.

To perform a glue between two highlighted shapes, click on the performers on each end of the two shapes.
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The Glue tool can be switched to the Knife tool by clicking on the Knife option.

Regroup All button will break all of the performers in the highlighted shape(s) into individual points. After
the performers are broken up, you can reconnect the performers in a different order. Normally this is not
used when all of the shapes of a page are highlighted. To highlight a smaller group of performers, select the
group prior to clicking on the Glue tool. The Regroup All option is commonly used to change the grouping
order of block shapes as shown.

You can click and drag (much like mimicking a “Gluestick”) through performers, and the grouping will be
assigned based on the order you drag over a performer. Regroup performers by clicking on one endpoint
(performer) of the form, then dragging through every other performer, in the order you wish them to be
grouped in.

This method can also be used to regroup multiple forms. Once the last performer of a form is grouped, click
on that performer. This releases the grouping option, at which point you can click on the starting performer
for the new form, and repeat the process.

Apply Pattern is available when only one shape is highlighted. To highlight a single shape, use the Pointer
Selection tool to select the shape prior to clicking on the Glue tool. To use Apply Pattern, select a pattern
from the pop up menu, and click Apply Pattern. The “AB” pattern will regroup a shape where every other
performer becomes a member of the first new shape and the remaining performers become members of a
second new shape. It is difficult to see any change on the field display. The first new shape is almost
directly over the second new shape.

Divide Into allows you to divide the selected shape into Halves, Thirds, Quarters, Pairs, Groups of 4, 6,
or 8. Select the appropriate grouping you wish to apply from the drop down menu, then select Divide Into. If
the Accept each change and stick around… checkbox is not checked, the new grouping will not take
effect until you select the Accept button.

The Find Next button will find the next person in the direction the form has begun to be glued and then glue
it to the end of the section. This function allows you to continue gluing a continuous line or form without
requiring every position to be clicked on individually.

The Undo Last button will undo the last glue that was performed.

Revert button reverts the grouping order to its initial order.
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Knife Regrouping Tool
The Knife Regrouping tool is used for cutting a shape into smaller pieces. For example, imagine an arc
splitting into thirds and each third floating into one of three separate lines. To make the editing easier, we
would first want to split the arc into three parts using the Knife tool. After cutting, we can select one part of
the arc independently of the others. We would then select the first part of the arc and morph it into a line,
then repeat the process for the remaining parts.

To select the Knife tool, click on the Knife tool and the Knife Tool Control Panel will display.

The Knife Tool Control Panel behaves differently from other tool panels. By default, there is no active
Accept button. Every cut with the knife is accepted without having to click the Accept button. This is usually
preferred because the Knife tool is used quite frequently for single cuts. Requiring the click of the Accept
button would simply add an unnecessary step. However, if you want to make the Knife Tool Control Panel
behave like typical 3D control panels, click of the Accept each change and stick around… option. When
the option is off, the Accept button will be available and if not clicked when you are finished cutting, then no
changes will occur.

To perform a cut on a highlighted shape, click on the performers on each side of the cut location.
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Regroup All will break all of the performers in the highlighted shape(s) into individual points. After the
performers are broken up, you can reconnect the performers in a different order. Normally this is not used
when all of the shapes of a page are highlighted. To highlight a smaller group of performers, select the
group prior to clicking on the Glue tool. The Regroup All option is commonly used to change the grouping
order of block shapes as shown.

Apply Pattern is available when only one shape is highlighted. To highlight a single shape, use the Pointer
Selection tool to select the shape prior to clicking on the Knife tool. To use Apply Pattern, select a pattern
from the pop up menu, and click Apply Pattern. The AB pattern will regroup a shape where every other
performer becomes a member of the first new shape and the remaining performers become members of a
second new shape. It is difficult to see any change on the field display. The first new shape is almost
directly over the second new shape.

Divide Into allows you to divide the selected shapes into Halves, Thirds, Quarters, Pairs, Groups of 4, 6,
or 8. Select the appropriate grouping you wish to apply from the drop down menu, then select Divide Into. If
the Accept each change and stick around… checkbox is checked, the new grouping will not take effect
until you select the Accept button.

The Undo Last button will undo the last knife that was done.

Revert button reverts the grouping order to its initial order.

Snap To Editing Tool
This function snaps the selected performers to the nearest whole, half or quarter step. Choosing Snap To
from the Edit menu will display the Snap To dialog where you can choose the snap to resolution.

At least one performer must be selected to use this function.
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Adjuster Tool
The Adjuster editing tool is used for quickly moving and/or adjusting performers in shapes and transitions
without having to first select the performers.

Using the Adjuster Tool

On the Count Track, move the Red Anchor to the count of drill where the change of path adjustment will
stop. Move the Yellow Anchor to the beginning of the transition where the path adjustment will start
(usually the previous set).

If you want to limit the adjustment function to a number of performers, select them first using one of the
Selection tools. This is optional, however, as you can open the Adjuster tool without selecting anyone.

Click on the Adjuster editing tool or select Adjust To from the Edit menu and the Adjuster Tool Control
Panel will appear.

This is often used to firm up the positions of a block formation where all performers are a
whole step interval from each other.*
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If any performers were selected when starting the Adjuster tool, red editing handles will appear over each
performer. If you want to move them all, click and drag on one of the editing handles and they all will move.

If you want to move only one individual, click Deselect if any performers are selected to remove all of the
editing handles, then click and drag any single performer.

If you want to move a few performers at the same time, hold [SHIFT] and click on each performer until a red
editing handle appears over every performer you wish to move, then drag one of them. The other
performers will move similarly.

Edit Paths allows you to change the pathing of the selected performer(s). Edit handles can be removed to
create smoother transitions by clicking the Fewer Handles option.

To edit individual steps of a performer’s existing path, click Edit Steps. Editing handles will appear at each
step of the selected performers. If you select more than one performer and edit a step of one performer, the
same step for the others will similarly move. Since an editing handle appears at each step, it may be
necessary to zoom in to the area of the performer to drag the handles easily.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 186 of 407



Show Paths shows all of the paths of the selected performers or the performer you are adjusting.

Show Symbols shows the symbols of the selected performers while you are adjusting.

Revert removes all changes made while adjusting and starts the Adjuster tool over.

Stride and Distance boxes show the current stride and distance of the performer whose location you are
dragging.

Pace Tool

The Pace tool is used during animation to show a performer moving in double time, half time, or regular time
(one step per count). When a performer is marking time, the mark time pace is displayed by flashing the
performer twice per beat for double time, once every other count for half time, once per beat for regular
time, or no flashing at all for performers holding their position.

Move the Red anchor to the count of drill where the change of pace will stop. Move the Yellow anchor to
the beginning of the transition where the change in pace will start (usually the previous set). Select the
existing performers whose pace will be changing using a Selection tool such as the Pointer tool.

Click on the Pace tool and the Pace Tool Control Panel will be displayed.

The Pace Tool is only available if the Real View is disabled, or any version prior to version
7. See the Visuals Editor for information on how to change pace if the Real View window is
enabled.
*
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Enter the pace change information and click Accept. You can preview the change by clicking on the Play
(animation) button prior to committing the change.

Facing Tool

The Facing tool enables you to change the performer’s facing (or orientation) on the field. This is helpful to
see a more realistic approach to what your drill would look like in the Perspective view.

Open the Facing tool by clicking on the Facing tool on the Tool Palette. The Facing Tool Control Panel
will appear.

To change the facing of a performer, select the “Face” radio button and click on the compass to determine
which angle you would like the performer to face.

The Facing Tool is only available if the Real View is disabled, or any version prior to version
6. See the Visuals Editor for information on how to change performer facing if the Real View
window is enabled.
*
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To change the facing of a group of performers, select the “Face” radio button and click on the compass to
determine which angle you would like the group of performers to face.

The “Follow direction of movement” button automatically adjusts the selected performers to face the
direction they are traveling for the entirety of the move.

To toggle facing on or off while designing, select the “Show/Hide facing” button above the console.

Set Reference Tool
The Set Reference Tool is used to indicate which performer(s) will be used as a reference point for
adjusting or cleaning drill. To set a performer as a reference point, select the Set Reference Tool from the
Tool Palette.

Highlight a group of performers and select the Set Reference Tool. The Set Reference Tool control panel
will open, and you may click on performers to set them as reference points. There is no limit to the number
of reference point performers allowed.

Reference points will be displayed on the chart with a diamond around them, and their coordinate will be
underlined on coordinate sheet print outs.
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Editing & Maneuvering Tools
The tools in this section are called Editing & Maneuvering tools. these tools are used to reshape existing
shapes displayed at the count indicated by the Red Anchor of the Count Track. However, the power of
these tools go much further than just editing a single count. These tools also create the transition to the
count at the Red Anchor from the count at the Yellow Anchor. Typically the count at the Yellow Anchor is
the count of the previous set you have completed.

For example, imagine you are working on Set #2 of your drill. Set #1 of your drill is at count 0 and Set #2 of
your drill is at count 32. The Yellow Anchor is at count 0 and the Red Anchor is at count 32. Editing &
Maneuvering tools will make changes to shapes at count 32 as well as create the transition between counts
0 to 32.

Editing & Maneuvering tools are always used on existing performers. Therefore, in order to make the
Editing & Maneuvering accessible, you must select at least one performer on the field. Performers are
selected with Selection tools such as the Pointer tool.

Click on the arrow next to Editing & Maneuvering Tools in the Table of Contents to the left to expand this
section and begin.

Push Tool
The Push tool is used to relocate a selected shape in a straight line path from one point of the field to
another without changing the form of the shape.

To establish the counts where the push transition is to begin and end in the drill, set the Red Anchor on the
Count Track to the count where the push transition is to end. This is typically the count of the set you are
currently working on. Set the Yellow Anchor to the count where the push transition is to begin. This is
typically the previous set.

After selecting the shape or shapes that you want to push, clicking on the Push tool will display the Push
Tool Control Panel.
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Using the Push Tool

Editing Handles appear on each selected performer. These handles can be moved across the field, which
would move all performers to the final location of the push transition. While dragging the editing handles
the location of the cursor is displayed in the Console as well as the Largest Stride and Largest Distance.
The resolution of the cursor can be controlled by the whole, half, and quarter step switches on the Console.
The Push Tool Control Panel also displays the Stride and Distance.

A Reposition Handle will appear in the center of the selected performers. Dragging the center of the
Reposition Handle is the same as dragging one of the performer handles. Dragging the Rotator Arm that
extends from the Reposition Handle will rotate the shape. The point of rotation can be changed by
dragging the outer ring of the Reposition Handle to a preferred location.
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Use the Arrow Keys to shift and rotate forms easily without having to change tools or use the mouse.
Moving forms with the Arrow Keys (without the modifier keys) is disabled in drawing tools, because this
feature is primarily used for matching performers when regrouping. You can, however, use Arrow Keys to
move the form when you have any editing tool open. Simply select the form you wish to move, select your
editing tool, then move the form with your Arrow Keys.

[SHIFT][ARROW KEY] moves the center of the Relocation Handle and the selected form one step. This
causes the new positions to shift similarly to the new location.

[CONTROL][ARROW KEY] rotates the Relocation Handle 5 degrees. This causes the new positions to
rotate around the Relocation Handle.

Push Tool Control Panel Options

Entering a number in the Stride box will move the editing handles the correct distance to reflect the new
stride.

Entering a distance in yards (or meters) in the Distance text box will move the editing handles to the
distance entered.

Clicking a direction on the Direction Compass will move the editing handles to reflect the new direction.

Snap to Horz/Vert padlock will snap the handles to the nearest horizontal, vertical, or 45 degree direction.

Mirroring options are available if two or more shapes are selected. When mirroring, the direction of the
shapes can be set to opposing horizontally, opposing vertically, or opposing both horizontally and vertically.
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Show Symbols will display the position symbols instead of a plain dot.

Compound Move combines two maneuvers, such as a rotation & float, in to one transition. If the
Compound Move option is not selected, the Push tool will overwrite the existing transition over the selected
range.

Reset to Hold will reset the transition to a “hold” from the secondary count.

At any time the Animation Controls can be used to preview the change in the drill. Other useful options that
can be accessed during the change are located in the upper right corner of the Field Display Window. These
functions control the field display appearance such as moving or zooming the field, showing/hiding the text
boxes, and showing/hiding the performer labels.

Accept commits the change to the drill. Clicking on any tool without clicking Accept will cancel the change.
The change can also be cancelled by moving an anchor on the Count Track.

Fixed Interval Float Tool
The Fixed Interval Float tool is an editing tool that allows transitions to incorporate curved paths.

Since the Fixed Interval Float tool is an editing tool, performers must be selected in order to select the
Fixed Interval Float tool on the Tool Palette.

Using the Fixed Interval Float Tool

Once performers are selected, open the Fixed Interval Float tool. One performer will have a blue handle on
top of them. This is the Guide Performer Handle. The performer with the Guide Performer Handle is the
performer that all other performers reference to create curved pathways. Because of this, the performer
indicated with the Guide Performer Handle will always take a straight line path to their destination.

The Fixed Interval Float tool operates much like the Push tool. You can maneuver the form by adjusting
any of the Edit Handles or by moving the Relocation Handle.
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Fixed Interval Float Tool Control Panel Options

Curved Shape option will create a curved shape between the handles. When the option is not selected, the
shape consists of straight lines between the handles.

To create a curved path with fixed (locked) intervals, check the Lock Intervals check box. This will make all
performers take a curved path while maintaining their intervals in the form.

Show Paths shows all of the paths of the selected performers you are editing.

Show Symbols shows the symbols of the selected performers while you are adjusting.

Dragging an Editing Handle (red box) reshapes the form.

[SHIFT] click on the shape (blue line) adds an Editing Handle.

Delete Half removes every other handle from the shape.

Revert returns the form to its shape before floating.

Reset to Hold resets the form to its shape at the Secondary count (yellow anchor) creating a “hold”.
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Rotate Tool
The Rotate tool is used to “gate” a selected shape around a point along curved paths.

To establish the counts where the rotate transition is to begin and end in the drill, set the Red Anchor on
the Count Track to the count where the rotation is to end. This is typically the count of the set you are
currently working on. Set the Yellow Anchor to the count where the rotation is to begin. This is typically the
previous set.

After selecting the shape or shapes that you want to rotate, clicking on the Rotate tool will display the
Rotate Tool Control Panel.

The Fixed Interval Float tool is only available on the Interactive and Professional editions.
See the Interactive Features page for more information on upgrading your 3D edition.*

Pygraphics Pyware 3D User Guide - 11.0_en

Page 195 of 407



Editing Handles appear on each selected performer. These handles can be dragged and thus rotating all
performers to the final location of the rotation transition. While dragging the editing handles the location of
the cursor is displayed in the Console as well as the Largest Stride and Largest Distance. The Rotation
Control Panel also displays the angle of rotation.

A Point of Rotation handle will appear in the center of the selected performers. The Point of Rotation can
be changed by dragging this handle to a preferred location.

Entering an angle in the Rotation text box will move the editing handles to reflect the angle entered.

Mirroring Options are available if two or more shapes are selected. When mirroring, the rotation of the
shapes can be set to rotate on each shape’s individual point of rotation. The rotation can be in the same or
opposite directions.

Show Symbols will display the position symbols instead of a plain dot.

Reset to Hold – resets the transition to a “hold” from the secondary count.

Revert button resets the handles to their initial position.
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At any time the Animation Controls can be used to preview the change in the drill. Other useful options that
can be accessed during the change are located in the upper right corner of the Field Display Window. These
functions control the field display appearance such as moving or zooming the field, showing/hiding the text
boxes, and showing/hiding the performer labels.

Accept commits the change to the drill. Clicking on any tool without clicking Accept will cancel the change.
The change can also be cancelled by moving an anchor on the Count Track.

Morph Tool
The Morph tool is used to change the form of a selected shape. The transition creates a straight line path
from the original shape to the morphed shape. This is the most widely used tool because it is so versatile.

To establish the counts where the morphing transition is to begin and end in the drill, set the Red Anchor
on the Count Track to the count where the morph is to end. This is typically the count of the set you are
currently working on. Set the Yellow Anchor to the count where the morph is to begin. This is typically the
previous set.

After selecting the shape or shapes that you want to morph, clicking on the Morph tool will display the
Morph Tool Control Panel.

Editing handles appear on each selected performer. These handles can be dragged to create a new shape
at the final location. While dragging the editing handles the location of the cursor is displayed in the
Console as well as the Largest Stride and Largest Distance. Bridge lines are drawn from the original
shape to the new morphed shape. These lines represent the paths taken by the performers. The bridge line
drawn in red is the performer taking the Largest Stride.
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Initially there is one Editing handle per performer in the shape. This is often too many handles to work with.
Editing handles can be removed and added several ways.

Remove editing handles by clicking Fewer will remove half of the handles. Each time Fewer is clicked the
number of handles is cut in half.

Another way to remove editing handles is by using the cursor to drag a box onto the field around a group
of handles you want to remove.

An editing handle can also be removed by clicking directly on the handle while holding down the [SHIFT]
key. Likewise, to add editing handles to the shape, click directly between two handles while holding down
the [SHIFT] key.

Curved Shape option will create a curved shape between the handles. When the option is off the shape
consists of straight lines between the handles.

Show Bridges displays the bridge lines between the morphing shape and the initial location. The bridge
lines represent the paths of the performers. Turning this option off is useful when there are so many
performers that the bridge lines begin to clutter the screen.
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Show Symbols will display the position symbols instead of a plain dot.

Reset to Hold resets the transition to a “hold” from the secondary count.

Revert resets the handles to their initial position.

At any time the Animation Controls can be used to preview the change in the drill. Other useful options that
can be accessed during the change are located in the upper right corner of the Field Display Window. These
functions control the field display appearance such as moving or zooming the field, showing/hiding the text
boxes, and showing/hiding the performer labels.

Accept commits the change to the drill. Clicking on any tool without clicking Accept will cancel the change.
The change can also be cancelled by moving an anchor on the Count Track.

Follow the Leader Tool
The Follow the Leader (FTL) tool is used to create a new shape resulting from the paths taken by all
positions of the selected shape. The path is determined by the leader of the shape.

To establish the counts where the FTL transition is to begin and end in the drill, set the Red Anchor on the
Count Track to the count where the FTL is to end. This is typically the count of the set you are currently
working on. Set the Yellow Anchor to the count where the FTL is to begin. This is typically the previous set.

After selecting the shape or shapes you want to perform the FTL transition, clicking on the Follow the
Leader tool will display the Follow the Leader Tool Control Panel.

A red dot with a green center appears on one end of the shape. This performer is designated as the “leader”
of the FTL movement. If the other end of the shape is the preferred “leader”, click on the leader indicator
(the red dot) to change the leader to the opposite end of the form.
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If an existing path can be established for the leader, editing handles will appear along the path. These
handles can be dragged creating a new path to the final location. While dragging the editing handles the
location of the cursor is displayed in the Console as well as the Largest Stride and Largest Distance.

If no existing path has been established there will not be any editing handles visible. Clicking anywhere on
the field will create a path to that location. An editing handle will be placed at that location, the path will be
drawn and the performers will fill in place behind the leader’s new final location.

Each click on the field will extend the path of the leader to the location of each click. A new editing handle
will be added at each location.

Clicking on an editing handle while holding down the [SHIFT] key will remove the handle from the path.
Similarly, clicking along the path between two handles while holding the [SHIFT] key will insert a handle into
the path.

The Delete Last button shortens the path by removing the last editing handle of the path. This is useful
when you inadvertently add an editing handle to the end of the path.

Fewer cuts the number of handles on the path in half. Each time Fewer is clicked the number of handles is
reduced.
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The Curved Shape option will create a curved path between the handles. When the option is off the path
consists of straight lines between the handles.

Show Symbols will display the position symbols instead of a plain dot.

Reset to Hold resets the transition to a “hold” from the secondary count.

Revert resets the handles to their initial position.

Mirroring Options are available if two or more shapes are selected. When mirroring, the path of the shapes
can be set to opposing horizontally, opposing vertically, or opposing both vertically and horizontally.

At any time the Animation Controls can be used to preview the change in the drill. Other useful options that
can be accessed during the change are located in the upper right corner of the Field Display Window. These
functions control the field display appearance such as moving or zooming the field, showing/hiding the text
boxes, and showing/hiding the performer labels.

Accept commits the change to the drill. Clicking on any tool without clicking Accept will cancel the change.
The change can also be cancelled by moving an anchor on the Count Track.

Resize Tool
The Resize tool is a multipurpose tool for changing the size of a selected group of performers. The selection
can be resized any of the following ways:

Scale changes the size of the selection in equal amounts vertically and horizontally.

Stretch changes the size of the selection in differing amounts vertically and horizontally.

Slant stretches the shape while also skewing the shape in horizontal or vertical directions.

Distort changes the size of the selection in differing amounts in all four directions.

To establish the counts where the resizing transition is toe begin and end in the drill, set the Red Anchor on
the Count Track to the count where the resizing is to end. This is typically the count of the set you are
currently working on. Set the Yellow Anchor to the count where the resizing is to begin. This is typically the
previous set.

After selecting the shape or shapes that you want to resize, clicking on the Resize tool will display the
Resize Tool Control Panel.
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The selected performers are bordered on all sides by a Resizing Box. The Resizing Box has editing
handles at all four corners that can be moved.

Dragging the editing handles will manipulate the shape in a behavior based on the resize model chosen:
Scale, Stretch, Slant, Distort. While dragging the editing handles the location of the cursor is displayed in
the Console as well as the Largest Stride and Largest Distance. Bridge lines are drawn from the original
shape to the new resized shape. These lines represent the paths taken by the performers. The bridge line
drawn in red is the performer taking the largest stride.

Entering a value in the Scale To box will uniformly scale the selection by the amount entered.

Changing the value in the Interval box will resize the shape to the interval specified.

Show Symbols will display the position symbols instead of a plain dot.

Reset to Hold resets the transition to a “hold” from the secondary count.

Show Webbing displays graphically the resizing formula used on the selected group. This is rarely used,
however, can be useful with the Distort mode to understand how the handle movement is distorting the
group.

Revert button resets the handles to their initial position.
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At any time the Animation Controls can be used to preview the change in the drill. Other useful options that
can be accessed during the change are located in the upper right corner of the Field Display Window. These
functions control the field display appearance such as moving or zooming the field, showing/hiding the text
boxes, and showing/hiding the performer labels.

Accept commits the change to the drill. Clicking on any tool without clicking Accept will cancel the change.
The change can also be cancelled by moving an anchor on the Count Track.

Track Tool
The Track tool moves a group of performers uniformly along a path. Unlike the Follow the Leader tool, the
shape of the selection does not change. The entire shape follows the path at the same time as one entity.
This is especially useful for pulling a single performer out of a group for solo’s and creating a path for that
performer to take.

To establish the counts where the track transition is to begin and end in the drill, set the Red Anchor on the
Count Track to the count where the track is to end. This is typically the count of the set you are currently
working on. Set the Yellow Anchor to the count where the track is to begin. This is typically the previous
set.

After selecting the shape(s) you want to track, clicking on the Track tool will display the Track Tool Control
Panel.

A red dot will appear on one of the performers of the selection. Much like the Follow the Leader tool, this dot
indicates the highlighted performer is the “leader”. Clicking anywhere on the field will start a path from the
highlighted performer to that location. An editing handle will be placed at the location of the click.

Continuing to click on the field will extend the path of the selected group to the location of each click. A new
editing handle will be added at each location clicked.
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Clicking on an editing handle while holding down the [SHIFT] key will remove the handle from the path.
Likewise, clicking along the path between two handles while holding the [SHIFT] key will insert a handle into
the path.

The Delete Last button shortens the path by removing the last editing handle of the path. This is useful
when you inadvertently add an editing handle to the end of the path.

The Fewer button cuts the number of handles on the path in half. Each time Fewer is clicked the number if
handles is reduced.

Show Symbols will display the position symbols instead of a plain dot.

Reset to Hold resets the transition to a “hold” from the secondary count.

Revert resets the handles to their initial position.

At any time the Animation Controls can be used to preview the change in the drill. Other useful options that
can be accessed during the change are located in the upper right corner of the Field Display Window. These
functions control the field display appearance such as moving or zooming the field, showing/hiding the text
boxes, and showing/hiding the performer labels.

Accept commits the change to the drill. Clicking on any tool without clicking Accept will cancel the change.
The change can also be cancelled by moving an anchor on the Count Track.

Stagger Tool
The Stagger tool is an editing tool that allows peformers to both take off and arrive at independent times
during the course of a transition.

The Stagger tool is a unique editing tool, in that you must have performers selected and a transition already
written for the Stagger tool to be enabled on the Tool Palette.
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Using the Stagger Tool

Once you have selected performers on the field whose transition you wish to stagger, open the Stagger
tool. One performer will have a larger editing handle than the rest; this indicates the first performer to lead
the transition. The leader of the transition can be changed by clicking on the new leader. Performers will
follow suit based on grouping order.

Unlike other editing tools, clicking and dragging an editing handle will not adjust the form. These handles
strictly define who is selected (as well as who is the leader of the transition).

In the Stagger tool control panel, specify if the performers will take a step off, drop off, or how long they
should take to get from their current position to the new position.

Stagger Tool Control Panel Options

Step Off defines the duration each performer waits prior to stepping off after the performer before them
begins their transition.

Drop Off defines the duration each performer waits prior to ending their transition after the performer before
them arrives at their destination.

Duration defines the number of counts each performer will take in order to complete their transition.

Multi-segment mirrors the staggered transition when multiple groups are selected.

Compound Move combines two maneuvers, such as a float & stagger, in to one transition. If the Compound
Move option is not selected, the Stagger tool will overwrite the existing transition with a straight line path
staggered transition.

Reset to Hold resets the form to its shape at the Secondary count (yellow anchor) creating a hold.

Revert removes the stagger.
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<div class="player-unavailable"><h1 class="message">An error occurred.</h1><div class="submessage">Unable to execute
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Performer Labeling & Special Markings
This section covers the “Special Tools” in the Tool Palette. These tools are:

Performer Labeling for entering the identifying attributes of performers such as their symbol, color, label
(usually a number), and label position.

Text Boxes for placing text directly on a chart (usually for instruction).

Arrow indicators for clarifying direction of movement in a drill.

Props for placing props on the field.

Click on the arrow next to Performer Labeling & Special Markings in the Table of Contents to the left to
expand this section and begin.

Performer Labeling Tool
The Performer Labeling tool is used to change a performer’s identifying attributes. A performer’s attributes
consist of the performer label (usually a number), label placement at a count, symbol and color used at a
count, and performer name.

Some performer attributes do not change throughout the drill. Unchanging attributes consist of a performer’s
label and name.

Other performer’s attributes can change at any count within a drill. Changing attributes are a performer’s
label placement, performer’s color and symbol. A performer’s color and symbol are usually not changed
within a drill. However, a possible use for changing the symbol is to indicate an equipment change. A
possible use for changing the color is to indicate a costume change.

The display of a performer’s label can be turned on and off by the Hide/Show Labeling Switch located in
the upper right corner of the Field Display window. When the Show/Hide Labeling Switch is on
(depressed), the labels on the count displayed will be shown. A performer will not have a label until a label
is assigned to that performer via the Performer Labeling tool. When the performer does not have a label,
the Show/Hide Labeling Switch will not change anything whether it is on or off. It is not necessary to turn
the Show/Hide Labeling Switch on when using Performer Labeling tool. Labels (if any) are always shown
while the Labeling tool is active.

Once performers are selected, clicking on the Performer Labeling tool on the Tool Palette will display the
Performer Labeling Control Panel.
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A red bubble will appear on top of one of the selected performers. Entering a value in the Label box
changes the label of the performer marked with the red bubble. If the label value ends in a numeric value,
the [ + ] [ – ] buttons will be active. Clicking on the [ + ] button will change all of the remaining selected
performers with an increasing value starting with the number entered in the Label box. For example, “T1”
will generate T2, T3, T4… Likewise, clicking on the [ – ] button changes all of the remaining selected
performers with a decreasing value from the number entered.

Entering text in the Name box changes the name of the performer marked with the red bubble.

Labels can be displayed on two separate lines. To have labels display on two lines, enter
the Performer label in a “Line 1|Line 2” format.*
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Clicking on the Position compass will change the position of the labels relative to the location of the symbol
assigned to each performer.

Contour A will move the labels on each selected performer to a position perpendicular to the contour of the
shape.

Contour B does the same as Contour A except the position are on the opposite side of the shape.
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Alternate follows the contour of the shape but alternates each label position to each side of the shape.

The default performer label position can be set. Select Document Options from the File menu. In the
Preferences tab find the option Default label position. Choose one of the positions in the list. All new
transitions will initially set the label position to the default label position.

Clicking the Further button will increase the distance of the label from the shape. Likewise, the Closer
button decreases the distance.

Stagger Labels will alternate the distance between adjacent labels.
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Reset will revert any changes made to label position and distance prior to pressing accept.

Same as Secondary will copy the label positioning from the secondary (yellow) anchor’s count.

Entering a character such as “X” in the Symbol box will change the symbol of the performer marked with the
red bubble. The Repeat Symbol button will repeat the symbol entered throughout the selection. Typing a
sequence such as “ABC” will change the symbols in sequence. The performer marked with a red bubble will
be an A. The next performer B, then C. The sequence will repeat through the remaining performers.

Choosing a color from the Color button will change the color of the performer marked with the red bubble.
The Repeat Color button will repeat the color throughout the selection.

The symbol and color changes can be applied to all counts of the drill, or the changes can be applied only to
the counts between your Yellow and Red Anchors on the Count Track. This is dependent on your selection
between the two radio buttons: These changes apply to all counts or These changes apply to counts
XX through XX.

Previous and Next will move the red bubble to the previous and next performer of the selected performers,
respectively. Your [UP/DOWN] arrow keys on the keyboard will do the same.

Accept will commit the changes into the drill. Clicking on any tool without clicking Accept will cancel the
labeling changes. The changes can also be cancelled by moving an anchor on the Count Track.

Text Tool
The Text tool is used to enter boxes of text directly onto a count of drill. Text boxes are typically used for
instructions for the performers, or notes for certain sets.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 211 of 407



Clicking on the Text tool will display the Text Tool Control Panel.

All existing text boxes (if any) will appear on the screen with editing handles in the upper left and lower
right corner of each box.

Creating and Editing Text Boxes

Clicking on the field and not on any existing text box will create a NEW text box. The location of the first
click will become the upper left corner of the new text box. Move the mouse to a location for the lower right
corner of the new text box, then click to generate the box. In order to type inside the box, click in the middle
of the text box to place a cursor in the context area for typing.

Clicking and dragging on the editing handle located in the upper left corner of a text box will move the text
box. Clicking and dragging on the editing handle in the lower right corner of a text box will resize the text
box.

Clicking in the middle of an existing text box will select the text box and place a cursor in the boxes’ content
area for typing. A text box is selected if the frame around the box is red. After a text box is selected,
changes made in the Text Box Control Panel will only affect the selected text box, leaving all other text
boxes (if any) untouched. If no text box is selected, changes in the options of the Text Box Control Panel
will have no affect on any existing text box, however, any new text box created will have to be created with
the current control panel options.

Contents of a text box can be copied and pasted.
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The Bigger and Smaller options under Font Size will increase or decrease the size of the font used within
the selected text box.

Framed option will draw a frame around the selected text box.

Transparent will make the text box transparent. When transparent, the field grid along with any performers
will show through the text box.

Serif option will change the font to a Serif styled font as opposed to the default setting of a San Serif style.

Delete will delete the selected text box. If no text box is selected, Delete will do nothing.

Current Date/Time will add a timestamp with the current date and time at the time of the button press. This
is a helpful feature to aid in keeping track of any revisions that you make on sets. If a date and time is
already displayed in a text box, pressing the Current Date/Time button will replace the older date with the
current date and time.

Lists of pre-designed text boxes with text can be created and used through the Templates menu located in
the Text Tool Control Panel.

Text Box Templates

This feature is available on Interactive and Professional editions only.

When a Text Box is selected, you may choose to quickly import a note from the Production Sheet by
choosing one of the five Notes buttons. This will import the note from your current set in the Production
Sheet to your text box.

To use a template, select the template from the Templates menu and click Use. Initially there are only a few
preset templates in the list.

Adding a template to the list is accomplished by creating a new text box, then selecting “Edit List…* from
the Templates list to display the Text Template List Editor.

Be sure to set the exact size and location of your text box prior to creating the template.*
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Within the Text Template List Editor, clicking Add will add your new text box to the list. Selecting Replace
will replace the selected template in the list with the selected text box on the chart. Similarly, clicking Delete
will delete the selected the template from the list.

Selecting any of the Production Sheet Inserts will quickly develop a Text Box Template that you may
save and use throughout your design process.

Accept button accepts the text changes into the drill. Clicking on any tool without clicking Accept will cancel
the change. The change can also be cancelled by moving an anchor on the Count Track.

Adding and Removing Text Box Templates Across All Drill Pages

Text Box templates can be quickly added or removed from all pages (sets) of a drill. See the FAQ page for
steps on how to do this.

You can click in the Preview/Edit window and type text to be displayed as well. For
example, just pressing the Page (Set) Number button will only display that number in the
text box. If you type in “Page: “ in the Preview/Edit window prior to pressing the Page (Set)
Number, the text box will then read “Page: 3” as opposed to just “3”.

*
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Arrow Tool
The Arrow tool adds arrow indicators to a chart. Arrows are typically used to indicate direction of movement
within a transition. Arrows can also be used to identify distances between two points.

Select the Arrow Labeling tool in the Tool Palette and the Arrow Labeling Control Panel will display.

Any existing arrows will appear on the screen with editing handles at each end. Curved arrows will have an
additional editing handle in the middle.

Clicking on an arrow’s editing handle will select the arrow. A selected arrow is drawn in red. Dragging an
editing handle will reposition the selected arrow.
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If no arrows are on the field, clicking on a location on the field will start the creation of an arrow.

If arrows already exist in the filed, click New Arrow to start the creation of a new arrow, then click the
endpoints of the new arrow on the field to apply the arrow.

The type of arrow used is defined by the current settings in the Arrow Labeling Control Panel. There are
two types of arrows: Straight and Multi-Point.

Arrow Types

Straight Arrow is an arrow formed by a straight line. Two clicks on the field will apply a straight arrow, with
endpoints at each click.

Center Point arrow is an arrow that represents the radius of a circle or arc. The first click will be the center
point and the second click will be the circumference. After the arrow is entered, the settings for the new
arrow can be changed.

Multi-Point Will create a continuous arrow with each mouse click on the field. Multi-point arrows can be
straight or curved, depending on your selection in the Arrow Tool Control Panel.

Arrow Styles

Arrow Heads can be added to either end of the arrow using the Arrow Head options. The length of the
arrow can be placed on the arrow using the Show Length option.

Show Direction adds an arrow head at each editing handle on the arrow, pointing in the direction of
movement of the arrow.

Show Length displays the length of the arrow.

Line Color brings up a color picker so you can colorize the arrow to your liking.

Fill Shape will fill the shape the arrow outlines with whatever color you pick from the color picker.

Creating Arrows with Drawing Tools

If you need to show a specific direction of movement or highlight a certain part of the performance area, it
may be easier to create the arrow/filled shape with one of the Drawing tools.

To do so, select the appropriate drawing tool from the Create from Draw Tool menu in the Arrow Tool
Control Panel. This will open the selected tool’s control panel. Draw the shape as you typically would,

Transparency can be adjusted for filled color by adjusting either the “Transparency” or
“Alpha” sliders, depending on which color tab you’re on in the Color Picker.*
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depending on your selected tool. Once you press accept in the Draw tool, you’ll be taken back immediately
to the Arrow tool, where you can make any revisions necessary.

Delete Handle will remove the last editing handle added to your selected arrow.

Delete Arrow button will delete the currently selected arrow. The currently selected arrow is the arrow
drawn in red. To select a different handle, click on one of its editing handles.

Accept will commit the arrow to the drill. Clicking on any tool without clicking Accept will cancel the change.
The changes can also be cancelled by moving an anchor on the Count Track.

Prop Tool
A Prop is an image of an inanimate object such as a stage, wall, pillar, fence, etc. Any .jpg, .gif, or .png file
can be used as the prop. All props are entered at count 0 of the drill. Props can be move around the field
independently or be moved by a performer.

Before entering a prop, place both Red and Yellow Anchors on the Count Track to count 0 of the drill. This
enables the Prop tool. Props are always added at count 0.

Clicking on the Prop tool will display the Prop Tool Control Panel.
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Clicking on top of an existing prop will select the prop for editing. A prop is selected when it is outlined in
red.

Clicking a location anywhere else on the field will start the creation of a NEW prop. The first click will be the
location of the upper left corner of the prop. Move the cursor to the location for the lower right corner of the
prop and click. A red box will indicate the location entered.

Editing handles will appear on a selected prop. Dragging the handle in the upper left corner will move the
location of the prop. Dragging the handle in the lower right corner will change the size of the prop.

Choose a Prop Image in the Prop Tool Control Panel will display a file dialog for finding an existing image
to assign to the prop.

Prop Shape will assign an existing shape to the prop on the field. these range from flat panels and polygons
to pit (front ensemble) setups.
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Prop is carried by a performer will cause the prop to move with the movement of a selected performer. To
select the performer to be the prop carrier, drag the upper left corner of the prop directly on top of an
existing performer. A red “bulls eye” will appear on top of the performer to indicate the performer will carry
the prop throughout the drill. The carrier can be any performer in the drill, whether they are a wind/guard/
drum line member, or just a performer who’s sole purpose to move the prop. Selecting the performer and
editing its movement throughout the drill will cause the prop to move as well.

To rotate a prop, select the prop and adjust the Reposition Handle. Alternatively, you can enter a value in
the “Rotation” box in the control panel. Positive numbers will rotate the prop clockwise, and negative
numbers will rotate the prop counter clockwise.

The height of the prop can be entered by entering a number in the Height box. The height is in yards or
meters.

To delete a prop, set your anchors on the Count Track to count zero. Open the Prop tool and select the prop
by clicking on it. In the Props Tool Control Panel, press Delete, then Accept to accept the change.

Should you transfer the drill file to another computer, you will need to also transfer the prop images used in
your drill. You can save a 3D Drill file as a 3D Package that will include all props used with the drill into one
file. When saving, the package option Include Props must be set. To change the format of an existing drill
file to a 3D Package, choose Save As from the File menu.

For entering and editing props as performers, see the Performer Prop page.*
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Printing
The Printing section covers the various ways to printout your drills.

Click on the arrow next to Printing in the Table of Contents to the left to expand this section and begin.

Print
Selecting Print from the File menu will open the Print dialog. Here you’ll have settings and options to print
multiple jobs at once, such as printing a cover sheet, charts, and coordinates.

The settings found in this window are no different than those that you would find when you choose to print a
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single job from the File menu.

To print multiple jobs at once, check the “Print” option for each job’s section in this window. In the above
example, coordinate sheets and drill charts are selected to print.

Printing Charts
Any count of a drill can be printed in 3D. Most users, however, only want printouts at set points.

Charts can be printed by count number or set number. Sets are determined by the location of Page Tabs on
the Count Track. Prior to printing, you may want to add or remove certain page tabs from the Count Track
so the sets will print out according to your preference.

Selecting Print Charts from the File will display the following screen:

Print Selection options are used to determine which counts of a drill are printed.

From Page Tab will print the selected page tabs in the Print Charts dialog.

Currently Displayed Count will print the current count displayed. The displayed count is determined by the
location of the Red Anchor.

Thumbnails per page will print small grids to fill the page. Ideal settings for dotbooks are 8 thumbnails per
page in portrait orientation, or 4 thumbnails per page in landscape orientation.
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Instructions

Title Font changes the size of the Drill Title and Author Information.

Set Info Size changes the size of the Set #, Transition Counts, Measures and Set Title on each drill chart
print out.

Transition Counts prints the counts for that particular set at the bottom of the chart.

Merge Subset Counts When this option is selected, subsets that are NOT set to print will have their count
range merged with the count range of that transition.

Measures when selected will print the Measures (from the Production Sheet) at the bottom of the chart.

Audio Sync Time will include the audio sync time with the set information at the bottom of each chart.

Set Title will print the Set Title (from the Production Sheet) at the bottom of each chart.

Print Date & Time will print the date and time on the chart printout.

Production Sheet Note will print information from the Production Sheet Notes columns at the bottom of the
chart printout, below the field. Check the corresponding box for each Production Sheet Note column you
wish to be printed.

Chart

All performers black is useful when it is important to make clear black and white reproductions of the
printout. On color printers, this option may be useful because the color symbols will not copy as clear when
in color. On black and white printers, this option is helpful as colored symbols will be printed in a shade of
gray, and will not copy as clearly as if they were black. If you plan on reproducing the printouts, we suggest
using the “all performers black” option.

All performers as dots converts all symbols from the drill to dots on the chart printouts.

Performer label determines whether a label is printed (usually a number) beside each performer’s symbol.
Normally, if labels were entered with the Performer Labeling tool, this option is checked.

Mark center of performer locations will place a dot in the center of the positions where the performer will
be standing.

Facing will indicate which way the performers face for each symbol on the field.

Grouping prints the matching lines between performers. You can specify the color by clicking on the color
picker, then assigning the color of your choice.
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Zoom chart for largest printout will print zoomed in charts. The printout will be zoomed in as much as
possible while still keeping all performers in the viewable area. When selecting this preference, options will
display for determining which charted items are visible in the printout when zoomed.

Grid Layout Menu You can quickly change the grid layout by selecting a different option in this menu. This
is helpful if you have different grids for designing and printing.

Prop images enables props to be printed. If this option is unchecked, the bounding area for the prop will
print.

Floor Cover enables a floor cover to be printed. Uncheck to hide the floor cover during printing.

Thicker yard lines will thicken the yard lines.

Thicker grid lines will thicken the grid lines when printed.

Performer viewpoint (reverse view) will print the charts from the performer’s perspective.

Force Textbox Font Size will force the text box font to print at the size that you specify in this option.

Textboxes, when selected, will print text boxes and arrow indicators on the drill chart printouts.

Overlay Set

Overlay Set has two options: Use Previous and Use Next. If a chart selection includes an overlay, Use
Previous will print the previous set as a background chart. Likewise, Use Next will print the next set as a
background chart.

Starting Set # will change the starting set number. For example, if the first drill ends with page tab 23, the
continuation file can begin with page 24.

Shortcuts Menus

The Print shortcut menu will remove or add all of the checks from the selection boxes in the print column.
Charts will only print if they have a check in the selection box of the Print column.

Overlay will remove or add all of the checks from the selection boxes in the Include Overlay column.
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Paths menu will select all, none, or mid-point options to print paths.

Options of the Print Charts Table

Sets and SubSets are derived from the Page Tabs on the Count Track. A chart should typically be printed
at each page tab, and each page tab is a set. However, it is sometimes useful to create a page tab at a
location where you don’t necessarily need a printed chart. These page tabs are known as sub-sets. Sub-
sets do not advance the total number of pages. For example, if we had two sub-sets between pages 2 and
3, the numbering sequence would be 1, 2, 2A, 2B, 3, 4, etc.

The Print column in the table enables/disables the printing of selected sets.

Overlay enables/disables printing of a background chart for selected sets.

Paths can be set to none for no paths printed, all paths for a dot per step for every performer, or path
midpoint for a single dot for each performer marking the midway point to the next set.

The Title column in the table can be used to enter a title for the set to be printed along the top of the printed
chart.

Close will exit the Print Charts window.

Save as Default will save the settings you set for options in Print Preferences as default values. Print
Selection will not be saved.

Save as PDF will save the selected charts as a PDF document instead of printing a physical copy. Note that
PDF printouts created this way are intentionally set to a high resolution. This may dramatically increase the
file size of the PDF document.

Print/Preview opens the print preview and page setup dialog.

Print will send the job to the printer.
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Previous Page will move to the previous preview page of the print job.

Next Page will move to the next preview page of the print job.

Page Setup opens the printer’s page setup dialog.

Done closes the print preview and returns to the Print Charts dialog.

Printing Coordinates
Coordinates for any count of a drill can be printed, however you’ll typically only want to print coordinates for
set points in the drill. 3D uses page tabs on the Count Track to determine the sets in a drill. Prior to
printing, you may want to add or remove certain page tabs from the Count Track so the sets will print out
according to your preference. It is useful to use sub-sets on the Count Track to indicate sets that are used
for design purposes but not to print.

Selecting Print Coordinates from the File menu will display the Print Coordinates dialog.
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Report Type

Print Performer’s Coordinate Sheet is a list of coordinates for a performer. The coordinate list contains a
coordinate for each page tab (set) in a drill.

• Combine coordinates of all drills in this production into one list is available when printing
coordinates from a Production file.

• List Size is the size of the printout. This is useful for performers who want lists to be printed in a
convenient size for fitting on index cards, or small pocket size for a wallet.

Print Director Coordinate Sheet is a list of all performers. The list contains a coordinate for each
performer at a page tab. A Director Coordinate Sheet can be printed for each page tab in the drill by
selecting the Include coordinates for all sets option.

Sort Performers

The options found under Sort Performers will sort the coordinate list by the option you specify.

Preferences

Coordinates can be printed at four different step resolutions: Whole step, half step, quarter step, and
eighth step.

Starting Set # will change the first page tab to the value entered. All page tabs will be effected by this
change.

Print coordinates for only selected charts when this option is selected, coordinates will print for any
selected chart in the Print Charts dialog.

Print date and time of printout will print a time stamp on the coordinate printout.
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Print only selected positions is useful for reprinting a single performer or a group of performers. Select
the performer(s) with a Selection tool before selecting Print Coordinates from the File menu. Then check
the Print only selected positions option.

Print Set Numbers displays a column of each set number for every set.

Print Measures will add a measures column on the coordinate print out.

Grid Layout Menu will allow you to quickly switch to a different grid for referencing yardlines and hashes.

Don’t print sub-sets will not print sub-sets when selected.

Print Performer ID will print the unique ID number that 3D has assigned to that performer. This number is
different from their symbol and label.

Print Set Title will print a set title (if any) for the set on the coordinate printout.

Print Transition Counts adds a column for the counts from set to set.

Grid Terminology

Setting up the Grid Terminology to match the terms commonly used by your ensemble will make the
coordinates easier to understand by the performers. For example, on a football field grid the Left Side of the
grid (the left endzone) may be referred to as Side 1 or Side A rather than the default term Left.

The use custom terms for steps, yard lines, and sidelines option is useful when writing for indoor
ensembles that do not have yard lines and markers to reference.

Save as Default saves the settings of the Grid Terminology and Preferences as default values.

Save as PDF will save the coordinates as PDF documents instead of printing a physical copy.

Print/Preview opens the print preview and page setup dialog.
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Print will send the job to the printer.

Previous Page will move to the previous preview page of the print job.

Next Page will move to the next preview page of the print job.
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Page Setup opens the printer’s page setup dialog.

Done closes the print preview and returns to the print coordinates dialog.

Printing a Cast Sheet
Whether you have a large band or a small band the cast sheet is a very useful tool. The cast sheet will
display and print all symbols, labels, and names of the performers in the drill.

When you select Print Cast Sheet from the File the Cast List Editor will display.
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Print Sort order will sort the names in the cast sheet according to one of the following options: by “Symbol,
Label, Name”, by order entered, by “Name, Symbol, Label”, or by “Label, Symbol Name”.

The name is entered using the Label tool or can be entered directly from this dialog, the Cast List Editor.

The Notes column is a space on the printout for taking notes of performers during rehearsals.

Print all symbols black will print all symbols in the Cast Sheet black instead of the color defined in the
label function.
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Show unlabeled cast members shows all performers (even the performers with no label) on the Cast List
Editor window and in the printout. Hiding unlabeled performers from a printout is useful if you entered some
performers as markers on the field and not actually performers.

Save as Default saves the settings of the Sort order.

Print/Preview will open the page setup display then render and display a preview of the Cast Sheet report
according to the settings of the print cast sheet manager.
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Print will send the job to the printer.

Previous Page will move to the preview preview page of the print job.

Next Page will move to the next preview page of the print job.

Page Setup opens the printer’s page setup dialog.

Import Cast List Information

Cast list names and labels can be imported from one drill to another. This is very handy when you add cast
list information such as cast member names or labels to a drill after you have finished it. This is often done if
you have purchased a custom or pre-written drill. You’ll typically want to import into your drill the cast
information of the previous drill of the show you are writing. The set at the first count of the drill you are
editing is typically the same as the set at the last count of the drill you are importing from. Import will find the
counts with matching formations in both drills, look up the name and/or label of each performer and then set
that name and/or label in the drill you are editing.

Select Print Cast List from the File or Cast List Editor from the Utilities.

Click Import Names & Labels located in the lower left corner of the editor and the following dialog will
display:

Click Browse and find the drill whose cast list information you want to import into this drill.
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Select the Cast Member cross reference method

• Method 1: Order entered. Once you have finished a drill file, if you start another drill file using the
“this drill is a continuation of the drill…” option then both drills will have performers entered in the
same order. However, should you add new performers later, then the order may no longer be the
same (at least for the newly added performers) and the second cross reference method may give you
better results.

• Method 2: Matching Set. This scans both drill files and looks for a set whose formations are exactly
the same in both. Then it copies the cast information from one to the other.

Choose what information you want to import. The information can be cast list name and label. It is important
to remember that the name and/or labels of performers that are found in both drills will be overwritten in the
drill you have opened.

Click Import to begin the search and copy the cast information into your drill.

When you click Done in the Cast List Editor, you will be asked if you want to save the changes. If you do not
want the changes saved, you can click “No” here and nothing will be saved from the import.

Printing a Cover Sheet
The Print Cover Sheet function will print a cover sheet for the drill. When you choose Print Cover Sheet
from the File the Print Cover Sheet dialog will display.

Edit Drill Title will open the Document Options to the Preferences tab so that the title may be changed.

Edit Author Info will open the Document Options to the Properties tab so that the Author Info may be
changed.

Import 1st page of Notes and Import 2nd page of Notes will allow you to import a text file to have as
notes pages to follow the cover sheet for any additional instructions.

Close will close the Print Cover Sheet Manager dialog and return to the design grid.

Print/Preview will open the page setup display with a preview of the Cover Sheet report according to the
settings of the Print Cover Sheet dialog. You can Print from the Print/Preview dialog.
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Printing Instructions
The Instruction Report has two options to print:

• The Director’s Report, which will print a list of transitional maneuvers performed by grouped forms
throughout the drill, or

• The Performer’s Report, which will print a list of specific instructions for both transitional and visual
maneuvers for each individual performer.

Both reports are generated from the Command Editor data. To edit group names or transition descriptions,
you would need to open the Command Editor.

Both the Director’s and Performer’s reports can be saved as PDF files by clicking Save as PDF.

Director’s Report
The Director’s Report prints a list of transitional maneuvers performed by grouped forms throughout the
drill. This report is intended to be a general overview of commands for the ensemble. Specific details (such
as movement, visual, equipment, and uniform changes) for each performer can be viewed by printing a
Performer Report.

Both Director’s and Performer’s reports are generated from the Command Editor data. To edit group names
or transition descriptions, you would need to open the Command Editor.

When you select Print Instructions from the File menu, the following window will appear:
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Each Set (or page tab) in the drill is displayed, along with a Group Name and a brief Transition
Description for the group.

Expand rows to fit will expand any row with too much data to print in a single line.

From this window, you can either create a PDF of the Director Report by selecting Save as PDF, or print a
hard copy by selecting Print/Preview.

Performer’s Report
The Performer’s Report prints a list of specific instructions (such as movement, visual, equipment, and
uniform changes) each individual performer in the drill. This report is intended to be specific instructions for
each performer in the ensemble. A more generalized report for the full ensemble can be viewed by printing

No titles in the Group Name column? See the Command Editor page for an explanation as
to why that happens, and how to easily fix it.*
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a Director Report.

Both Director’s and Performer’s reports are generated from the Command Editor data. To edit group names
or transition descriptions, you would need to open the Command Editor.

When you select Print Instructions from the File menu, the following window will appear:

Click on the Performer’s Report button to view the Performer Report data.

The Performer’s ID (Name, Symbol, Label from the Cast List) for the performer you’re currently viewing is
displayed at the top of the window.

Each Set (or page tab) in the drill is displayed, along with a Group Name and a brief Transition
Description for the group.

Visual Description information is generated from the Visuals Editor.

No titles in the Group Name column? See the Command Editor page for an explanation as
to why that happens, and how to easily fix it.*
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Expand rows to fit will expand any row with too much data to print in a single line.

Previous and Next buttons cycle through the reports of each performer in the drill.

The option to print either all performer reports or only reports for selected performers is found under the
Performer Report button. When Selected Performers is chosen, reports will only print for performers that
have been selected on the design grid prior to opening the Print Instruction option.

You can sort the Performer Reports by Original Entry Order, Label and Symbol, Name, or by Symbol
and Label.

From this window, you can either create a PDF of the Director Report by selecting Save as PDF, or print a
hard copy by selecting Print/Preview.

Printing QR Codes
QR Codes are a simple way to share the links to mobile app files (drills and surfaces) that are being stored
through various cloud storage applications. Since tablets and phones have the ability to easily scan a QR
code through a camera, this is often one of the quickest ways to distribute your mobile application drill and
surface files.

Printing a QR Code
To print a QR code, go to File and choose Print QR Code. The QR Code Printer window will appear.

You’ll need to enter 2 pieces of information in order to create a QR code for a drill: the Drill Title and the
Drill URL.

The Drill Title can be anything you wish to call the file; it does not have to be the exact file name. This is
generated purely for naming the QR code. When viewing a drill in the mobile app, the drill’s Title from
Document Options will display.
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The Drill URL is the download link (not to be confused with the share/view link that many cloud storage
services provide) for the mobile file that has already been saved to a cloud storage service.

Click Print/Preview to preview and print the QR code(s). Save as PDF will create a PDF file for your QR
code(s).

Surfaces
Similar to drill files, custom surface files can be shared via QR codes. Type in the Surface Title (again, this
does not have to match the file name) and download URL for the surface file.

Once complete, click Print/Preview to preview and print the QR code(s). Save as PDF will create a PDF file
for your QR code(s).

Be sure that you enter the URL to download the drill file, not the URL to share the file. For
example, if you upload a file to Dropbox, then “share” the file (or copy the link’s location),
when you paste the URL it will read http://www.dropbox.com/….. This link will not work.
However, if you change the WWW in the URL to DL, so it reads http://dl.dropbox.com/…,
that will initiate a download of the file, which is what is required by the mobile app. See
Viewing Drills on iOS for further explanation.

*
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Utilities
The Utilities menu contains many functions for editing the contents of a drill file. These range from a
powerful Drill Rewrite tool, utilities for altering the appearance and dimensions of your design grid, as well
as adding or removing the number of counts in a drill or transition.

Click on the arrow next to Utilities in the Table of Contents to the left to expand this section and begin.

Create Movie
Click here for an in depth guide on how to create a movie of your drill’s animation.

Drill Rewrite
The Drill Rewrite tool is an editor which can add or remove performers from an entire drill file. Depending
on the situation, you might prefer to adjust the interval for the addition or subtraction of performers in the
drill file, or simply leave a hole (when removing performers). This is especially useful for blocks and filled
shapes. The Drill Rewrite editor can adjust intervals or leave holes, depending on your choice. This
powerful editor can also adjust the transitions of the shapes.

When the Drill Rewrite adds or removes a performer, it looks at each shape where the performer is
involved throughout the drill. If intervals for those shapes need to be adjusted to accommodate the removed
performer, only the shapes where the performer resides will be changed. This section will cover how to
ensure only the necessary shapes are changed when intervals change.

For example, you may find that combining two or more shapes into one larger shape may make more sense
when the Drill Rewrite starts adjusting the shape intervals. Imagine at set #3, two arcs are drawn end to
end to make an S shape, and a performer we plan on removing is part of one of the arcs. If we choose to
adjust the intervals to accommodate the removed performer, the arc where the performer resides will be
adjusted, but the other arc intervals will remain unchanged. We might have preferred that the intervals
would adjust across the entire S shape. To make this happen, we would need to glue the two arcs into a
single S shape before using the Drill Rewrite. Now when the Drill Rewrite look to see which shape is
involved at set #3, it will find an S shape instead of two independent arcs.

You may sometimes find that cutting a shape into a smaller segment may make more sense when the Drill
Rewrite starts adjusting the intervals of the shape. Having your drum line (which often uses mixed intervals)
connected as part of a larger form would be a prime example. Since the drum line uses a mixed interval, if
you altered the intervals of the larger form via the Drill Rewrite, you would overwrite the mixed intervals of
the drum line, with the results being nothing short of catastrophic. To accommodate for this, prior to using
the Drill Rewrite, we would want to visit the set at which the drum line is connected to a larger form, and
knife the drum line from the rest of the form. This will allow the larger form to adjust the interval in the Drill
Rewrite without changing the mixed interval the drum line is set in.
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Evaluate the Drill

To check and see if shapes need to be combined from another shape or cut out of a shape, do the
following:

• Click on the first page tab and select Select All from the Edit menu.

• Evaluate how shapes are grouped, especially the shapes that you expect to be involved in interval
adjustments during a drill rewrite. The shape will be involved when one or more performers within the
shape are to be removed or added. For example, if a performer of this square is to be removed, then
the intervals of the entire box will be adjusted because the performer resides in the box shape.

• If regrouping appears to be needed, select which shape needs to be regrouped. Select either the
Knife or Glue tool and make the necessary adjustments to the grouping of the involved shape(s). In
this example, we want the performer to reside in only one side of the box and not the whole box. This
is done by cutting the box into four lines.

• Repeat these steps at each page tab in the drill.

Removing a Performer

The Remove Performer option will delete a position from the entire drill. You can specify whether the shape
should have an adjusted interval once the performer is removed, or leave a hole.
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• Select Drill Rewrite from the Utilities menu and the Drill Rewrite Control Panel will appear. The
Drill Rewrite will only edit a drill file that has first been saved. You may be asked to save before
continuing.

• Click on the performer(s) you wish to remove from the drill.

Stop at each page tab will display each count that has a page tab and highlight the performer to be
removed. You will decide how the shape is to handle the removal of the selected performer. For example, if
the shape is part of a filled block of horizontal and vertical lines, it may be preferred to leave a hole in the
shape rather than to adjust its intervals.

Equalize Intervals adjusts the intervals of each shape that the removed performer(s) occupies.

Leave a hole throughout the drill leaves a hole in each shape that the removed performer occupies.

• Click Continue and the Rewrite Control Panel will display. A red X will appear on top of each
performer that is about to be removed. The Rewrite Control Panel will display the counts that are
about to be involved. Depending on the options set, one or more of the following buttons are
available:

Equalize will equalize the intervals of the shapes involved during the count range shown in the control
panel.
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Leave a Hole will keep a hole in the shapes involved during the count range shown in the control panel.

Undo Last Set backs up the previous count range rewritten.

Cancel reverts to a saved version of the drill.

Adding a Performer

This function will add a performer to an entire drill and resize shape intervals. While the Drill Rewrite
function is an extremely powerful tool, it cannot do everything (yet). In this case, when using the Drill
Rewrite, a performer can only be added between two performers that remain adjacent throughout the entire
drill.

• Select Drill Rewrite from the Utilities menu and the Drill Rewrite Control Panel will appear. The
Drill Rewrite will only edit a drill file that has first been saved. You may be asked to save before
continuing.

• Click the Insert Performers tab.

• Click on the performer adjacent to the location where you want a performer to be added. The
performer you selected and the adjacent neighbor will be highlighted. If the selected performer and
their neighbor do not highlight, this means these performers do not remain adjacent to each other
throughout the drill. You must select a different pair of performers to use with the Drill Rewrite
function.

• Click Continue and the Rewrite Control Panel will display. A blue dot will appear on top of each
performer that will surround the newly added performer.

Equalize will equalize the shapes within the drill.

Performers that do NOT remain adjacent to each other throughout the drill will have a large
red “X” on top of their symbol. These performers cannot be selected to insert a performer
between them.
*
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Cancel will revert to the last saved version of the drill.

Shift All Performers
Shift All Performers is a function found in the Utilities menu that will adjust all performers in a certain
direction (that you specify) for the entirety of the drill. This is helpful if the show was written too far from the
front side line and needs to be adjusted forward without rewriting each set.

To shift all performers in a drill, go to the Utilities menu and click on Shift All Performers. The Shift All
Performers control panel will appear.

Every performer will have an editing handle on top of them. This means you can click and drag anyone on
the field, and the entire form will move. Alternatively, you could enter the distance you wish to shift in the
Distance box in the tool’s control panel, then click on the directional compass to move them to the correct
location on the field.

For more discussion on adding performers via the Drill Rewrite, visit the following Quick
Start page: Adding Performers via the Drill Rewrite.*
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Count Editor
The Count Editor is an editor which is used to insert or remove counts from a drill. This editor can also be
used to shorten or lengthen transitions.

Shortening or Lengthening Transitions

This function of the Count Editor is particularly useful if you need to make changes to an existing drill file.
When editing a file using the Shorten/Lengthen Transition option, 3D will automatically recalculate the
transition and steps needed to get from the beginning to the end of the transition, depending on your input in
the Count Editor. Simply put, once you specify how you would like to change the transition, 3D takes care
of the rest.

To shorten or lengthen a transition, your anchors must be spread on the Count Track. If you haven’t already,
we recommend setting page tabs to indicate where each form (or set) “hits”.

• Click on the ending page tab (where your transition “hits” the form) so your Red Anchor is on the
ending page tab, and your Yellow Anchor is on the previous set.

• In the Utilities menu, open the Count Editor. Select Shorten/Lengthen Transition.
• A new window will appear with various options on how to change the transition; by adjusting the total

transitional counts, by expanding by X counts, or by shrinking by X counts

Depending on the complexity of the maneuver, some Follow the Leader maneuvers may
need to be redone when using the Shorten/Lengthen Transition option. All other
transitions should not need any further adaptation.
*
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Let’s say we had a 16 count transition that we wish to reduce to 8 counts. For this example, you could either
choose the 1st option, to change the transition to “8” counts, or the 3rd option, to shrink the transition by “8”
counts. Either option would yield the same result.

If we decided we needed to lengthen our 16 count transition by 8 counts, we could either choose the 1st
option and change the transition to “24” counts, or the 2nd option (expand by “8” counts).

Add or Remove Counts in a Drill

The Add/Remove Counts in Drill option is most useful when you are needing to edit the total number of
counts in a drill file. By default, a 3D drill file has 300 counts in the file. If the movement of drill you’re
designing requires more counts than 300, we would need to add counts in this drill file to accommodate.

To add or remove counts in a drill file, go to the Utilities menu and choose Count Editor. Select the Add/
Remove Counts in Drill option.

A new window will appear with various options on how to add or remove counts in the drill file.

When adding (inserting) counts to a drill, you’ll have the option to either add counts after count X (which you
specify), or at the end of the file.

When removing counts from a drill, you can specify where you would like to pull the counts from.
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Cast List Editor
Whether you have a large or small ensemble, the Cast Sheet is a very useful tool. The Cast Sheet will
display and print all symbols, labels, and names of the performers in the drill.

When you select Print Cast Sheet from the File menu the Cast List Editor will display.

Print Sort order will sort the names in the Cast Sheet according to one of the following options: by Symbol,
Label, Name; by order entered; by Name, Symbol, Label; or by Label, Symbol, Name.

The Name can be entered using the Performer Labeling tool or directly in this window.

The Figurine column allows for the assignment of figurines to each performer in the Cast List. These
figurines are shown in the Classic Perspective View only.

Notes is a place on the printout for taking notes on performers.
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Print all symbols black will print all symbols in the Cast List black instead of the color defined by the Label
tool.

Show unlabeled cast members shows all performers (even the performers with no label) on the Cast List
Editor window and on the printout. Hiding unlabeled performers from a printout is useful for stationary
performers (such as the pit).

Edit Symbol Map opens the Symbol Map Editor. Here you can set default uniforms and equipment for
symbols you frequently use.

Import Cast Information allows you to import cast information from an existing drill. This includes names,
labels, and Real View visuals (or Figurine data if the Classic Perspective is enabled). Imported data will
overwrite any existing Cast List data.

Print/Preview will open the page setup display and show a preview of the Cast List report according to the
settings of the Print Cast Sheet dialog.

Save as Default saves the settings of the Sort order.

Done exits the Print Cast Sheet window.

Symbol Map Editor
The Symbol Map Editor is a huge time saver in 3D. With this tool, you can save a set of default values (such
as uniforms and instrumentation) for symbols you frequently use when designing, then apply these values
with the click of a button.
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The Keypress column shows what buttons are available for symbols. These cover the majority of keys on
your keyboard. The keypress is which key you press in the “Symbol” blank in the Performer Labeling tool
when assigning symbols to peformers.

The Symbol column shows what symbol is displayed based on the keypress you entered. Some fonts have
special characters for certain keypresses. For other fonts, the keypress and symbol might be close to
identical.

The Uniform column allows you to set which uniform you would like to be assigned for which symbol.
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Like the uniform column, the Hat column allows you set which hat you would like to be assigned for which
symbol.

The Equipment column displays what equipment or instrument the performer will carry for the assigned
symbol. For example, by default, the F symbol carries a flute.

The Figurine column is used for the Classic Perspective View.

The Uniform, Hat, Equipment and Figurine columns are all editable. You cannot edit the Keypress column
because those are the only keys available for use on your keyboard (in 3D), and you cannot edit the Symbol
column because these are bound to the keypresses.

Apply Map to Count 0 (zero) will assign equipment and uniforms from the Symbol Map to the performers in
your drill file, based on the symbols you gave performers through the Performer Labeling tool.

Save as Defaults will remember any changes you have made to the Symbol Map Editor for use in any
future file.

Revert will revert any changes made back to the last saved version of the Symbol Map.

Grid Designer
The Grid Designer is an editor which is used to create custom grid layouts. 3D can accommodate many
grids, such as soccer fields, football fields, gymnasiums for winter guard and indoor drum lines, stages, and
streets.

Custom grid layouts are stored in the Layouts folder inside the Pyware 3D user Documents folder. When a
new drill file is created, a grid layout is chosen. That layout is embedded into the drill file. If a drill file is
given to another 3D user, the recipient does not have to have a copy of the layout in order for the drill file to
be displayed correctly.

To load the Grid Designer, select Grid Designer from the Utilities menu. The current field grid will display
inside the editor.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 249 of 407



Grid Divisions

The Left-Right [ ] steps per [ ] yards options sets the underlying horizontal step grid. This also establishes
the way the Location Indicator of the Console and performer Coordinates measure locations on the field.

Top-Bottom [ ] steps per [ ] yards sets the underlying vertical step grid. These values are typically the
same as their Left-Right counterparts.

Grid Options

Style allows you to change the step division grid to either lines or dots.

Resolution changes the frequency at which you would see the step division markings between the yard
(major) lines.

Set Gridline Weight allows you to specify the exact weights of each line on your design grid. The higher the
number, the thicker the line.

Marker Options

Marker Size Enter a value to change the size of the yard line markers.

Bottom of Front/Back Marker to Sideline allows you to change the distance of the marker from the
sideline.

Measure changes the way the Location Indicator, Field Markers, and Coordinates use the yard (major)
line markers. Typically winter guard designers measure from the center yard (major) line marker outward.
Field designers follow the yard line markers on football fields and measure inward.
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Choose Marker Font opens a font picker, allowing you to switch the font type of the yard line markers.

Measure vertically from stage front: This option sets the vertical measurement of the Location Indicator
to measure incrementally from the front side line (0 steps) to the back side line (typically 84 steps). If this
option is not checked and the Measure setting is inward, the Location Indicator measurement from each
side line will start with 0 (steps) and incrementally increase until the cursor reaches the center of the field
(typically 42 steps).

Zoom buttons will either zoom into, or zoom away from the center of the grid area. These are the magnify
glass buttons above the grid.

Field Relocation buttons – clicking on the slide up button moves the grid area higher on the screen.
Conversely, the slide down button moves the grid area lower on the screen.

Division Markers are the large numbers running from one end of the field grid to the other. The numbers
are located at each major division line. They designate the number of yards across the grid. Usually, these
Division Markers are used as yard line markers on a football field, where the center marker is the 50 yard
line.

Division Markers are movable. For example, the markers displayed horizontally can be dragged vertically to
any location. With football field grids, the markers are often placed in the exact location as they appear on
the field, however it is sometimes preferable to move the markers just off of the field grid area so as to not
clutter the display or printout.

Markers can be hidden so that only certain yard line markers will be shown. To hide the Division Marker,
double click on the large oval (editing handle) that corresponds to the yard line and it’s marker you wish to
remove. Double click the large oval (editing handle again to have the yard line marker reappear.

Clicking on an Editing Handle presents the option to customize Division Markers. This is extremely helpful
when designing for indoor ensembles, as they would typically be performing on a surface without yard lines.
Coordinate printouts will reference whatever letter or number you label a yard (major) line with.

Custom Division Markers

To customize the Division Markers:

• Go to the Utilities menu and choose Grid Designer
• Click on a green edit handle for the yard (major) line you wish to label
• Type in the value for the Custom Marker (you’ll find the box towards the top of the window, just under

the Grid and Marker Options)

Field Grid Border this is the red border surrounding the grid. On a football field, the border represents the
side lines and the end zones. In the middle of each of the four border lines is a number that represents the
location of the border in relation to the center of the grid. Borders can be adjusted by clicking and dragging
on these numbers.
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Division Line, Sub-Division Line, and Hash Mark editing handles located along the bottom and right
margins can be dragged to move the lines or hash marks up and down or across the grid area. The editing
handles associated with Division Lines are the longer ovals. Editing handles associated with sub-
division lines are the smaller ovals. Editing handles associated with Hash Marks are rectangular in
shape. All the editing handles are yellow until they are moved onto the grid, at which point their color
changes to green. To add a line or hash, drag a new handle out of the handle bin into the grid area. To
remove a line or hash, drag its editing handle back into the bin area. The small numbers located along the
left and top margins of the editor indicate in yards the location of the line or hash. When creating a grid
representing a football field, it may be interesting to note that you can add as many hash marks as you
would like.

Save with Real View settings included will save any Real View data to the grid layout you edit and save.

Color Options are used to change the color of the grid elements. Clicking on Color Options will display
Grid Color choices. Within the Grid Color dialog, clicking directly on a color swatch will display a color
palette for changing the color.

Save and Save As will save the field grid layout to the Layouts folder.

Clicking OK will copy the current field grid layout in the Grid Designer into the currently opened drill file.

Clicking Cancel will exit the Grid Designer without changing the grid layout currently embedded in the
opened drill file.

Page Tab Editor
This feature is only found on the Basic Edition, or versions 3 and earlier of 3D. The Production Sheet
replaces the Page Tab Editor on Interactive and Professional editions.

The Page Tab Editor is a utility that allows you to easily add, remove, and change any page tabs that
appear on the Count Track.

Hash Marks can be custom-named by clicking on the hash edit handle, then typing the
name of your choice in the Custom Marker Value field above the design grid.*
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Starting Set # will change the starting set number. For example, if the first drill ends with page 23, the
continuation file can begin with page tab 24.

The Add Page Tab button adds a page tab at a count entered.

Remove Page Tab removes the page tab that is currently selected in the list of page tabs.

The Subset column is useful when moving only a certain section of the ensemble between two major
pictures (sets). Say for example, everyone except the guard holds from page 2 to page 3. There’s no need
to increase the total number of pages for just a guard maneuver between 2 and 3. In this case, you can
establish the set as a sub-set. This will prevent the set numbers from incrementing the total number of sets,
because sub-sets are labeled with letters. Adding a sub-set between our example of pages 2-3 would read,
2, 2A, 3.

Click in the set Title column to enter a title for the page tab. When a title is entered, the title will be used in
printouts. Page tab titles are useful to clarify reports. For example, imagine page tab #4 is a company front.
Titling page tab #4 “Company Front” will print “Company Front” on any printout where page tab #4 is
included.
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Production Sheet
Available on Interactive and Professional editions only. The Production Sheet replaces the Page Tab
Editor, which is found on the Basic edition and earlier versions of 3D.

The Production Sheet is a helpful tool that allows you to develop your show ideas within 3D before any
charting begins. Think of the Production Sheet as a “map” of your drill. Within this tool, you are able to
notate which measures of a piece will be the transitions between Page Tabs, along with adding any notes,
such as “Big Hit” or “winds face back field”.

Production Sheet Options

Set indicates the set (page tab) number you are working on.

Placing a check mark in the Sub column would indicate that the current set is a sub-set.

The Count column displays which count a set is on.

Transition shows how many counts there are to get to a particular set.

Selecting a row under the Measures column would allow you to input which measures the set is referring to.

Title works much like the Measures column. If you click on a row under the Title column, you would be able
to input a title for that particular set.

Notes columns are there for any quick instructions or notes the ensemble (or you) might need. These notes
can be quickly imported into a Text Box and display on the field through the Text Box tool.

Selecting a set on your Production Sheet is like selecting a page tab on the Count Track.
This is another quick way to preview a set.*
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Moving the Production Sheet

By default, the Production Sheet is activated by a roll over with your mouse onto the large Production Sheet
button located at the left endzone. To pull the Production Sheet away so you may view the field and
Production Sheet at the same time, press the “Detach” button in the upper right corner of the Production
Sheet window. You will now be able to drag the Production Sheet anywhere on your screen. To pin the
window back to 3D, press the “Pin” button.

Print, Import, and Export the Production Sheet

To print the Production Sheet, select Print from the Tasks list in the Production Sheet window. Any Notes
columns on the Production Sheet that have no information (completely blank for each page/set) will not be
printed.

To import a Production Sheet that has been created from a 3rd party application, select the *Import
option from the Tasks list in the Production Sheet window. This will open a new window where you may
browse your machine to find the Production Sheet for importing. To specify which field separators were
used when creating your Production Sheet, select the appropriate option from the Import/Export Options
menu.
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To export a Production Sheet, select the Export option from the Tasks list in the Production Sheet window.
This will open a new window where you may name the production sheet file and select its save destination.
To specify which field separators to use in your 3rd party spreadsheet application, select the appropriate
option from the Import/Export Options menu.

Shortcut Editor
Many functions of the 3D menu bar can be accessed directly using keyboard shortcuts.

You can create more than one set of shortcuts. This is useful if more than one person is using your
installation of 3D. Each individual can setup the shortcuts according to their preferences.
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Creating a Shortcut Set

To create your own shortcut set, select a set that most closely matches the set you want to create for
yourself. Typically, one choose Default as the set to copy. Select the set by choosing a set name from the
Shortcut set menu appearing at the top of the Shortcut Editor. Click New Set to make a copy of the
currently selected set with a new name. Likewise Delete removes the currently selected set.

Editing a Shortcut

To edit a shortcut, click on the shortcut description appearing in the list of shortcuts and click the Edit
button. Shortcuts from the Default set can not be edited. Click the key commands you want to use as the
new shortcut.

To remove a shortcut, click on the shortcut description appearing in the list, and click on the Clear button.
The shortcut will be removed.

To reset a shortcut to its default value, click on the shortcut description appearing in the list, and click
Default.

To save the changes click Save.

The currently selected Shortcut Set will be the set used in the application when the Shortcut Editor is exited
after saving.
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Figurine Editor
This editor is only enabled when the Classic Perspective View is used.

The Figurine Editor is an editor for changing the Figurine uniforms that appear in the Classic Perspective
window. When you open the Figurine Editor you can choose to edit the standard set. The Standard Set is
used with any file that does not have a custom figurine set assigned to it.

The Edit Standard Set button opens the figurine editor window and allows you to change the default figure
uniforms.

The Add Custom Set button copies the standard set and adds it to the current drill package, then allows
you to edit the uniform colors.
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Command Editor
The Command Editor is a utility that allows editing of instructions (commands) for transitional maneuvers.
This is particularly useful if you are teaching a military or show-style ensemble, or if you need a printed
reference of visuals cues for performers.

These commands are generated by using any of the Drawing or Editing tools to transition performers in the
drill.

What Are Commands?
Commands are instructions to perform various tasks in a drill. They can include both transitional commands
(such as follow the leader) and visual commands (such as horns down).

The Command Editor only shows transitional commands. These include the following, by default:

• Hold
• Float
• Push
• Move
• Follow the Leader
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• Track

To print visual commands, see the Performer’s Report section.

Personalizing Command Editor Data
The Transition Description column only contains basic commands that 3D has determined as descriptive
for the maneuver. Any command in this column can be changed by selecting the appropriate cell and
entering the command you wish.

Much like the Transition Description column, Group Names can be edited.

Why Are All of My Groups Untitled?
The Group Name column pulls the names of groups from the Selection History tool. Grouped (glued)
performers in the Selection History tool can be renamed while in the tool, and that naming convention will
carry into the Command Editor.

If you see nothing but (untitled) in the Group Name column, this means no groups (selections) have been
renamed from their symbols in the Selection History tool. You can easily rename any Group Name by
clicking in the appropriate cell and typing the name you desire.

Print/Preview allows you to print the Command Editor list.

Save as PDF will create a PDF file of the Command Editor.

Helper Editor
The Helper Editor allows you to turn on or off specific helpers and allows you to view all helpers at one
time.

Whenever you click on a row in the Command Editor, your Anchors on the Count Track
jump to the count range and the performers for that selected command will highlight on the
field. This allows you to verify you are editing data for the transition and/or group you
intended.

*
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Show in Context turns the selected helper on to be seen when its tool or function is activated.

Don’t Show in Context turns the selected helper off, and will not be shown when its tool or function is
activated.

Show all in Context turns all helpers on to be seen when their tool or function is activated.

Don’t Show Any turns off all helpers, and will not show when its tool or function is activated.
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Virtual Clinic
The Virtual Clinic analyzes your drill files both upon opening of a drill, as well as during design. Watching for
collisions, excessive strides, large jumps in animation and difficult direction changes, the Virtual Clinic runs
in the background and does not require the Analyzer windows to be open while designing.

Virtual Clinic Analyzers are windows with graphs displaying the number of performers at risk (Y axis) over
time (X axis). The higher the output on the Y axis, the larger number of performers are at risk, determined
by the respective Analyzer.

When the option Show Warning Sign on Performers at Risk is selected in a Virtual Clinic Analyzer
window, performers deemed “at risk” will have a warning symbol during their “at risk” counts on your design
grid.

To view the problematic transition, select a range of counts by clicking (or click and drag for multiple
transitions) in the clinic window. Select the Play button that appears in the clinic window when a transition/
range of transitions is selected. This will play a looped animation for the range of counts you have selected.

Transitions can only begin and end on sets (page tabs) when playing the animation from a
clinic window.*
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To open a Virtual Clinic window, go to the Clinic menu and select which Analyzer you would like to be
displayed. To close a clinic window, uncheck the option under the Clinic menu, or click the close button on
the clinic window.

Stride Analyzer
The Stride Analyzer watches for excess stride and graphs output in the Stride analysis window. The higher
the output on the graph, the more performers are taking too large a step.

Selecting the option to Show Warning Sign on Performers at Risk in the Stride Analyzer window will
display a visual warning symbol on the performer(s) at risk on counts where the stride might be too large.
This will be displayed on your design grid.

3D has a predetermined set of default excessive strides. To change settings for what is deemed to be an
excessive stride, select the Settings button in the Stride Analyzer window. When height is not entered for
performers in the Cast List, defaults will be used.

Stride Settings opens a new window with a graph displaying maximum stride (Y axis) and average
performer height (X axis).
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The slider on the left side of the Y axis sets the maximum stride for your shortest performer.
The slider on the right side of the Y axis sets the maximum stride for your tallest performer.
The X axis slider adjust the average height for your band. This is used as the default when height is not
specified for performers in the Cast List. The default stride is indicated on the graph by a red circle on the
line displaying the maximum strides for the tallest and shortest performers.

Collision Analyzer
The Collision Analyzer watches for collisions and graphs output in the Collision Analysis window. The higher
the output on the graph, the more performers are colliding during those counts.
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Selecting the option to Show Warning Sign on Performers at Risk in the Collision Analyzer window will
display a visual warning symbol on the performer(s) at risk on counts where collisions might occur. This will
be displayed on your design grid.

Collisions are based on performer size. This is determined by Figurines or setting the Default Performer
Size in the Collision Analyzer Settings.

The Performer Size is the perimeter around a performer. When setting the Performer Size, you should
consider instrumentation and equipment. Performer Size is automatically calculated. To have a more
specific threshold for collisions, select the option to use Figurine Size. To have the same Performer Size for
everyone in the ensemble, use the Default Performer Size option and set the value to what works best for
your ensemble.

Continuity Analyzer
The Continuity Analyzer watches for large jumps in animation. These typically occur when rewriting a
transition and the animation is not consistent with your written change.
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Selecting the option to Show Warning Sign on Performers At Risk in the Continuity Analyzer will display a
visual warning symbol on the performer(s) at risk on counts where the jump occurs. This will be displayed
on your design grid.

Direction Change Analyzer
The Direction Change Analyzer watches for difficult direction changes for performers in a drill.

Selecting the option to Show Warning Sign on Performers At Risk in the Direction Change Analyzer
window will display a visual warning symbol on the performer(s) at risk of a difficult direction change. This
will be displayed on your design grid.

You can adjust the sensitivity at which the Virtual Clinic thinks is a difficult direction change in the Direction
Change Analysis Settings.

The Ignore facing option will ignore the facing of performers. Deselect this option if you would like the
Virtual Clinic to account for performer facing during the drill.

Disregard stride will ignore strides that are shorter in length than the value you set.
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The Sensitivity scrub bar is where you can adjust the threshold for the Direction Change Analyzer to set “at
risk” performers. Move the scrub bar left to make the Direction Change Analyzer less sensitive, and right for
more sensitive.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 267 of 407



Design Techniques
The following topics cover a few of the more advanced design techniques when charting in 3D.

Click on the arrow next to Design Techniques in the Table of Contents to the left to expand this section
and begin.

Colored Page Tabs/Range
You can quickly assign colors to page tabs or ranges on the Count Track. This is a great way to organize
sets, or make visual reminders of transitions you would need to quickly jump to.

Double-click on a page tab, then choose Color in the Page Tab Options window. Choose which color you
would like to use in the color picker.

Import/Export Audio Sync
Audio Synchronization can be imported and exported between drill files. This is a real time saver if you are
working with multiple versions of a file. Importing an audio sync allows you to bypass syncing audio for a
file, if the file you are importing into has the same audio sync data.

Exporting an Audio Sync

• Go to File, Document Options, and select the Preferences tab.
• Choose Export Sync for the audio file.
• A Save Drill Sync File window will open; give the audio sync a file name, and specify where you want

to save the sync file. Press Save when you are done.
• A 3D Audio Sync file (.snc file type) will be created with the name you gave, in the location you

specified.

Enable colored ranges on the Count Track on the Ease of Access tap in Application
Options.*
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Importing an Audio Sync

• Go to File, Document Options, and select the Preferences tab.
• Choose the audio file you would like the drill to sync to, then press OK in Document Options.
• Press the speaker button on the Count Track. A new window will appear, with various options to sync

the audio file.
• Choose the Import button in the Audio File Synchronization window.
• Select the 3D Audio Sync file (.snc file type) you wish to use, then press Open. The drill file will then

be synced to the audio file.
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Matching Forms
When drawing tools are used to create transitions of existing performers, you will need to identify (match)
the new places made by the drawing tool with a selection of existing performers in the drill. This process is
automatic in 3D and is shown by the matching lines extending from the new positions to the selected
performers.

The matching order predicted by 3D is often correct, however you may need to occasionally adjust the order
in which the forms are matched. Below we’ll explore the various options of matching performers to new
transitions.

Flip
If the new transition was drawn in reverse order of the existing form, a simple Flip will do the trick.
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Predict Next
However, sometimes the matching order is not obvious enough for 3D to predict it correctly. In some
situations, 3D may just need a little input to get started. Other times you may need to enter each of the
matching lines yourself. When 3D has not found the correct matching order, the first thing to do is try to give
it some help.

Click the Clear button to clear all of the matching lines and a red bubble will appear on top of the first new
place. The red bubble indicates the new place that you will match to an existing performer.

With Predict Next checked, click on the selected performer that you want moved into the new place marked
with the red bubble. A match line will connect the performers with the new place.
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The red bubble will move to the next new place. Again, click on the selected performer that you want moved
into this new place. Depending on the location of the selected performer, this may be enough matches for
3D to correctly predict all or some of the matches. Sometimes it may take one or two more manual matches
for 3D to attempt a prediction depending on the matching order you are entering.

If 3D does not predict the matching order you desire, you can use the Back button to back up one match at
a time. Once you get accustomed to 3D’s prediction logic, you may find that combinations such as matching
partly with Predict Next “on”, then partly with Predict Next “off”, will accomplish matching with the fewest
steps.

Manual Matching
When the matching order follows no basic pattern that can be predicted by 3D, it is sometimes easier to just
do the matching manually from scratch.

Turn off the Predict Next option.
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Click the Clear button to clear all of the matching lines and a red bubble will appear on top of the first new
place.

Click on the selected performer that identifies the new place marked with the red bubble. A match line will
connect the performer with the new place.

The red bubble will move to the next place in the new shape. Matched Positions turn green to indicate they
have been matched. Click on the selected performer that identifies this new place. Repeat this step for each
new place.
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If you make a mistake, click the Back button to back up one matched place. Another way to correct a
mistake is to click on the matching line drawn over the incorrect performer and drag the line to the correct
performer.

The [DOWN ARROW] key on the keyboard will advance the red bubble to the next new place. Likewise, the
[UP ARROW] key will advance the red bubble to the previous new place. After pressing an arrow key, any
matches done afterward will advance the red bubble in the same direction as the last arrow key press.
Should the up/down arrow keys stop responding, click once in the Positions box.

Proximity Match
The Proximity Match option will assign performers to new positions in the form based on closest proximity.
This means the Proximity Match analyzes the drill and assigns performers to travel to the closest position in
the new form.

Proximity Match is particularly helpful when assigning performers to a scatter transition, or when used as a
foundation to match into complex maneuvers, as the closest transition may not always be the cleanest, but
is a great start.
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Swap
Swap is the default selection when switching performers order by click + drag. Take the following example:

If two positions in the newly matched form need to be swapped, click and drag one performer to the other
performer’s location.
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Shift
Shift matching will adjust all performers over one spot in the new form. Take for example the following:

Notice that the leftmost performer in the new form is traveling to a position that is nonsensical. If we move
him to the appropriate spot by swapping his positions to the correct one, everyone else would need to move
over one position to accommodate the new hole in the matching.

To alleviate this, you can use the Shift matching function. Press Shift in the matching options, then click
and drag the performer whom you wish to move to their new spot.
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All performers will shift over to fill the void in matching.

At any time during the matching process the Animation Controls can be used to preview the transition in the
drill.
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Moving Props as Performers

Sync Music to Drill
Syncing your music to a drill file is a great way to both visually and audibly preview the drill before hitting the
field. You can synchronize an audio file at any point of your design process; whether it be the first or last
thing you do to the drill. Some prefer to sync audio before any charting takes place, while others might wait
until the drill is finished (or until you get a copy of the audio file, whichever comes first).

A 3D drill file can be synchronized to one of the three following types of audio files:

• MID = MIDI audio file
• WAV = Waveform audio file
• OGG = Ogg Vorbis audio file

We recommend using an OGG file as out of the three, .ogg files tend to be the smallest with the highest
quality sound.

To sync an audio file, you’ll need to do the following:

If your audio file is in a format other than the 3 file types listed above, you’ll need to convert
the audio file to one of the 3 supported files types. There are many free audio converters
available online, however we recommend Audacity for its ease of use.
*

<div class="player-unavailable"><h1 class="message">An error occurred.</h1><div class="submessage"><a
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Load the Audio File in to Your Drill
With your drill opened, go to the File menu and open Document Options. In the Document Options
window, click on the Preferences tab.

Click Choose File for the audio file and select the audio file you wish to sync. Depending on where your
audio file is saved, you may need to select Browse to navigate to the exact location of the audio file on your
machine.
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Once you have selected your audio file, apply the the change in Document Options by pressing OK in the
Document Options window.

Syncing the Audio File
Once the audio is loaded into your drill file, you’ll then be ready to sync. Press the Sound button in the
animation controls on your Count Track.

A new window will appear with options on how to sync the audio file.

Any audio you wish to sync must be saved on your computer. A stream from a web page
will not work.*
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When syncing audio to a drill, you will be asked to sync by count or page.

Sync Audio by Count
To sync an audio file to a drill by count, choose Start Synchronization. The audio file will begin playing
immediately once you press Start Synchronization, so be sure you’re ready to go before pressing this
button.

You’ll want to press the [SPACEBAR] on your keyboard for each downbeat in the audio file. Each press of

the [SPACEBAR] will advance the audio sync one count. When the sync is complete, press the button
on the Count Track.

When resyncing in the middle of a drill (after count 0), the audio will start with an 8 count
lead in prior to the count you entered. For example, if you wish to resync starting at count
48, once you press start synchronization, the audio will begin at count 40. This will allow
you to properly time the first new beat (count 49, in this example).

*
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Sync Audio by Set
To sync an audio file to a drill by set, choose Start Synchronization. The audio file will begin playing
immediately once you press Start Synchronization, so be sure you’re ready to go before pressing this
button.

You’ll want to press the [SPACEBAR] on your keyboard on the 1st count of every transition (excluding sub-
sets). This will sync the count data to music between the page tabs. When the sync is complete, press the

button on the Count Track.

Sync Audio by Beginning and End Count
To sync an audio file by specifying the first and last count of drill, choose Start Synchronization. The audio
file will begin playing immediately once you press Start Synchronization. so be sure you’re ready to go
before pressing this button.

You’ll want to press the [SPACEBAR] on your keyboard on the first and last counts of the drill. 3D will then

evenly space drill file to the audio file. When the sync is complete, press the button on the Count
Track.

Sync by Page Tab tempo (Auto-sync)
To sync by Page Tab tempo, you’ll first want to set a tempo for your page tabs in your Production Sheet
(for Interactive or Professional editions) or *Page Tab Editor (for Basic Editions). If the tempo is consistent,
you only need to enter tempo for the first page tab. If there is a tempo change, you’ll want to enter the new
tempo at each page tab the tempo changes at. For example, if there are 3 tempo changes, you’ll want to
enter the starting tempo, and then the other 2 tempos at the page in which they change.

This method only works for audio files with consistent tempo.!
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Once you have your tempos set, you can begin the sync process. With this option chosen, you only need to
press the [SPACEBAR] on your keyboard at the beginning of the music. 3D will then automatically sync the
remaining counts based on the tempo structure you assigned to your page tabs.

Re-syncing the Audio
Nobody is perfect the first time. If you need to re-sync the audio to the drill, you can clear the current sync
by holding your [ALT] key (or [OPTION] on Macintosh) while clicking on the Sound button. A new window
will appear, confirming that you wish to clear the current audio sync.
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Once the sync has been cleared, you can then re-sync the audio by following the same steps above.

Previewing the Audio Sync with Drill
After the audio file is synchronized, each time you click on the Play button when the Sound button is
depressed, the music will be played. This works the same whether you are previewing a chunk of drill, or the
entire drill file.

Writing Backwards
There will be times when you might wish to write backwards from a set later in the drill. For example,
imagine your second set of a drill is actually the opening formation, and the first set is a transition into the
opening formation. In this case, it is easier to create the opening formation at the later count first, then chart
backwards to the beginning of the drill.

As with the above example, set #2 is the opening formation. In this case we need to create performers for
the first time in the drill at set #2. These performers do not exist anywhere else in the drill file. Place both
editing anchors at set #2. If you are charting backwards from a set of existing performers, skip this step.
Place both anchors on the Count Track on the same count. This is necessary for creating “first time”
performers. Holding [ALT] (or [OPTION] on Mac) while clicking on a page tab will force both Yellow and
Red Anchors to move together to the tab. With the anchors set up properly, enter the new formations into
the drill.

Using the above example, set #2 is the start of the set we have just finished, and now we want to move
“backwards” to set #1 to design the ending count and transition between the two sets. Normally we would be
thinking about the transition from the previous set (set #1) to the current set (set #2). To set up the anchors
for the “backwards” design, set the editing anchors on the Count Track between set #2 and set #1. Click on
the small red right arrow on the Count Track appearing between the Yellow and Red Anchors. The Red
and Yellow Anchor will swap locations. Editing of shapes and all transitions will now be written backwards.

Forward drill writing as indicated by the small red right arrow on the Count Track.
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Backward drill writing as indicated by the small LEFT arrow on the Count Track and the red warning bar in
the Count Track’s page tab area.

Do not forget to return the small red arrow back to its normal direction when you’re ready to
continue writing forward.

!
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Interactive Features
This section covers all functions found in the Interactive menu, including but not limited to: online file
manager and its user permissions, checking for updates, re-authorzing / de-authorizing a machine, and
purchasing plug-ins and accessories.

Click on the arrow next to Interactive Features in the Table of Contents to the left to expand this section
and begin.

Pyware Portal Manager
The Pyware Portal Manager has replace the Online File Manager for file sharing in the version 10.

To open the Pyware Portal Manager select Pyware Portal Manager from the Interactive Menu.

The Pyware Portal Group List will be shown allowing a group to be selected that is available to the selected
user.

Files may also be uploaded directly to the Pyware Web Portal, Upload File to Group*

If the Group Selection window is blank a group will need to be created on the Pyware Portal!
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Once a group is selected the Pyware Portal File List will be shown.

There are several options available:
Upload File – A prompt will show allowing a file to be selected to be uploaded to the Portal Group. Once
selected a prompt will show to have the File Title and File Description entered.

in order continue. How to Create a Group
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Download File – Opens a window to prompt for a filename and download location, then starts the download
once the save button is pressed.

Delete File – Deletes the selected file from the Pyware Portal Group.

File Information – Shows the complete file information for the selected file in the Portal File List.

Compatible file formats include (.3dj, .3dz, .prod, .pdf, .3da, .3dudb)*
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Close – Closes the Pyware Portal Manager

Real View Asset Store
The Real View Asset Store has been introduced to provide access to custom props that can be purchased
as a service from the Real View Store.

To access the Asset Store select “Real View Asseet Store” from the Interactive menu. The asset store
window will then display.
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The assets may be sorted by any column by clicking on the title bar.
The columns included are:

• Name
• Description
• Type
• File Size
• Price
• Minimum version required

Once a row is selected 2 options become available
Preview – shows a preview of the prop as it will appear in the Real View.
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Download File – Starts the download process of the asset and will show a prompt when the download has
been completed.

Close – Closes the Real View Asset Store and loads any downloaded assets to the Visuals Editor.

Drill Lock Decoder
The Drill Lock Decoder utility is used primarily for designers selling drills online. Drills can be locked with a
password so they can be viewed but not edited or printed. After a customer downloads and previews a drill,
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the customer can then contact the drill designer to purchase and unlock it. This decoder creates unique
keys for unlocking a drill, so a key used by one customer cannot be used by another.

Locking a Drill

To create a locked drill file that can’t be edited or printed:

• Open the drill and select Document Options from the File menu.
• In the Author Information box, type your contact and/or sales information.
• Under the Properties tab, pick your restriction options such as Cannot be printed and/or Cannot be

edited.
• Choose to Lock the properties with a Master Password and enter it. The Master Password is the

password that only you know. When your customer contacts you to unlock the drill, don’t give them
your Master Password. Instead, use this decoder to create a unique key that will only work for this
customer and no one else. Remember the Master Password because you will need it to create the
unique key for your customer.

Unlock this Drill
This function is used to unlock drills that have been locked from full access by a drill designer.
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Unlocking a Drill

To unlock a drill, first contact the drill designer for a key. The drill designer will want to know the Drill ID and
Lock ID displayed in this window:

Once you have provided the designer the Drill ID and Lock ID, they will be able to generate your key. Enter
the key and click Unlock.

Instantly Upgrade My 3D Now
There are two prompts that appear when you choose the Instantly Upgrade My 3D Now! option:

• How do I instantly upgrade my 3D edition opens a window similar to Get Plug-in and Accessories.
This window has information and pricing regarding available updates and plug-ins.

Do not click Exit or close this window after you give the designer the information. The Lock
ID will change each time you use this function. If you close the window before entering the
key you were provided, the key will not work.

!
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• I want to apply an existing upgrade or plug-in purchase prompts you to authorize your program. If
you have purchased an update (and have internet access at the time you are attempting to authorize),
your new purchase will take effect after completing the online authorization.

Deauthorize This Computer
This function was employed for users who need to switch 3D installations between more machines than
their license allows, all with the convenience of not having to contact Pygraphics to do so. Once you select
the deauthorize button, the program on your machine will switch to a restricted demonstration version that
cannot save. You would then be able to install and activate on a different computer.

Get Plug-ins and Accessories
This option opens the 3D Upgrades and Accessories window for information and pricing regarding available
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updates and plug-ins. These may be purchased instantly online with a credit card.
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Real View
The 3D Real View is one of the most powerful tools in 3D. Within the Real View, you are able to visualize
your drills with fluid marching animations and true 3D performers. Customize the performer’s uniforms and
instrumentation to see your work in a performance scenario.

Detailed below are the features and options you’ll find in the Real View window.

Zoom Slider

The slider on the bottom left side of the Real View window adjusts the zoom of the Real View. Move the
slider left to zoom in, and right to zoom out.

Zoom can also be adjusted by scrolling your mouse wheel while the mouse is inside the Real View window.

Horizontal Adjustment

You can either click the Left-Right arrows, or drag the handle to adjust the field of vision horizontally.
Horizontal view can also be adjusted by holding down a right-click and moving your mouse left or right.

Restore Default Camera Location

This button will reset the default location of the Real View camera.

Swap Cameras

If you have multiple cameras (for example, Blimp and Sky cams) enabled in the Real View, you can toggle
the focus of the main camera by pressing the Swap Cameras button. Pressing the Swap Cameras button
multiple times will cycle through the cameras.
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Real View Cameras

Cameras in the Real View have multiple options, from multiple angles, viewpoints, and panning. To adjust
any of these settings, select the Cameras button in the Real View window. This will open a control panel
with two tabs. Sky Camera Movement and Active Cameras.

Sky Camera Movement

The Sky Camera Movement tab is where you will find options for camera panning, as well as setting values
for fixed camera angles.

Camera Angles: There are 6 camera radio buttons available for you to quickly jump to different viewing
angles when watching the animation or previewing a chart. To set specific angles to a preset button, change
the view point in the Real View window to your desired angle, then press the Cameras button. Select the
Sky Camera Movement tab. Assign the angle you created to a radio button, 1-6. Once you save a camera
angle through this process, you amy instantly jump to that view in the Real View anytime during the design
or previewing animation process.

To remove all saved camera angles, press the Cameras button, then choose Clear on the Sky Camera
Movement tab.

Camera Panning: Camera panning is based on the placement of your Red Anchor on the Count Track.

Once the anchor is in the desired starting position, adjust the Real View field of vision, then press the
Cameras button. This will open the Real View Cameras window. On the Sky Camera Movement tab, select
the check box to use Camera panning starting at count X (where X=current Red Anchor location).

The Camera Pan Speed sets the speed of the camera pan. Leaving the speed at 0 will result in a snap, or
no pan, to the set camera location.

After the preset Camera Angle Speed has been set, press Save to retain the Camera Angle information.
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Active Cameras

The 3D Real View allows up to 4 different active cameras at once. To set your active cameras, select the
Cameras button on the Real View.

Select the Active Cameras tab and choose which cameras you would like displayed from the 4 available:

The Sky Camera is the least restricted of the 4. It can zoom as far in or out as desired, and be set from any
view point.

The Ground Camera will follow a performer that has been selected with the Spotlight tool. This camera can
be set to any angle, however the zoom is restricted.

The Helmet camera is a first person view of a performer that has been selected with the Spotlight tool. This
is a fixed view point dependent on the selected performer’s facing.

The Blimp Camera is an aerial view with limited zoom. Any tilting or sliding in this view has been disabled.

Real View Document Options

The Document Options button on the Real View window is a way to quickly launch to the Real View
Perspective tab in a drills’ Document Options. Here you can specify settings for fabrics (such as uniforms
and flag silks), default visuals, and a performance surface (if any).

Show/Hide Camera Panning

If camera panning has been assigned to a drill file and you wish to ignore it, select the Show/Hide Camera
Panning button. This will keep the Real View window at a fixed angle while playing the animation.

Show/Hide Performer Labels

Performer labels can be displayed in the Real View window. This is particularly helpful when using the
Ground or Helmet camera options, so the selected performer has a better understanding of their
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responsibility and immediate surroundings.

By default, performer labels are displayed in the Real View. To hide performer labels, press the Show/Hide
Labels button in the Real View window.

If labels have not been assigned to performers, 3D will display labels automatically assigned based on the
order that performers were entered. These labels will be replaced by user entered labels through either the
Performer Labeling tool or the Cast List.

Show/Hide Performance Surface

In the Real View window, you have the option to display step grids and performance surfaces. To do so,
select the Show/Hide Performance Surface button in the Real View window. Clicking the button switches
the option between the step grid and any existing performance surfaces loaded into the drill.

Vertical Adjustment

You can either click the Top-Bottom arrows, or drag the handle to adjust the field depth. Depth can also be
adjusted by holding down a right-click and moving your mouse up or down (while inside the Real View
window).

Heads Up Display (HUD) Settings

Production Sheet data can be displayed as an overlay in the Real View window. This information shown can
be adjusted by clicking on the HUD Settings button located on the Real View window.
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In the Real View window, click the HUD Settings button. A new window will appear. To enable the HUD,
check the Show Heads Up Display option. You can also choose to include or exclude any of the data listed
in this window for display in the Real View. When your options are set, press Save.

Windows Shade

When selected, the Window Shade option will open the Real View perspective while animating, and keep
the window shaded when not animating. This feature is especially helpful if you are running 3D on one
screen.
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Visuals Editor
The Visuals Editor tool aids in customization of both performers and performances in the Real View. Use
this tool to choose uniform style, performer facing, equipment carried, equipment visuals, marching style,
hold style, and pace.

The tool can be kept open while designing, this way you can set multiple performance effects and visuals
while on the move.

There are 5 different tabs available on the Visuals Editor: Uniform & Equipment, Facing, Visuals, March
Style & Pace, and Utilities. Each of these tabs and their respective features will be outlined in the following
topics.

To use the Visuals Editor, the Real View must be enabled, and you must select at least one performer on
the field. To open the tool, select the Visuals Editor on your Tool Palette.

Click on the arrow next to Visuals Editor in the Table of Contents to the left to expand this section and
begin.
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Uniform & Equipment

Uniform Style

With the Visuals Editor, you have multiple uniform “styles” to select from. Any performer at any point during
a drill can wear any of the uniforms available. This means that you could have a traditional uniform for the
winds and percussion, and a guard uniform for the color guard.

Assigning a Uniform

To select a uniform for use, highlight (select) performers on the field and open the Visuals Editor tool. If not
already selected, select the Uniform & Equipment tab.

At the top of the Uniform & Equipment tab will be two menus; one for Uniform Style and one for Hat Style.
Select which uniform you would like under Uniform Style, and repeat the process for Hat Style. Once these

All changes in the Visuals Editor are based on the location of the Yellow and Red Anchors
on the Count Track. Because of this, uniforms can be changed throughout the drill. There is
no restriction on how many times a uniform can be changed; just be sure to have your
anchors on the Count Track in the correct location where the change will occur!

*
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changes are made, they will apply for the entirety of the drill, or until another change occurs.

Assigning Equipment

Carried instruments and equipment is easily assigned and changed for performers in a drill.

To have performers carry an instrument or equipment, you must first select the performers on the field with
a Selection tool. Once the performers are selected, open the Visuals Editor and click on the Uniform &
Equipment tab.

Select the radio button to enable the equipment “family” you wish to choose from. Once selected, the menu
will be enabled, allowing you to pick the equipment of your choice.

For example, if you selected trumpets on the field, you would choose the Brass radio button, then “Trumpet”
from the Brass menu.

Facing
The Facing tab controls which way performers face in a drill. The facing of performers can be changed at
any count in the drill.

Default Facing in a File

To change the default facing for one file, open the drill file. Go to the File menu and choose Document
Options. Select the Real View Perspective tab. You should see a “Facing Style” menu. Choose to have
performers face a fixed angle, or follow the direction of movement.
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Any edits made to the Document Options can become defaults for new files by selecting the *Save as
Defaults for New Files” button.

Change Performer Facing

To change the facing of performers, select the performers and open the Visuals Editor tool.

Once the Visuals Editor tool is opened select the Facing tab. Choose the Facing Style you would like for the
selected performers. If facing a fixed direction, you will need to select the direction on the Facing Direction
Compass.

The changes to the Document Options will only affect performers AFTER the change has
been made (new performers, for example). Performers that were in the file prior to the
change will not be affected.
*
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You may choose for these changes to occur either STARTING at count X (your Yellow Anchor location) or
ENDING at count X (your Red Anchor location).

Follow direction of movement

The follow direction of movement option will have the selected performers face the direction the form is
traveling.

Face to / Away From Performer

To have performers face towards a specific performer, select your performers and then choose the Face to
Performer button in the Visuals Editor. Click on a performer you wish your selected performers will face.
The performer will have a large red circle on top of them, indicating they are the focal point for your selected
performers.

Selecting the Away from check box will face the selected performers in the opposite direction of the
specified performer.
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Face to / Away From Point

Facing to or away from a point is quite similar to facing to or away from a performer. Select your performers
and then choose the Face to Point button in the Visuals Editor. Click a point on the design grid you wish
your selected performers to face towards. There will be a red + on the field indicating the point specified.
You can click the set point button to reset the point.

Selecting the Away from check box will face the selected performers in the opposite direction of the
specified performer.

Face Grouping Order

Selecting the Face Grouping Order will have the selected performers face the direction that the form is
grouped in. For example, if a form of of 10 performers was grouped from 10-1, performer 10 would face 9,
who would face 8, would face 7, so and so forth until the end of the form.

Face Fixed Direction

Facing a fixed direction will have all performers face a specific direction that was input either by the
compass, or typing in an angle in the text box.

Turn Into a Facing

To have performers turn to face a direction over a range of counts, select the performers and open the
Visuals Editor tool. Select the Facing tab in the tool’s control panel. Choose to face a fixed direction, then
select the direction on the compass and enter the number of counts you would like the turn to take.

You may choose for these changes to occur either STARTING at count X (your Yellow Anchor location) or
ENDING at count X (your Red Anchor location).

Visuals
Performer visuals can be broken down into categories, depending on the body orientation and equipment
assigned. You can define upper and lower body visuals, poses and maneuvers.
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Upper Body

Upper Body visuals are dependent on the selected performer’s assigned equipment (if any). The list of Pose
and Move options may change depending on what the selected performer is carrying.

To assign an Upper Body visual, select a performer or group of performers on the field. Open the Visuals
Editor tool and click on the Visuals tab. If you wish to assign a Pose (a non-moving hold), select the
appropriate Pose from the list. IF you wish to assign a Move (a moving maneuver), select the appropriate
Move from the list. You can enter a count value to have the performer take X amount of counts to hit the
Pose or do the Move, and have it start or end at a certain count in the drill (dependent on your Yellow and
Red Anchor locations on the Count Track).

Lower Body

Much like Upper Body visuals, Lower Body visuals can be assigned to a performer or group of selected
performers. To do so, select the desired performers on the field with any Selection tool. Open your Visuals
Editor and click on the Visuals tab. If you wish to assign a Pose (a non-moving hold), select the appropriate
Pose from the list. If you wish to assign a move (a moving maneuver), select the appropriate Move from the
list. You can enter a count value to have the performer take X amount of counts to hit the Pose or do the
Move, and have it start or end at a certain count in the drill (dependent on your Yellow and Red Anchor
locations on the Count Track).
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Hold Style

The menu under Hold Style on the Visuals Editor tool allows you to specify if selected performers will stand
or mark time during a hold.

Performer Prop
The Performer Prop tab allows you to assign props to performers on the field. This means that you can
enter and maneuver props just like you would performers.

To assign a performer as a prop, add performers to the field using any of the Drawing tools. Select the
performers on the field, and open your Visuals Editor to the Performer Prop tab. You’ll then be presented
with various prop types to select from.

See Real View Poses Guide for a quick visual reference for all available poses.*
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Pit Props

The Pit Props list include many instruments and accessories found in front ensembles, as well as a few full
front ensemble layouts for use. Pit Props can be assigned to performers, but cannot change size or have an
image assigned to the existing instruments.

Shape Props

Shape Props include a list of various 2D and 3D geometrical shapes for use. Many of these props can have
an image assigned to the prop by selecting Choose a Prop Image and applying the image in the menu.

Shape Props can also change dimensions, either immediately, or over a range, depending on your
preference.
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Structure Props

Structure Props include both geometrical shapes as well as models of various show equipment such as
ramps and podiums. Like Shape Props, some Structure props can have an image assigned to the prop by
selecting Choose a Prop Image and applying the image in the menu.

Structure Props can also change dimensions, either immediately, or over a range, depending on your
preference.

Custom Props

Custom Props include any props download through the Real View Asset Store in the Interactive menu. Like
Shape Props, Structure props, Custom Props can have an image assigned to the prop by selecting Choose
a Prop Image and applying the image in the menu.

Custom Props can also change dimensions, either immediately, or over a range, depending on your
preference.

Performer & Prop Collision

There are 4 options for prop collision:

Can be walked on when enabled, a performer can pass over the top of selected prop(s), assuming the
performers were set to be able to walk on props (see next option below)

Can walk on Performer Props when enabled, selected performer(s) can pass over the top of a prop (that
has been set to be walked on)

Performer/Prop Performer will not collide is essentially the “turn off” option – when enabled, performers/
props will not collide with each other; the performer/prop would then pass through each other

Once any type of Performer Prop has been assigned to the field, it can be selected and edited, just like you
would a standard performer.

March Style & Pace
Multiple marching styles are available for you to choose from. By default, performers marching in the Real
View will march with a bent knee style and jazz run when necessary. You can, however, specify for
percussion to march with a crab step, or have the performers march with a traditional style high step.

For more information on entering and moving props as performers, see Moving Props as
Performers.*
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March Style

To change the march style of performers, select the performer(s) and open the Visuals Editor tool. On the
March Style & Pace tab, choose the style you want performed and press Apply Changes.

Pace

Performers can march single, double, or half time, based on your input.

To change the pace of a performer, select the performer(s) and open the Visuals Editor tool. On the March
Style & Pace tab, choose the pace option you would like from the menu and select Apply Changes.

Once a pace has been applied for performers, they will continue marching at that pace until the pace has
been adjusted again.

Utilities (Visuals Editor)
The Utilities tab contains quick links for different tools in the program that are frequently used in conjunction
with the Real View perspective.

Fabric/Visual Options opens the drill file’s Document Options so you may specify which fabrics to use for
the drill.

All changes in the Visuals Editor are based on the location of the Yellow and Red
Anchors on the Count Track. Because of this, march style can be changed throughout the
drill. There is no restriction on how many times marching styles can change; just be sure to
have your anchors on the Count Track in the correct location where the change will occur! If
you are setting a default for the file (such as March Style), make sure the Red Anchor is at
count zero. If your anchors are spread when you change the style, the style change will
apply to that transition and from that point forward, or until another change is made.

*
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Fabric Editor is a quick way to open either the drill’s fabric folder, or launch an image editor to customize
fabrics for use in a drill.

Symbol to Real View Map will open the Symbol Map Editor, where you can specify uniform and equipment
values to be saved, depending on which symbol is used on the design grid.

Movie Maker will begin the process for creating videos of your drills.
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Plug-ins
There are four plug-ins available for Pyware 3D: the Floor Covers plug-in, Personal Drill Book Printer, Spiral
Tool plug-in, and the Traditional Tools.

All plug-ins are included in the Professional edition of 3D. Any plug-in can be purchased separately on the
Basic or Interactive edition.

Installation Instructions

All plug-ins are installed during 3D’s installation. You would need to activate 3D before attempting to
activate any plug-in purchase. Once 3D has been activated, do the following to activate your plug-ins:

• Open 3D
• Go to the File menu and choose Application Options
• Click on the Plug-ins tab
• Click the Re-activate Plug-ins button
• Enter the Plug-in Activation Code in the text box at the bottom of the screen. The Plug-in

Activation Code was provided to you at the time of purchase. If you do not have an activation code
for your plug-in, Contact Pygraphics, Inc. for assistance.

• Click Re-activate

If the steps above were followed correctly, your plug-in(s) will be unlocked. Your plug-in(s) will be available
for use after a restart of 3D.
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Click on the arrow next to Plug-ins in the Table of Contents to the left to expand this section and begin.

Floor Covers
In Pyware 3D, a performing surface is most always made up of a grid created by the Grid Designer of the
Utilities menu. Grids are the lines on the display (much like yard lines on a football field). Most performing
surfaces can be defined using simply these horizontal and vertical grid lines. However, in some cases there
are other characteristics of a performing surface that would be handy to show on the screen. For example,
the markings on a standard basketball court would be nice for indoor performances. These special markings
can be displayed using Floor Covers. When creating a grid using the Grid Designer, you can add a Floor
Cover that is placed under the grid. The floor cover usually represents the markings of a basketball court,
soccer field or other standard field. It could, however, also be the logo that is painted in the center of a
football field, or the design on a canvas that lays over the performing surface for an indoor performance.
There are many uses for Floor Covers.

Adding a Moveable Floor Cover

A Moveable Floor Cover is an image such as a stage, wall, or pit area. Any .jpg, .png, or .gif image can be
used as the Moveable Floor Cover. All Moveable Floor Covers are entered at count 0 of the drill. Moveable
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Floor covers can be moved around the field by assigning a performer to be the carrier of the floor cover. To
control the movement of a Moveable Floor Cover, you can assign the Moveable Floor Cover to an existing
performer, or create a new performer using the Point tool. To move the Moveable Floor Cover, use any
Editing tool on the performer and the Moveable Floor Cover will follow the movement of the performer.

Control Panel Options

Clicking on the Moveable Floor Covers tool will display the *Floor Cover Tool Control Panel.

Clicking on top of an existing floor cover will select the floor covers for editing. A floor cover is selected
when it is outlined in red.

Clicking a location anywhere else in the design area will start the creation of a new floor cover. The first
click will be the location of the upper-left corner of the floor cover. Move the cursor to the location for the
lower-right corner of the floor cover and click. A red box will indicate the location entered.

Editing handles will appear on a selected or new floor cover. Dragging the handle in the upper-left corner
will move the location of the floor cover. Dragging the handle in the lower-right corner will change the size of
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the floor cover.

Clicking on Choose a Floor Cover Image in the Floor Cover Tool Control Panel will display a file dialog for
finding an existing image.

Floor Cover is carried by a performer will cause the floor cover to move with the movement of a selected
performer. To select the performer to be the floor cover’s carrier, drag the upper-left corner of the floor cover
directly on top of a performer. A red “bullseye” will appear on top of the performer to indicate the performer
that will carry the floor cover throughout the drill. The carrier can be any performer in the drill.

Selecting the performer and editing its movement throughout the drill will cause the floor cover to move as
well.

The Opacity of the floor cover can be entered by entering a number in the Floor Opacity text box. The
transparency value is a percentage. If you choose an opacity of 50% the floor cover will allow 50% of the
drill to be seen through it on the design field.

Loading a Floor Cover in the Grid Designer

To create a grid that includes a floor cover you will use the Grid Designer found in the menu of 3D.

• Select Grid Designer from the Utilities menu.

• Load the grid you wish to use by selecting Load then choosing the grid of your choice.

• Click Floor Cover and open your floor cover image file (.jpg, .png, or .gif.)
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• Once the floor and grid are loaded as you like, you can save the setup by selecting Save or Save As
so you can use the grid design on new drill files.

• Selecting OK will apply the changes to the drill file that is currently open.

Adding a School Logo to a Grid Layout

Included in the Floor Covers folder (inside your user Documents\Pyware 3D folder) is a
Football_Template.jpg file. This file is created with the correct floor cover dimensions (height and width) of a
standard football field. The file also has a tick mark at each yard line location.

• To add a logo to the file, open the file “Football_Template.jpg” with an image editing program.

• Paste your logo into the template. Scale and locate the logo so that it fits correctly in the template
using the yard line tick marks as a guide.

• Delete the outer border and tick marks leaving only the logo in the file.

• Select Save As for the file under a new name. Make sure the location of the file is in the Floor Covers
folder.

• Use the steps in the section above for adding a floor cover to an existing grid.
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Transferring Floor Covers

Should you transfer the drill file to another computer, you will need to also transfer the floor cover image
used in your drill. You can save a 3D Drill File as a 3D Package that will include the floor cover image used
with the drill into one file. When saving, the package option Include Floor Cover must be set. To change
the format of an existing drill file to a 3D Package, choose Save As from the File menu and set the Save
options.

Personal Drill Book Printer
The Personal Drill Book Printer is a plug-in that harnesses one of the most powerful features of the
Performer’s Practice Tools. This plug-in allows you to print customized drill books for each performer that
contain drill charts, set by set pathways, and coordinate sheets.

Printing a Drill Book

Before printing drill books it is suggested that you label and name all performers (in the Cast List) for this
tool to be most effective. To print a Personalized Drill Book select Print Personalized Drill Books from the
File menu.
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This will open the Print options for the Personalized Drill Books.

Drill Book Printing Preferences

Print props images will print props when enabled. If the option is not checked, only the prop boundary will
appear.
Print only selected positions only prints drill books for performers that you currently have selected in the
drill. Use any Selection tool to select the performers.
Zoom top chart for largest printout when enabled will zoom the top chart view point to the largest
possible.
Include Drill Book Cover includes a cover for the drill book pages to be inserted into.
Include all drills of this production includes all drills that are part of the current open production.
Print all performers black prints all performers black instead of the color set in the label editor.
Print all symbols as Dots changes every performer’s symbol in the drill to a dot.
Print each performer’s label prints each performer’s label that is set in the label editor tool.
Print text boxes prints all the text boxes that have been entered on each page.
Print Facing prints the facing direction for each performer.
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Print only one chart per page will print one set (chart) per page.
Overlay set: (Previous) (Next) prints the secondary positions as dots from either the previous or the next
drill set.
Force Textbox Font Size will set a standard text size in text boxes (if included).
Print Notes enables the option for including space for notes (blank space to be written in by the performer
or notes from the Production Sheet) on each chart. Enabling this option removes the ensemble chart
printout, leaving only the zoomed in chart printout.

• Blank Notes leaves a lined section for the performer to write in notes manually on each page.
• Print text from Production Sheet Note will include the notes from whichever notes columns of the

Production Sheet are selected below.

Grid Layout Menu allows you to quickly switch between grids when printing. This is helpful if you have
different grids for designing and printing.

Sort Performers allows you to sort the drill books in order of Original Entry, Name, Symbol & Label, or
Label & Symbol.

Save as Default saves the preferences that you select as the default settings for Drill Book printouts.

Print/Preview opens the Print Preview screen that is seen on the next page.

Close closes the Print Drill Book dialog.

Print Preview

The print preview screen is accessed by clicking the Print/Preview button in the Print Drill Book dialog. All
drill charts printed on the drill book are in the student perspective.
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Print will send the job to the printer.

Previous Page will move to the previous preview page of the print job.

Next Page will move to the next preview page of the print job.

Page Setup opens the printer’s page setup dialog.

Done closes the print preview and returns to the print charts dialog.

Spiral Tool
The Spiral tool is a plug-in that allows a designer to easily create a fluid spiral shape. The Spiral tool can
create spirals of any numbers of loops.
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For NEW performers, set the Red and Yellow Anchors on the Count Track to the count at which you wish
the spiral to be drawn. To transition EXISTING performers into a spiral, move the Red Anchor to the count
where the selected performers should “hit” the spiral shape. Move the Yellow Anchor to the beginning
count of the transition into the new spiral. This is usually the previous set in the drill. Select the existing
performers that will be moving into the spiral using a Selection Tool. See the Drawing Tools overview for
more explanation between new performers and transitioning existing performers.

Clicking on the Spiral tool will display the Spiral Tool Control Panel.

Drawing a Spiral

The Spiral tool operates similar to the Circle tool. Spirals are drawn by clicking two points on the field
display. The first click on the field will be the center point (or first endpoint) of the spiral. The second click
will be the second endpoint of the spiral. The remaining performers will be drawn in automatically,
depending on the number of loops you specified. You can change the number of loops of the spiral before
committing the form to drill.

Spiral Tool Control Panel Options

Loops sets the number of times the spiral will loop.

Reverse changes the direction of the spiral.

Entering the interval in the Interval box will lock the interval and the form will maintain the interval while you
move its editing handles. Since the interval between positions is locked, the form would grow or shrink by
changing the number of positions in the form.

Mixed Intervals are also entered by pressing the button. This option will allow you to have different
intervals in one form. Mixed Intervals are extremely useful when charting large instruments or instruments
that are close together but vary in size (drum lines, for example).
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To create a Mixed Interval, type the Interval value, followed by an “x”, followed by the number of positions
at that interval. For example, a form with 5 positions at a 3 step interval, followed by 10 positions at a 2 step
interval, ending with 5 positions at a 3 step interval would be entered like this:

5×3,10×2,5×3

Mixed Intervals can be entered before or after you create your shape, but must be entered before you
Accept the form.

Many of the options in the Spiral Tool Control Panel are exactly the same as options in the Line tool. Refer
to the Line tool for details on the Clone, Alignment, Symbol, Color, Editing Handles, and Reposition
Handles. See Matching Lines for an explanation of the Matching Lines functions.

Traditional Tools
The Traditional Tools Plug-in includes a set of tools that are frequently used in military (traditional) style
marching. This set of tools includes:

• Sequential Push Tool – used to create step offs and drop offs
• Counter March Tool – used to create counter marches
• Parade Gate Tool – used to create parade gates or wide, sweeping turns
• The Traditional Tool – allows you to create multiple maneuvers and combine them over the course of

a single transition

The Spiral tool is a separate purchase on Basic and Interactive editions, and is included
with the Professional edition. See the Interactive Features page for more information on
purchasing the plug-in.
*
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Sequential Push Tool
The Sequential Push Tool aids in easily creating step offs and drop offs.

Since this tool is an Editing tool, performers must be selected, and your Yellow and Red Anchors on the
Count Track must be spread for a transition. Click on the Sequential Push Tool on the Tool Palette to open
the Sequential Push Control Panel.

Editing handles appear on each performer. Dragging the editing handle of a position to a final location will
cause all other performers to follow behind in a sequential movement. The position that is dragged will
always be the performer that will travel the furthest in the maneuver.

If there are not enough counts in the transition for all performers to have time to step off, the remaining
performers will mark time.

Entering a value in the Stride text box automatically moves the performers into the new location based on
the stride length entered. Likewise, entering a number into the Distance text box automatically moves the
performers into the new location based on the distance entered. Clicking on the directional compass will
move the positions to reflect the new direction.

Snap to Horz/Vert padlock will snap the positions to horizontal, vertical, or 45 degree direction.
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Multi-Segment allows you to select more than one shape (segment) and have the step off be uniform in all
of the selected shapes as shown here:

The value in Step Off designates the counts between each step off. For example, if you entered “2”, then
the positions will step off every 2 counts until either the end of the shape or the number of counts in the
maneuver is reached.

The value in Drop Off designates the counts between each drop off. Typically you will enter a value for
either the Step Off or Drop Off and leave the other at 0. For example, if you enter a “0” as the Step Off and
“2” as the Drop Off, all positions will step off together and a performer will drop off every 2 counts until the
end of the maneuver. If there are not enough counts in the maneuver, some positions may just mark time.

The Animation Controls are always accessible while using this tool for previewing the maneuver.

Reset to Hold – resets the animation to a “Hold” from the secondary count.

Revert button resets the handles to their initial position.

Accept will accept the transition to the drill.

Counter March Tool
The Counter March Tool aids in easily creating counter march transitions.

Since this tool is an Editing tool, performers must be selected, and your Yellow and Red Anchors on the
Count Track must be spread for a transition. Click on the Counter March Tool on the Tool Palette to open
the Counter March Control Panel.
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Editing handles appear on each performer. Dragging the editing handle of the counter march to the
location on the field where the counter march is to begin. A blue line will designate the location where the
counter march maneuver will begin.

In the Counter March Control Panel, the value in the Stride text box determines the stride length the
performers will be using during this maneuver.

The Flank options determine which way the performers will first turn in the counter march.

The value in Take [ ] steps and flank designates the number of counts the performers will hold (or mark
time) before the second flank.

The Animation Controls are always accessible while using this tool for previewing the maneuver.

Revert button resets the handles to their initial position.

Accept commits the transition to the drill.

Parade Gate Tool
The Parade Gate tool allows you to create wide gate turns easily. This is an essential tool for parades when
rounding corners.

Since this tool is an Editing tool, performers must be selected, and your Yellow and Red Anchors on the
Count Track must be spread for a transition. Click on the Parade Gate tool on the Tool Palette to open the
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Parade Gate Control Panel.

Editing handles appear on each performer. Drag any performer to determine the initial marching direction
and the point at which the rotation of the gate maneuver should begin.

The center point of the rotation will occur at the final location of the editing handle you drag.

You can change the center point of the rotation by dragging the center point indicator.
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In the Control Panel, the value in the Stride text box designates the stride length the performers will use
during this maneuver, except during the actual gate (turn). During the gate all performers will be taking
different strides.

Gate [left] [right] at the blue line designates which way the positions will turn when performing the gate.
The gate will not begin until the performers cross the blue line.

The value in steps during gate designates the number of steps taken in the gate. The default is 16. This
means the performers take a total of 16 steps during the execution of the gate maneuver.

Revert resets the handles to their initial position.

Accept commits the transition to the drill.

Traditional Tool
The Traditional Tool aids in creating multiple maneuvers and combining them over the course of a single
transition.

Since this tool is an Editing tool, performers must be selected, and your Yellow and Red Anchors on the
Count Track must be spread for a transition. Click on the Traditional Tool on the Tool Palette to open the
Traditional Tool Control Panel.
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Editing handles appear on each performer. Drag any performer to determine the initial marching direction
for all for of the performers.

As you drag an editing handle an action line will appear on the field. This action line designates the starting
line for a Route (maneuver) to begin. As each performer crosses this line, the performer will begin following
the Route.

In this example, the performers are initially moving in the same direction as the leader (left). As they cross
the action line, the performers begin the route. In this case the route is a simple LF (Left Flank).
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Traditional Tool Route Key

The Traditional Tool allows you to create multi-maneuver transitions. These transitions are created by
entering Routes consisting of a combination of moves. There are 8 different moves available:

Code: Movement

LF: Left Flank
RF: Right Flank
MT: Mark Time
FM: Forward March
TR: To the Rear
ST: Step Off (such as step 2)
SD: Drop Off (such as drop 2)
H: Half Stride (taking a half distance step)

Routes are entered in the Route box by typing the code for the move followed by a number of steps. Each
move is separate with a comma.

For example: LF2,LF

The above example is a Left Flank (LF), then take 2 steps and make another Left Flank (LF), then continue
marching to the end of the transition. This is a standard left Counter March. When entering the route in the
Route text box, the description of the maneuver(s) will appear in the Description area. This will help you
confirm that you are entering a correct route.

Action Line Slope changes the slope of the starting line of the route. Typically the slope will be 0. However
you can set the line to a 45 degree slope which allows you to create column left and right formations. There
are 7 different settings of slope available: no slope, 22.5, 45, 67.5, -67.5, -45, and -22.5 degrees. Any
selection will influence the direction the column will turn.

New creates a new traditional maneuver.

Save will save your route as a traditional maneuver to be used again later.

Copy will open and display a saved route.

Delete will delete a saved route.

Revert resets the handles to their initial position.

Accept accepts the shape into the drill.
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FAQ
The subtopics below cover a broad range of frequently asked questions. You can navigate the topics by
clicking the arrow left of FAQ in the Table of Contents to expand the list of viewable topics, or by searching
for your inquiry in the search box above.

Video version of this User Guide – Pyware University Video User Guide
We offer Night School Zoom Sessions for learning how to use Pyware 3D – Sign up for Pyware Night School
How to Videos and Past Night School sessions are available on the Pyware YouTube Channel

Activate Every Run on MacOS
If Pyware is prompting you to activate the software on every run, there is an issue with the license
information being saved on your computer. This is most commonly created by having different users (in the
operating system) with varying levels of permissions. To remedy this, we recommend following the steps
below.

1. Open Finder.

2. From the menu bar, choose Go then Go to Folder.

3. In the new window, type in ~/library/application support and click the blue Go button.

4. Look for the Pyware 3D V# folder, where # is the latest version for your Pyware 3D license. Once you
have found the appropriate Pyware folder, open it.

If you receive any errors throughout these instructions, please contact your IT personnel for
appropriate permissions.*
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5. Inside the Pyware folder, delete both the lib and temp folders.

6. Click the back button on the Finder window once. This will bring the window back to the Application
Support folder.

7. Right-click (or CTRL left-click) on the Pyware V# folder and choose Get Info.
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8. Click the arrow next to the “Sharing & Permissions” header to expand this section. Here you will find a list
of users.

9. At the bottom right section of Get Info is a padlock. Click on the padlock and enter the required
information.

10. Once the information is entered successfully, the padlock will unlock. In the list of users under “Sharing
& Permissions”, set Read & Write as the privilege level for all users.

11. Click the cogwheel at the bottom of the window.

12. Choose apply to enclosed items.

13. Click the padlock once more to lock the changes.

If you are unable to get past this window, please consult with your school IT personnel.!

Pygraphics Pyware 3D User Guide - 11.0_en

Page 334 of 407



14. Close out of Finder.

15. Launch Pyware 3D and activate the software one last time. From this point forward, all future runs
should not prompt you to activate Pyware.

Activate Every Run on Windows
If Pyware is prompting you to activate the software on every run, there is an issue with the license
information being saved on your computer. This is most commonly created by having different users (in the
operating system) with varying levels of permissions. To remedy this, we recommend following the steps
below.

1. On your keyboard, press and hold the Windows key + R. This will open a new window near the bottom
left of your screen called Run.

2. Inside this window, enter C:\programdata and click the “OK” button.

3. Look for the Pyware 3D V# folder, where # is the latest version for your Pyware 3D license. Once you
have found the appropriate Pyware folder, open it.

4. Inside the Pyware folder, delete both the lib and temp folders.

If you receive any errors throughout these instructions, please contact your IT personnel for
appropriate permissions.*

Your hard drive may be labeled differently than “C” – if that is the case, edit the string above
with your appropriate hard drive name.*

If you are unable to get past this window, please consult with your IT personnel.!
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5. Click the back button once to return to the “ProgramData” folder.

6. Right click on the Pyware V# folder inside of ProgramData and choose Properties. A new window will
appear.

7. Click on the Security tab at the top of the Properties window.

8. Click the Edit… button, which will open a new window.
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9. Click on the Add… button, which will open a new window. Type “everyone” inside the object name box,
then click “OK”.

10. Back on the Security tab, select “everyone” under the Group or user names section. This will highlight
“everyone” in the list. At the bottom of the window, under the “Permissions for Everyone” section, check the
boxes for Read and Write under the Allow column. Press “OK”.
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11. Back under the Properties window, click “OK”.
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12. Launch Pyware 3D and activate the software one last time. From this point forward, all future runs
should not prompt you to activate Pyware.

Add Performers to the Drill

Adding Performers to a New Drill
When starting a new file, performers are added to a drill by any of the Drawing tools on the Tool Palette.
Drawing tools on the Tool Palette are outlined below:

To add performers with a Drawing tool, your primary and secondary (red and yellow) anchors must be on
the same count on the Count Track.
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Although not necessary, we recommend adding all performers on count zero of the drill, especially if you are
still “learning the ropes” of 3D. Performers can technically be inserted at any count. This is helpful if you
would like to start from a certain set, or “hit” in the drill and work backwards to the beginning.

Adding Performers to an Existing Drill
Much like adding performers in a new drill, you can add performers to an existing drill by drawing the
performers with any of the Drawing tools, while both anchors on your Count Track are together.

If you need to add multiple people, such as the drum line or color guard, this would typically be the quickest
method to adding performers in an existing drill.

If you only need to add a few people, you might want to consider using the Drill Rewrite function. More on
that here.

Adding Performers via the Drill Rewrite
Numbers change; it’s a fact of life when designing marching shows. It’s just about inevitable that there will
be some sort of adaptation required from the time you designed (or contracted a designer) your drill and
teaching the drill. When that time comes, look to the Drill Rewrite function to quickly insert or remove
performers. Since we’re just discussing adding performers on this topic, we’ll keep this section related only
to the “Insert Performer” option of the Drill Rewrite.

Simply put, the Drill Rewrite is a function that allows you to quickly insert or remove performers from a drill
file. When a performer is inserted into a drill, the Drill Rewrite function will attempt to maintain the integrity
of each set. The Drill Rewrite function accomplishes this by paying respect to the way forms are “grouped”
(matched) on each set.

Before we get into adding anyone with the Drill Rewrite, it’s best if you understand a few concepts first.

Picture vs. Form

The Drill Rewrite will insert a performer between two performers that remain next to each other throughout
the entirety of the drill. This means that if two performers that start adjacent to each other, but at some point
in the drill separate into different groups, squads, mesh, etc., you would not be able to insert the performer
between them via the Drill Rewrite function. Because of this, we suggest doing a little prep work to
maximize the effectiveness of the Drill Rewrite function.
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Take a look at the following image.

This is a set of a drill. The performers are standing in the picture for the set. A picture can be composed of
multiple forms.

Here’s the exact same picture, with all of the forms selected:
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In this particular example, multiple forms create the big picture (set). This is important to both understand
and identify as you can save yourself quite a bit of work on the back end of the Drill Rewrite.

When equalizing a form to account for the newly inserted performer(s), the Drill Rewrite function will
equalize the shape of the form, not the picture.

Our best suggestion is to identify where in the drill you wish to add the performer, then look at each page,
set by set, and see how the form is grouped together with respect to other forms. Taking the same example
from above, let’s say we want to add an additional trumpet. The trumpets comprise a few rows of the wind
block and look good if you look at the big picture (set), but if you look at their grouping it seems a little
strange. If we add a trumpet with the current grouping, 3D will equalize the form as it stands. The result
probably won’t be the effect you’re looking for. Here’s what it looks like if we add a trumpet between T72
and T69 without changing how the form is grouped on that set:
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As you can see, 3D equalized the previous form (grouping) when we inserted a new performer. Because the
grouping of that particular form was so large, with parts of it going over other forms, the result is quite
messy. This is why we recommend observing and/or changing any grouping (if necessary) where you wish
to insert a performer using the Drill Rewrite, before going through the Drill Rewrite steps.

Once you are satisfied with how the forms are grouped on each set, you can then go to the Utilities menu
and choose Drill Rewrite. From the Drill Rewrite control panel, on the insert performers tab, click on a
performer on the field that you would like to insert the new performer next to. If they performer remains
adjacent to another performer in the drill, both performers will highlight. You can then continue forward with
the Drill Rewrite process.

Apply Text Boxes to All Sets in a Drill
While text boxes can be incredibly helpful as they can contain pertinent instructions, adding that instruction
on every page can be very time consuming. 3D has the ability to drastically reduce the time it takes to add
text instruction on every page by using Text Box Templates.

Simply put, pushing out a text box on every page is a 3 step process:

1. Enter the information you wish to be displayed on each text box in the Production Sheet.
2. Create the template for where and what information will be displayed in the text box.
3. Apply the text box template to count 0 of the drill. You’ll then be prompted to apply that text box to all

other drill pages (sets).

We’ll break the process down into 3 separate sub-topics, which can be found here: 1, 2, 3.

This feature is only available on Interactive and Professional editions of 3D.*
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Enter Information in the Production Sheet
Text Box Templates take your hand-picked information from the Production Sheet to be displayed in text
boxes. Because of this, the Production Sheet must have, at the very least, the information you wish to
display in the text box.

Much of this information is input in the Production Sheet when you add sets to the drill. Columns like Set,
Subset, Count and Transition will all have data based on the pages on your Count Track. The Measures,
Title, and Notes 1-5 columns are user defined and would display nothing without your input.

Adding Pages to the Production Sheet
First and foremost, pages must be present in the Production Sheet before you can add any other related
information. To add a page, click the Add button at the bottom. A new window will appear, where you can
add a page to the entered count for the drill.
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You can add as many pages as your drill requires; there is no minimum or maximum limit to the number of
pages a drill can have.

Once your pages are entered, you can then begin entering information in the Title, Measures and Notes
columns. Click in the cell you wish to enter in information, enter the information, then you can click out (off)
the cell when done.

Creating the Template
Once your Production Sheet has information to display in a text box, creating the text box and saving it as a
template is quite simple.

To begin, open the Text tool on count 0 of the drill.

Create the text box shape and size by clicking twice on the field, once for the upper-left corner, and second
for the lower-right corner. You can reposition the text box by clicking and dragging the edit handle in the
upper-left corner, and re-size the text box by clicking and dragging the edit handle in the lower right corner.

By default, a new drill has 300 counts. If you need to add counts to a drill, go to the Utilities
menu and choose the Count Editor. There you will find an option to add or remove counts
from a drill.
*
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Once you have the size and shape of your desired text box, click the Edit button in the Text Tool Control
Panel.

The Text Template Editor window will appear. This is where we define what information will display from the
Production Sheet in the text boxes.
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The buttons that run down the right side of the Text Template Editor, appropriately named Production Sheet
Inserts, are the list of available options to input in a text box. You’ll notice each button has it’s own column
in the Production Sheet. This is because all of the information in the Production Sheet is at your disposal for
use in text boxes.

If you click a button, it will add that Production Sheet value to the Preview/Edit section of the Text Template
Editor window. Let’s say we wanted to have the Page Number, Measures, Transition, and Notes 1 column
in a text box on every page. Here’s what it would look like if we clicked each of those respective buttons, in
order:

Production Sheet Inserts will be in <> (brackets) in the Preview/Edit button.*
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And here’s what that text box would look like:

Not exactly the effect we were looking for! This can be prevented by adding a little formatting to the
Production Sheet Inserts. Let’s go back to the Text Template Editor and format the information to make it
more legible.

You can type in the Preview/Edit section of the Text Template Editor window. This allows you to add text
before or after the Production Sheet Inserts, this way you’ll know what numbers are what, as well as add
line breaks for visibility (if desired). So with a little formatting, and using the exact same Production Sheet
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Inserts, we can make this:

Look like this:
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Which will result in this on the page:

Once you have the template designed as you wish, press the Add button in the Text Template Editor
window. You will be prompted to name the template. Enter the template name, press OK, then Done in the
Text Template Editor window.

The template will then be available for use in any future drill by selecting the template from the Templates
menu in the Text Tool Control Panel and pressing the Use Above button. Press Accept in the Text Tool
Control Panel to apply the text box.
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Adding the Template to All Pages
Once your Text Box Template has been created, applying the template to all pages is extremely quick.

Text Box Templates are applied to all pages on count zero of a drill. If you add a template to any other count
of the drill, you will not be prompted to apply the template across all pages.

To begin, make sure both anchors are on count 0 of your Count Track.

Open the Text tool on your Tool Palette.

In the Text Tool Control Panel, select your template from the Templates menu and press Use Above. You’ll
be prompted to confirm adding the template to all pages of the drill.

Select Yes and your text box template will be added to every page in your drill file.

Continuation File
A commonly asked question we get each year is “how do I take the last set from one file and make it the
first set of another file?”

The process is extremely simple when using the Continuation File function.

In order to apply the template to all pages in a drill, a drill file must have page tabs. See the
How to Create Page Tabs topic for discussion on adding page tabs to a drill.*
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• To begin, you would need an existing drill file. Open the drill that you would like to continue FROM
(the drill which contains the last set that you would like to copy).

• Go to File, and choose New Drill.
• In the New Drill window will be a section for continuing the existing file. Select the file in the list, and

then choose whether to continue from the last count of the selected file, or count X (where X is the
count you specify).

• Set any remaining options for the new drill.

The new file will be created, with the form from the previous drill set as the opening picture of the new file.

Once the file is created, be sure to import your Cast List information so you don’t have to
relabel all performers!*
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Convert Audio Files to OGG Format
Although permissible audio file types include MIDI and WAV, we recommend using OGG audio files to sync
to your drill. OGG files tend to be the smallest size with the highest quality.

If you have been provided a file format that isn’t OGG, it’s extremely simple to convert an audio file to the
OGG format.

Converting Audio Files to OGG

First and foremost, you’ll need an application to convert your audio to OGG. We recommend Audacity for it’s
simplicity and price (free!). Download and install Audacity from the following links:

• Windows Installer: Download Audacity for Windows
• Macintosh Installer: Download Audacity for Mac OS X

1. Once you have downloaded the installer, be sure to run the installer so Audacity is installed on your
machine.

2. Open Audacity.
3. Click the File menu and choose Open.
4. A file browser will open. Locate the audio file you would like to convert, select it, and press Open.
5. Click the File menu and choose Export.
6. A file browser will open. Enter a file name. For the File Type, choose Ogg Vorbis. Select a location to

save the new file then press Save.
7. Nothing needs to be entered in the Edit Metadata window, so press OK to begin the export.
8. Your new OGG file will appear in the destination location you chose to save the file to.

Create a Custom Fabric Using GIMP
The term “fabrics” in 3D could refer to multiple different things. Any textures in the Real View (including, but
not limited to: uniforms, helms, flag silks, flag poles, drums, and skin color) are all considered fabrics for the
sake of simplicity. This means that with the right software, you could manipulate the fabrics we provide to
customize the look and feel of performers and equipment in the 3D Real View.

To create a fabric for use in 3D, you must have an image editing program. We
recommend GIMP or Photoshop.

While there are many image editing programs available, we recommend using GIMP because of it’s cost
effectiveness (read: free!) and power. This does not mean that GIMP is the only way to go about editing
fabrics for use in the Pyware 3D Real View. If you are more comfortable using a different image
manipulation software, by all means, please do so. From this point forward, these instructions will detail
creating a fabric in GIMP.
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Downloading GIMP

Download and install GIMP for your operating system:

Download GIMP for Windows

Download GIMP for Mac

Once the download is complete, be sure the run the installer to install and set up GIMP for use.

After you have GIMP installed, you can start following the steps to creating a custom uniform by clicking on
the sub-topics on the left. The first step would be to Open the Template File for editing.

Open the Template File
We provide you with a template file that you can edit in GIMP to get your desired custom uniform. The
template file can be found at the following location:

Documents\Pyware 3D\Fabric\Templates\7.1 Uniform Template (gimp).xcf

Open the template file. This will launch GIMP, which might take a few moments to fully load. Once the
template has loaded, you’ll see something similar to the following image:

We have many custom uniforms designed and available for FREE as a direct download
from our site. Please visit www.pyware.com/fabric-gallery/ to view the available uniforms.*
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GIMP Layout
Before we get started, now would be a good time to familiarize yourself with the layout of GIMP.

The panel on the left of the design (or workspace) area is the Toolbox. This is where you will find tools for
selection and editing.

The window in the middle of the image is your workspace. This is where you’ll be adapting the uniform for
your ensemble.

The panel to the right of the design area is the Layers panel. This panel lists all layers of an image. The
Layers panel also has quick access to the various paths for the image, whether provided in the template or
created by the user. We’ll briefly discuss paths later on.

Click through to the next topic, Creating a New Uniform Layer, to continue.

Create a New Uniform Layer

The Layers Panel
In the Layers panel, you will find multiple options, or layers (as they are called by GIMP) available. Think of
a layer as a piece of an image. If the image was laid horizontally, you could theoretically stack things on top
of the image. Each thing you stacked would be its own separate layer.

Layers can be nested, or grouped under other layers. The order of layers is important, as much like in real
life, if you stack a larger object on top of a smaller object, you will no longer see the smaller object. The
same can be said with the layers of an image. If, for example, the sash on your uniform was on its own
separate layer from the uniform coat, and ordered under the uniform coat layer, the sash would not be
visible. With that being said, the following layers are available in the template file from top (highest) to
bottom (lowest):

• Section Labels
This layer, when visible, will display the name of each piece of the uniform that can be edited. The
Section Labels layer corresponds with the next layer below it, the Part Outlines. This layer should be
hidden before saving the image file.

• Part Outlines
This layer, when visible, displays the outlines for the uniform. When creating a custom uniform, you
only need to color inside the boundaries of this layer, as anything beyond the outlines will not be
represented on the performers. Think of it as coloring inside the lines of a coloring book. This layer
should be hidden before saving the image file.

• Gender & Ethnicity (Face & Hands)
The Gender & Ethnicity layer is a group of layers that contain options for different ethnicities for the
performers. To change the ethnicity of the performers, click the visibility (eye) icon to turn off the
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current skin, and click in the same area to turn on the visibility on the ethnicity layer you wish to use.
You may need to expand the list to view the available layers.

• Cloth Texture Overlay
This layer contains an overlay to add a sense of realism to the uniform. You should not need to edit
anything in this layer.

• Uniform Color
The Uniform Color layer shows the current template uniform. You will be creating a new layer just like
this one when designing your custom uniform.

• Background
The Background layer is available should you want to have a color behind the uniform. This layer
should be hidden before saving the image file.

Create a New Layer
You’ll want to create a new layer when working on your uniform, otherwise you’ll overwrite the template. To
create a new layer, click the New Layer button.

A new window will appear. Give the layer a name, then press OK.
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You’ll see your newly created layer in the Layers panel. As we discussed earlier, the order of layers in the
Layers panel is important. Be sure that your new layer is between the Cloth Texture Overlay and Uniform
Color layers. Whenever you’re designing the custom uniform, you will want to be sure that this new layer is
selected for editing. Again, you do not want to edit the template layer!

Click through to the next topic, Select Paths to Edit, to continue.

Select Paths to Edit
In its simplest form, creating a custom uniform is much like coloring between the lines. In GIMP, the lines we
set as the boundaries for color are called Paths. If you open the Paths panel, you’ll see various paths with
uniform part names. The Paths panel is opened by clicking on the Paths tab in the Layers window.
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These paths act as the guides (boundaries) for colorizing the uniform. For example, if we click on the the
Upper Torso Front Only Arms path, you’ll see those pieces of the uniform are selected. If you go back to
the Layers panel and turn off the visibility for the template uniform, the selected path will be much more
obvious.
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If we choose the Path to Selection button, the line changes to a dashed line, indicating it’s been selected.
When a path is selected, you can only color inside of that selected path.
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Click through to the next topic, Colorize Paths, to continue.

Colorize Paths
Once a path has been selected, you can easily fill the selected area by using either Photoshop or GIMP’s
Fill command. Before you fill the selected area, you’ll want to first specify which color you would like to fill
the area with.

Click on the Foreground Color box and a Color Picker will appear.

Choose the color you wish to fill the area with, then press OK. With the path selected (and your uniform
layer selected), go to the Edit menu and choose Fill with FG Color. This will apply the color you have
selected to the path.

In this example, we colored the Upper Torso Front Only Arms path. This filled the selected path with the
foreground color I have selected (blue).
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You can repeat this process by selecting the next path, setting the color you wish to fill it with, then choosing
the Fill with FG Color command to fill the selected area.

Click through to the next topic, Hide Section and Label Outlines, to continue.

Hide Section and Label Outlines
Once you have completed the uniform, you’ll want to hide the Section Labels and Part Outlines guide
layers before saving the file as an image. If these layers are not hidden before saving the image and loading
the image in 3D, you’ll have an undesired effect of seeing both the outlines and section labels on the
performers.

To hide these layers, click the visibility (eye icon) next to the layer.

The above is for creating a very simplistic uniform. You can get as creative or technical as
needed with the template file when customizing the file for your ensemble. Be sure to stay
inside the guide lines for each uniform piece.
*
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Click through to the next topic, Save As Image File, to continue.

Save As Image File
After you have completed the uniform and hid the guide layers, your file will be ready to be saved for
uploading in 3D.

You’ll want to save two copies of the file, one for male uniforms, and one for female uniforms. Turn on the
gender layer of your choice by clicking the visibility (eye icon) for that layer.
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Hide the gender layer that you will save second. Go to the File menu and choose Export. For the file type,
choose either a .jpg or .png image file.Give the file a name, and be sure to save the image in an easily
accessible location.
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Repeat this process for the opposite gender you just saved.

At this point, editing the uniform should be complete. For the next step, you’ll want to jump to the Load a
Custom Fabric File in 3D topic.

Create a Movie of Your Drill
Capturing a movie of the drill animation is a fantastic way to share the animation with either your students or
clients, especially if they do not have the ability to download and install the demonstration version of 3D.

To create a movie of your drill, you’ll need to go to the Utilities menu and choose Create Movie. A new
window will open with various recording options.
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If you know the size of the movie you would like to create, you may set the size option here. If you are not
sure about which size you would like to use, you can set the size later once you have launched the recorder.

We launch a 3rd party application from 3D called Screencast-O-Matic to capture the animation and save it
as a video. Before you can use Screencast-O-Matic, you’ll need to set up the application for use in 3D. To
do so, click on the Setup button in the Create a Movie window.

The Setup window will appear. Simply click the Use Recommended Recorder button and press Save. This
will take you back to the Create Movie window.

Choose Launch a Recorder. Two new windows will open, one for 3D and the other for the screen recording
application. It’s very possible your web browser will open, as Screencast-O-Matic is typically launched from
a web browser (unless otherwise already installed on your machine).
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The 3D window gives further instruction for recording.

The screen capture window is adjustable. You can click and drag on the frame to resize the recording area,
or click and drag in the middle of the recording area to reposition. The screen recording application will only
capture what is included in this frame.

As of Mac OS X 10.7.3, all Java Applets are disabled by default. Scroll to the bottom of the
page for instructions on enabling Java applets to run on Macintosh.

!
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Now would be the time to prep the drill for capture. Size the screen (whether you’re recording the
perspective window or the design area) as big or little as you wish.

Press the Record button once you are ready to start recording. Screencast-O-Matic will provide a brief
countdown before recording actually occurs so you may press Play to start the animation in 3D.

When the animation is complete, press Done in the screen recording application. You will then be able to
preview your recording, as well as save it out in various formats, through the screen recording application.

Recording Audio with the Video
Click through to the appropriate sub-topic for your machine for discussion on recording audio playback with
the video animation.
Recording Audio on Macintosh
Recording Audio on Windows

Enabling Java Applets to Run on Macintosh
To enable Java applets (this is required to run the screen recorder application), do the following:

Go to Mac HD/Applications/Utilities and open Java Preferences.

Be sure to keep your mouse out of the recording frame while recording. The screen
recording application will capture ANY movement inside the recording frame, including your
mouse.
*
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On the Security tab, check the Enable Java content in the browser option.
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In Safari, click on the inactive plug-in link (on the screen recording application’s page) and enable the plug-
in. A restart of Safari is required.

Recording Audio on Macintosh
If you are creating a movie on a Macintosh with Screencast-O-Matic, you’ll need to install a Utility
Application called SoundFlowerbed to capture audio with the video.

Download SoundFlowerbed from https://github.com/crmne/Soundflower/releases and install the application.

Once installed, run SoundFlowerbed from Applications. You will not see a user interface when you open the
application. Locate the Flower in the menu bar and change the setting for input for 2 channel.
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Open System Preferences and go to Sound, click on the Input tab and select Sound Flower 2 Channel.

Click on the Output tab and select Sound Flower 2 Channel.
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Run Screencast-O-Matic, and set the microphone to be Sound Flower 2 Channel.

Once this has been set up, you’ll be able to record both audio and video at once.

Recording Audio on Windows
The free version of Screencast-O-Matic (which is what is launched by default when following these
instructions) records audio from your microphone. If you have a standard auxiliary cable, you could plug the
cable into both the headset (speaker) and microphone jacks on your computer. This will loop the audio
through your computer, allowing you to record both audio and video at once.

If you do not have an auxiliary cable that you can plug into your machine, you could purchase the Pro
version of Screencast-O-Matic. We actually recommend this route for capturing audio with video on
Windows machines as the audio is captured from your computer’s sound card, giving you the highest quality
recording.
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Create a New Drill
By default, a new drill is created when you open 3D. This is a blank drill file with 300 counts and default field
layout settings.

Counts can be added or subtracted to a drill file with the Count Editor, found in the Utilities menu.

Field layout settings, such as grid size, shape, division lines, and markers can be edited with the Grid
Designer in the Utilities menu.

Continuing a Drill from a Previous File
Once you have completed a drill file (movement) of your show, you can quickly transfer the picture of the
last page (set) along with performer label, symbol, uniform and equipment information, to a new drill file. To
continue drill from one file to another:

• Open the drill you wish to transfer continue FROM
• Go to the File menu, choose New Drill
• Enter the new file name you are continuing TO in the Drill Title field
• Choose the “…continuation of the drill from the selected file…” button, and select the drill you have

open. In this example, we’re continuing from Movement 1.3dj
• Choose whether you wish to continue from the last count of the selected file, or from count X, where X

is the count you specify
• Press Okay
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Create Page Tabs
Page tabs, or what you might know as sets, pictures, etc., are markers on the Count Track to indicate where
in time the ensemble “hits” a set. We recommend using page tabs to indicate where each set is throughout
your show, including the opening picture on count zero. This is because you can more accurately draw
transitions in the correct amount of counts by clicking on a page tab (which in turns spreads your anchors
from the page tab you clicked on to the previous page tab).

Page tabs are required for any printing in 3D. Without page tabs in a drill, the program would not know what
you would like to print.

Creating a page tab is extremely simple, and can be done multiple ways.

Adding pages via the Count Track
On all editions of 3D, you can add page tabs by clicking directly on the Count Track. You would first need to
unlock the Count Track so it may be edited.

Click on the padlock at the bottom right of the Count Track.

The color of the Count Track will change. This indicates the Count Track is unlocked and page tabs can be
added. Click anywhere in the yellow space below the count track to add a page tab.

You can click and drag a page tab to any count on the Count Track while the count track is unlocked
(editable).

Once you are done adding page tabs, lock the Count Track by clicking on the padlock once more to lock the
Count Track from editing.

Adding pages via the Production Sheet
On Interactive and Professional editions of 3D, page tabs can be quickly added in the Production Sheet.
Pages that are added in the Production Sheet are applied automatically to the Count Track, and pages
added to the Count Track will show up in the Production Sheet. Both the Production Sheet and Count Track
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update each other.

To add pages to the Production Sheet, simply click the “Add” button. A new window will appear, prompting
to enter the count at which you wish to add a page tab.

Display Issues
This FAQ section is for Display Issues.

Dot Font
Dots for symbols are a great way to create beautiful, yet accurate drill charts. Since dots are symmetrical,
many designers prefer to use a dot as a performer symbol as opposed to a standard letter based system.

In order to use dots as the performer’s symbols, you’ll need to load the Dot Font into your drill file.

Load the Dot Font

To begin, go to the File menu and select Document Options. In Document Options, click on the Preferences
tab. Select Choose for the Symbol Font.
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Select PYJAVA2 from the list, then apply the change by pressing OK in both windows.

Assign the Dot as Performer Symbols

Once the Dot Font (PYJAVA2) is set as the font for performer symbols, you’ll need to apply the appropriate
symbol to each performer for the dot to display.

Many characters (the symbols and letters on your keyboard) are mapped to certain shapes and symbols in

3D uses PYJAVA2 as the default font for performer symbols. If PYJAVA2 is already listed
as the symbol font, skip to the next step.*
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the Dot Font. For a reference guide, check out the Dot Font Symbol Key.

If we look at the Dot Font Symbol key, we’ll notice that the dot symbol is assigned to the lowercase letter “s”
(note: casing does matter!) key press. In the program, select the performers who’s symbols you would like
to change, then open the Performer Labeling tool.

In the Symbol text box, type a lowercase “s”. Be sure that the change is applying to ALL COUNTS in the
drill. Press Repeat Symbol to apply the change to all selected performers, then Accept to commit the
change.

Load a Custom Fabric File in 3D

To load a custom fabric file, such as a uniform, go the File menu and choose Document Options. Click on
the Real View Perspective tab.

The Dot Font Symbol Key is also found in the Reference menu inside 3D.*

We have many custom uniforms designed and available for FREE as a direct download
from our site. Please visit pyware3d.com/3d/fabric-gallery/ to view the available uniforms.*
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Here you’ll find a table with options for assigning any custom uniform or flag silks available. Click the edit
(pencil) button for the uniform slot you would like to load the image into. Open the image (if necessary, click
the browse button in the 3D window to locate the image file on your machine).
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Repeat this step for the other gender uniform you saved, or any other fabrics you wish to load. Once all
images are loaded, press OK in Document Options.

Once you have loaded the fabrics for use in 3D, be sure to assign the fabrics to the performers on the field.

Assign Custom Fabrics to Performers on the
Field
After any fabric has been loaded into the drill’s Document Options, you’ll need to assign those uniforms to
the performers in the drill.

To do so, put both your red and yellow anchors on the Count Track on count zero.
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Select the individuals on the field that you wish to assign the uniform to. Open the Visuals Editor tool on
your Tool Palette.

On the Body tab, choose the uniform slot that you loaded the custom uniform in to, then press Apply. You
will then see the custom uniforms in the Real View.

Modifiers and Specialty Keystroke List
Below is a list of special keystroke commands that are available in 3D.

Right Click Functionality
Default Tool – Right click on the design grid to select the Default tool. At the time of installation, the Pointer
Selection tool is set as the Default tool.
Set Default Tool – Right click on a tool in the Tool Palette to set the Default tool. The Default tool is
automatically selected once you accept any tool.

Double Click Functionality
Minimize/Restore Windows – Double clicking on the title bar of many windows, such as the Perspective
View, Real View, Production Sheet, and Virtual Clinic, will minimize or restore the window.
Tool Palette Orientation – Double clicking on the gray bar to the left of the Tool Palette will switch the
orientation of the Tool Palette from horizontal to vertical, or from vertical to horizontal.
Pointer Select Recent – Double clicking on the Pointer Selection tool will select the most recent selection.
Page Tab Options – Double clicking on a page tab will display the page tab options.

Modifier Key Combination Functionality

Selection Tools

Adding/Removing Performers in Selection – [SHIFT] + click or [SHIFT] + drag with any Selection tool will
add or remove performers from the selection.
Add to Selection – [SHIFT] + click on a Selection tool will allow you to continue selecting performers with
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the Selection tool you [SHIFT] + clicked on. This will not clear your last selection. For example, if you have a
group of performers selected with the Box Selection tool, you could [SHIFT] + click on the Lasso Selection
tool, and while holding SHIFT, continue selecting performers to add to your currently selected performers.

Drawing and Editing Tools

Move Relocation Handle – [SHIFT] + [ARROW KEY] while in a Drawing or Editing tool will move the
relocation handle by one step in the direction of the arrow you pressed.
Rotate Relocation Handle – [CTRL] + [ARROW KEY] while in a Drawing or Editing tool will rotate the
handle by 5 degrees in the direction of the arrow you pressed.
Tool Panel Relocation – [CTRL] + [ALT] + click with a tool panel open to move the tool panel to your
mouse location.
Symbol Box – [ALT] + click in a symbol box of any Drawing or Editing tool will open a Symbol window. This
window will show the actual symbols that will be displayed when using specialized 3D fonts.
Drawing Tool Interval Box – [ALT] + click in the Interval box of any Drawing tool will open the Mixed
Interval window. This window allows the input of complex mixed intervals.
Performer Matching Selection – [ALT] + clicking on 2 performers that are stacked on top of each other will
select the performer on the bottom.
Adding/Removing Editing Handles – [SHIFT] + click on an editing handle to remove it from the form.
[SHIFT] + click on the form to add a handle to the form.

Count Track
Jump Anchors to Same Page Tab – [ALT] + click on a page tab to set both Red and Yellow Anchors on
the same page tab.
Yellow Anchor to Previous Set – [CTRL] + click on a page tab will move the Yellow Anchor to the previous
full page tab, skipping any sub sets.
Delete a Page Tab – [ALT] + click on a page tab when the Count Track is unlocked to delete the page tab.
Reset Count Track Zoom – [CTRL] + click on the Count Track Zoom button will reset the zoom of the
Count Track to default.
Count Track Zoom – [SHIFT] + click on the Count Track Zoom button zooms the out from the Count Track.
Select a Range of Pages – [SHIFT] + click on page tabs, in the Production Sheet, or in the Virtual Clinic
windows will allow you to select a range of pages.

Animation Controls
Open Document Preferences – [ALT] + click on the Play button to open the Document Options’
Preferences tab to assign a music file.
Clear Music Synchronization – [ALT] + click on the Speaker button in the Animation Controls to clear the
music synchronization.
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Field Display Window
Reset Zoom and/or Grid Shift – [ALT] + click on the Zoom or Grid Shift tool the settings for these tools will
be reset to default.
Zoom Out From Grid – [CTRL] + click with the Zoom tool enabled will zoom out from the design area.

Classic Perspective View
Reset Perspective View Tools – [ALT] + clicking on the Tilt, Shift, or Zoom buttons will reset the
perspective view to default.

Print Outside of Performance Area
If your show calls for performers to travel beyond the boundaries of the performance area (for example,
outside of the sidelines, or into the endzone of a football field), you’ll definitely want the ability to print drill
charts that show the positions for those performers for your reference.

By default, 3D only prints inside the red bounding box for your drill’s performance area that is specified in
the Grid Designer. You can print beyond the bounding box by doing either of the following:

Load a Preset Grid

3D comes packed with various grid templates for your disposal. In the Grid Designer, click Load for the
preset grids. This will open a file explorer, allowing you to select which grid template to load. There are
templates with appropriate markings for each football field, all with extra room at the sides and ends of the
field. Select the grid that would be appropriate for you, then press OK to commit the change in the Grid
Designer.

Add Minor Division Lines to the Grid

If you have customized the grid for you drill, the 1st option would probably not be in your best interest, as
you would be loading a template and replacing any revisions you made to the grid. To keep your current grid
style intact while still accommodating for printing beyond the boundaries of the performance area, we’ll need
to add a few minor (sub) division lines to the grid. To do so, open the Grid Designer from the Utilities menu.
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The grid designer is zoomed in to the performance area to make it as large as possible. Because of this,
you’ll most likely want to zoom out (away) from the performance area, so you can see precisely where on
the grid you’ll be adding additional lines.

To do so, click the zoom out button until you have adequate space to add your division lines.

Then click and drag the minor lines onto the grid, from their respective anchors (upper right for side line
(horizontal), or lower left for end zones (vertical)).
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You’ll want to add minor lines for BOTH sides of the performance area, even if you don’t cross over both
boundaries.

For example, if you need to print 4 steps outside the front side line, you’ll want to add minor lines 2.5yds
outside of both side lines. See the picture below for reference.

This gives 3D the proper reference points when printing beyond the standard boundaries of your
performance area. You do not need to add minor lines on all 4 sides of the performance area if you only
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exceed one side.

Real View Poses Guide
Below is a quick reference for both Upper and Lower Body poses that can be applied to performers when
using the Real View. These poses are applied to performers with the Visuals Editor tool.

Lower Body
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Upper Body
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Reset Default Tool
Is a tool opening up every time you close out of a control panel? Here’s an easy way to fix it.

On your Tool Palette, right click on the Pointer selection tool. A new window will appear.

Pygraphics Pyware 3D User Guide - 11.0_en

Page 391 of 407



Selecting Yes in this window will reset the Default tool to the Pointer selection tool.

What’s the Default Tool?

The Default tool is the tool that 3D always “defaults” to when you exit another tool. When you install 3D, the
Default tool is set to the Pointer selection, as it is the most commonly used tool on the Tool Palette.

What Caused My Program to Do That?

We introduced the ability to bind a shortcut to a “right click” function back on version 6 of 3D. In the default
set of shortcuts, a right click will open the default tool. If you accidentally right clicked on another tool on the
Tool Palette, this would change the binding of the default tool to whichever tool you right clicked. This can
happen accidentally, especially on laptops when you’re using a track pad as opposed to an external mouse
as track pads can be quite sensitive to touch.

Reset Window Locations
If any window in the program appears off screen, you can easily reset the location of all windows in 3D to
their default positions. To do so, follow the steps below:

• Go to the File menu and choose Application Options
• Click on the Display tab
• Select the big Reset Window Locations button at the bottom of the window
• Press OK to apply the change
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Symbols Not Printing
Are your drill charts printing without symbols (meaning you see labels only, no performers)? The majority of
the time this is caused by the symbol font not being properly installed on your computer. This can occur if
the program was installed as a non-administrator on the computer. Fortunately, this can be corrected by
simply installing the necessary fonts into your computer’s Fonts folder.

Instructions for Windows
• Go to Computer > C: > Program Files > Pyware 3D > lib > factory > forAppDataLib > fonts
• Copy the “PYJAVA2.ttf” and “pyview.ttf” files onto your desktop
• Go to Control Panel > Appearance and Personalization > Fonts
• Move the copied fonts on your desktop into the Fonts folder
• Once both fonts are installed, restart your machine to complete the process

After you have restarted your computer, open 3D again and attempt to print your drill. You will now see both
symbols and labels on the drill charts.
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Instructions for Macintosh
• Go to Applications > Pyware 3D > lib > factory > forAppDataLib > fonts
• Copy the “PYJAVA2.ttf” and “pyview.ttf” files onto your desktop
• Go to Applications > Font Book
• Move the copied fonts on your desktop into the Font Book
• Once both fonts are installed, restart your machine to complete the process

After you have restarted your computer, open 3D again and attempt to print your drill. You will now see both
symbols and labels on the drill charts.

Upload a Drill to the Online File Manager
The Online File Manager is a fantastic way to easily share drill files with any associates, clients, or students
you may need to see the drill. Think of it as cloud storage with the ability to easily share these files with
anyone that has either a license of 3D, a Director’s Viewer, or the Performer’s Practice Tools (student
viewer).

Uploading a File to the Online File Manager

In the Interactive menu, choose Online File Manager.

The Online File Manager will open.

The Pyware 3D file might be in Program Files (x86), depending on if you are running the
32-bit or 64-bit version of Pyware.*

The Online File Manager is only available on the Interactive and Professional editions of 3D.*
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You will see your account listed, as it’s tied to your installation of 3D. Select your account in the list and
choose Open.

You’ll then be prompted to sign in to the account.

Only the administrator of the online account can upload drill files. The administrator name and password
was included in your email at the time of purchase. Choose to sign in as a Registered User or Group,
enter your administrator name and password, then choose Sign On.

Once you have signed on to the Online File Manager, the main work area will appear. You could potentially
see multiple drills in this window, however they’ll only be in 1 of 2 locations: either in your Documents\
Pyware 3D\Drills folder, or uploaded in the online account.

The only location you can upload a drill from is your Documents\Pyware 3D\Drills folder. If
you have the drill saved elsewhere on your machine, you would need to save the drill inside
your Drills directory in order for the Online File Manager to “see” the drill to upload.
*
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The main layout looks very similar to a spreadsheet. On the far right side, you’ll see a TO DO column. Click
in the TO DO column for a drill you wish to upload and choose send a file copy to the internet account. A
new window will appear, asking for a description of the file.

The description is required so anyone accessing your Online File Manager will know what they are
downloading and/or if the files have been revised recently. Once the description is input, press Send to
Online Account. At this point, you can repeat the process for any other drills you would like to upload.
When you’re ready to send the drill(s) to the online account, press Save Changes. This will begin the
upload process.
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View Drills on a Mobile Device

Download on the App Store

Get it on Google Play

The following is a step by step guide on how to view a drill on your iOS device.

If you need to upload a drill to share, start with step 1. If you were provided a QR Code for a drill, skip to
step 6.

1. Save As Mobile App File
To view any drill file on iOS, you’ll need a mobile compatible drill file. These drill files have a “.3da”
extension, so the file might look like filename.3da. To save a .3da file, go to File > Export File > Export 3D
App File .

2. Upload the File to Cloud Storage
Once you have a .3da file, you’ll then need to upload the file to a cloud storage service. Any service that
provides a download link for your files will work. We recommend using Dropbox due to it’s popularity and
simplicity. If you’d like instructions on using Google Drive instead of Dropbox, click here.

https://www.youtube.com/embed/RCpRQ-KMgAs?rel=0
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3. Copy the Mobile App File URL
After you have uploaded the file to your cloud storage service, copy the “sharing” link for the file.

4. Generate a QR Code
The easiest way to share drill files that are stored in the cloud are with 3D’s Print QR Code feature. Within
this feature, you can quickly generate a QR Code for any mobile app file, which can then be scanned by the
Pyware 3D Viewer and imported into the app instantly.

To create a QR Code, open 3D and go to File, then Print QR Code. In this new window, you’ll want to enter
a name for the QR Code in the Drill Title box, then paste the URL you copied earlier in the Drill URL box.

5. Change URL to a Download Link
We’ll need to slightly alter the mobile file’s “share” link so it will properly load into the app. Instead of using
the file’s “share” link, we’ll need to change it to a “download” link.

Using our Dropbox example, you can easily change the share link to a download link. Let’s say that when
we click Share for our .3da file in dropbox, it provides us the following link:

http://www.dropbox.com/s/qvoc234ha5k/sample.3da

To change the share link to a download link, we need to switch the www to a dl in the URL. So the original
share links reads:

http://www.dropbox.com/s/qvoc234ha5k/sample.3da

but after editing, will now look like:

http://dl.dropbox.com/s/qvoc234ha5k/sample.3da

Notice the only change was swapping www for dl. This changes the link to begin a download of the file
when you go to that address, which is what our mobile app requires. Be sure to alter the link before creating
the QR Code.

Once you have changed the Drill URL, press Save as PDF to create a PDF file of the QR Code, or Print/
Preview to print a hard copy.

Once you have created a QR Code for the mobile app file, that link will never change. You
can distribute the QR Code to performers, clients, or associates so they may download the
app on to their own respective devices.
*
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6. Opening the Drill in iOS
Tap the Open button in the app. The Load/Import window will appear.

Tap Import in the Load/Import window. Select QR Code to start your device’s camera to scan in the QR
Code. Point the device’s camera at the drill’s QR Code. The file will begin to download.

Once the download is complete, you’ll then see the drill in the list of available files to open. Tap the file, then
press Load.
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Click here for an overview of the 3D Viewer app interface.

Mobile App Files and Google Drive
If you prefer to use Google Drive as your cloud storage service, please follow the instructions below to save
your mobile app file and generate a shareable link that you can create your QR code with.

1. Save As Mobile App File
To view any drill file on the Pyware 3D Viewer App, you’ll need a mobile compatible drill file. These drill files
have a “.3da” extension, so the file might look like filename.3da. To save a .3da file, go to File > Export File
> Export 3D App File.

2. Upload the File to Google Drive
Once you have your .3da file, you’ll then want to upload the file to Google Drive.

3. Sharing Options
Right-click on the uploaded .3da file and choose Share. This opens a new window; click Copy Link in the
upper right corner.
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4. Generate Shareable Link
Go to Google Drive Direct Link Generator and paste your copied link in the “Enter your sharing URL” field.

5.Get Shareable Link
Click Create Direct Link, then select the entire link in the “Output Link” field and copy the link.
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6. Generate a QR Code
Go back to Pyware, and go to File and Print QR Code. In this new window, you’ll want to enter a name for
the QR Code in the “Drill Title” box, then paste the link you copied earlier in the “Drill URL” box.

At this point, you can either print the QR Code, or save the QR Code in PDF format for distribution.

Mobile App Overview
Below is an overview of the 3D Viewer app layout.

Load/Import
Load/Import opens the Load/Import window, where you can open drills, import them into the app (from an
online storage service), or refresh a drill to retrieve the current copy from the online storage service. See
Viewing Drills on iOS for instructions on how to open a mobile drill file.

Spotlight
When tapped, Spotlight will spotlight a performer on the field. You can change the currently spotlit
performer by tapping on the performer you wish to spotlight. To stop spotlighting a performer, tap the
Spotlight button again.
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Cast List, Coordinates & Production Sheet
The Cast List, Coordinates & Production Sheet button will display the drill’s Production Sheet when
tapped.

Tapping a set in the Production Sheet list will display that set’s Production Sheet and Text Box notes (if
applicable). The anchors on your Timeline will jump to the appropriate count range for the transition, and
display the set you selected on the screen.

To access the Cast List, tap the Cast List tab in the Cast List/Production Sheet window. A list of every
performer in the drill will display. Performers in the Cast List are sorted by Performer Label.

Spotlighting a performer will show the performer’s detailed coordinate instructions at the top
of the screen.*
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Tapping a performer in the Cast List will display that performer’s coordinates for the drill. Tapping a set in
the Performer Coordinate window will jump the anchors on your Timeline to the appropriate count range
for the transition.

To search the Cast List for a certain performer, pull down the top of the Cast List. A search
box will appear.*
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Settings
When tapped, the Settings panel will slide open. Here you’ll find the following options:

Sliders

• Timeline Zoom increases or decreases the viewable range of counts on the timeline.
• Playback Speed increases or decreases the drill’s playback animation speed when animating. The
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higher the number, the faster the drill will animate.
• Playback Smoothness changes the fluidity of the drill animation. Decreasing the Playback

Smoothness will make the drill animate in a more step-time fashion, whereas increasing the Playback
Smoothness will make the drill animate more fluidly.

View Modes

• Flat will change the ground to a single, flat color.
• Contrast is a high contrast mode for viewing in poor light conditions. All performers, markers, division

lines and step grid are black. The ground is white.
• Surface loads a realistic surface for the drill. For example, drills on a football field will show a football

field with turf and appropriate markings, whereas indoor drills will show a hardwood gymnasium floor.

• Ensemble displays every performer in the drill.
• Solo displays the currently selected performer. You can select a different performer by tapping the

performer in the Cast List.

Switches

• Show Grid displays a 1-step grid for the performance area.
• Show Timeline displays the Timeline.
• Audible Click plays a click for every count in the drill, much like a metronome.
• MSAA stands for Multi-Sampling / Anti-Aliasing. Turning on this option will make performer models

and text have crisper, cleaner edges.
• Draw Labels will display the performer labels (when zoomed in enough to see them).
• Draw Symbols will display the performer symbols (when zoomed in enough to see them).

Timeline

The 3D Viewer Timeline acts very similar to Pyware 3D’s Count Track. The row of ticks at the top of
Timeline is every count in the drill. These counts are subdivided every 8 counts for ease of use when
navigating the Timeline.

Page Tabs are displayed as the longest ticks on the Timeline. The Page Tab (or set) number is read from
the 3D drill file, so both sets and sub-sets will be accurately numbered. You can tap a Page Tab to jump
your anchors on the Timeline to that transition.

The Secondary Anchor is where animation will begin. When you select a set to play, the Secondary Anchor
will typically start at the previous set. This anchor can be tapped and dragged to any count in the drill.
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The Count Indicator indicates which count of the drill you see. The indicator can be tapped and dragged
across the Timeline to preview any count of drill.

The Primary Anchor is where animation will end. When you select a set to play, the Primary Anchor will
typically be the set you selected. This anchor can be tapped and dragged to any count in the drill.

Animation Controls
Our 3D Viewer app features many of the commonly used animation controls found in Pyware 3D. They are
as follows:

• Previous Set will jump your Primary and Secondary anchors to the previous set’s transition. The
Count Indicator will jump to the set previous to the set it was currently on.

• Previous Count will move your Count Indicator back one count per tap on the button.
• Play will animate the drill from the Secondary Anchor’s location to the Primary Anchor’s location.
• Next Count will move your Count Indicator forward one count per tap on the button.
• Next Set will jump your Primary and Secondary anchors to the next set’s transition. The Count

Indicator will jump to the set after the set it was currently on.
• Repeat will repeat the played animation.
• Play All will disregard the Primary and Secondary anchor’s location on the Timeline and play the drill

animation from the first to last count of drill.

Gestures
Center View – Double tap anywhere on the screen to realign and center your field of view of the
performance area.
Rotate View – Twist with two fingers to rotate the view.
Tilt View – Drag with two fingers up or down.
Zoom In/out – Pinch with two fingers to zoom in. Spread with two fingers to zoom out.
Move Performance Area – Drag with one finger in any direction.
Show/Hide Timeline – Triple tap to hide the Timeline. Triple tap again to show a hidden Timeline.
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